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System Overview  
The Spectrum FL Software is an extensive and easy to operate software package for luminescence 
spectroscopy (fluorescence, phosphorescence, and bioluminescence). 
Spectrum FL is operated under the MS WindowsTM environment.  In order to work with Spectrum FL 
a basic knowledge of Windows is necessary. When working with Windows for the first time, you 
should first review the Windows documentation.  

It can be used to set up and collect data from the: 
•       FL 6500 (Pulse) 

•       FL 8500 (Continuous) 

NOTE: When you are working in Spectrum FL, press F1 at any point to display an 
appropriate Help topic. 

The manual is divided into the following areas: 
Getting Started - A brief overview of Spectrum FL. 

Method Setup - Select an application method to set up for your analysis. 
Accessories Setup - A brief overview of the functions for the accessory setup 
tools. 

Collecting Data - Controlling your instrument to collect spectra. 
Data Analysis - Analyze the data collected using various processes. 

Viewing Spectra - Working with windows and graph views. 
Finding and Saving - File operations and navigation. 

Publishing Results - How to cut and paste, print your screen, or export data to 
another application. 
Processing Data - Working with your spectra and data. 

Setup and Administration - Adapting Spectrum FL to your needs and preferences. 
Workspace Reference - Links to help about particular commands, tools and 
features. 

  



 

 

Getting Started 
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Overview  
These topics provide a brief overview of the essential features of Spectrum FL: 

• Login and Instrument Connection 

• The Spectrum FL Workspace 

• Managing Data 

• Processing Data 

• Publishing Results 

• Exit and Save Options 
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Logging into Spectrum FL 

Start Spectrum FL by clicking on its desktop icon  or the Windows Start button and navigate 
to PerkinElmer Applications. 

The Login Dialog 
Spectrum FL can be configured to: 

• Open after you have entered a valid User name in a Login dialog. Password control is 
optional. 

OR 

Use your Windows login details. 
If the Login dialog is displayed: 

1. Enter your User name and, if required, Password. 
For a new installation of Spectrum FL (where no users have been set up and no other 
PerkinElmer applications are installed), log in as the default Administrator. We suggest that 
you set up at least one User and one other Administrator. See Setting up Users, Groups 
and Passwords. 

2. If you want to change your password for any reason, click Change Password, enter and 
confirm your new password, and then click OK. 
If you are a new user, have been given a new password, or your password has expired, 
you may be required to change your password. 

3. Click OK. 

Spectrum FL opens. 

Selecting an Instrument at Login 
• You can use Spectrum FL online to control an instrument, or offline to simply review or 

process data. 
Working offline releases a networked instrument for use by another user. 

• To make an instrument available to Spectrum FL, select Add Instrument from the 
Instruments sub menu of the Setup menu. 

Login and your Save Option on Exit 
When you exit or close Spectrum FL, you can save all your data for reload when you next log in. If 
you were connected to an instrument, this instrument becomes your default instrument when you 
next log in. 

Additional Information 
Passwords 
If you have forgotten your password, ask an administrator to set a new password for you. You may 
have to change this password when you next log into Spectrum. 

To learn more about password control, and the rules that can apply to passwords, see Passwords. 
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To learn more about how Spectrum can utilize Windows logins and passwords automatically, see 
Windows Login. 

Instrument Administration 
To learn how to select, add, or remove a networked instrument from Spectrum FL, refer to 
Instruments. 

Auto-Connect 
To learn more about how you can auto-connect to a instrument when you log into Spectrum FL, 
refer to Auto-Connect. 

Save Options on Exit 
To learn more about exiting or closing Spectrum FL:, refer to Save Options on Exit. 

Unexpected Software Events and Power Failures (Spectrum ES only) 
In the event of a sudden power failure or software “crash”, some of the workspace data may be 
left unsigned. 
When the software is next started, it compares the current workspace setup with the signed 
information held in the database and, if a difference is found, the user is given the option to reload 
the previously saved workspace. A new entry is added to the Audit Trail to indicate that the 
workspace has been recreated. The user can then work on the data and apply an electronic 
signature to it.   
If the workspace is not reloaded, the old data is left unmodified and a new workspace is created. 
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The Spectrum FL Workspace 
After you log in to Spectrum FL, your workspace window is displayed. It can include a number of 
panes and toolbars. 

NOTE: Not all of the functions are available in every page of the Spectrum FL Workspace.  For 
example, Data Explorer does not appear in the Method Setup screen. 

Panes 
The Spectrum FL workspace window is divided into panes: 

• The Navigation Pane, on the right, which contains shortcuts. 

• The Viewing Area, in the center, which you use to display one or more spectra. 

• The Dialog Pane, at the bottom, which you use to adjust parameters or enter information 
when, for example, setting up your instrument. 

• The Data Explorer, on the left, which you use to manage your spectra. 

The contents of the Dialog Pane reflect the shortcut selected in the Navigation Pane. You use the 
Data Explorer in conjunction with the Viewing Area. 

Toolbars 
The Spectrum FL workspace can include a number of global toolbars: 

• The Method Setup Menu bar 

• The Data Analysis Menu bar. 

• The scan toolbars, namely the Instrument Settings bar and the Action bar and the 
Accessory bar. By default, these toolbars are located at the top of the workspace, under 
the Menu bar. 

• The Status bar, located at the bottom of the workspace. 

A pane can include one or more local toolbars. For example, the Viewing Area can include the 
following Graph toolbars: 

• The Graph bar. By default, this toolbar is located at the top left of the Viewing Area. 

• The Process bar. By default, this toolbar is located at the top right of the Viewing Area. 

Additional Information: 
You can show, hide, re-arrange, or float many toolbars to suit your preferred manner of working. 
You can also easily customize your global and local toolbars so that they include the tools you need 
and exclude the tools you do not use. For example, you can decrease the apparent complexity of 
the application by excluding unused icons from the Process bar. See Personalizing Toolbars. 
You can revert to a default workspace, or preserve your current workspace for your next session. 
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Managing Data 
Spectrum FL enables you to: 

• Use familiar Windows techniques to find, select, open and save files. 

• Automatically save spectra to a default location as they are collected. 

• Organize different spectra into Samples Views to help facilitate data collection and 
processing. 

• Select spectra from a Samples View for presentation. 

Using Familiar Windows Techniques 
File menu commands enable you to open and save files using familiar Windows techniques. 

For example, to view a spectrum file stored on your PC: 
1. Select Open from the File menu. 

          OR 

          Click  on the Graph bar. 

          The Open File window is displayed. 
2. Browse to, and select, the appropriate *.sp file. 

To display summary information about a spectrum, place the mouse pointer over its 
filename. 
To select more than one file, hold down the CTRL key while selecting each file. To select a 
range of files, hold down the SHIFT key as you select the first and last file. 

3. Click Open. 

The spectrum is displayed in the Viewing Area on a graph tab. 
The spectra in the current Samples View are listed in a table embedded under the graph 
referred to as the Spectrum Browser. 

Saving Spectra 
Unless you have specified another default directory, the Save command in the File menu saves 
your selected spectra to C:\pefl_data\spectra\ 
One way to discover whether a spectrum has been saved is to select the Results Table tab in the 
Viewing Area, which lists the spectra in the current Samples View. By default, a column in the table 
indicates whether each spectrum has been saved. 
Specify another default directory for saved spectra by selecting Save As or Save All from the File 
menu. 

Organizing Samples Views using the Data Explorer 
Samples Views are virtual folders that are a useful way to organize open spectra in the Spectrum 
workspace. They do not reflect the actual location of any saved spectra. 
A Samples View can contain links to the spectra associated with a batch of samples, or an 
experiment, and the results generated by any processes applied to them. 
To see the Samples Views currently in use, open the Data Explorer on the left side of the Spectrum 
interface. Each folder represents a Samples View. 
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The contents of the Viewing Area, arranged on one or more tabs, reflect the currently selected 
Samples View or link. 
To create a new Samples View, select New from the File menu. You can drag and drop a copy a 
link from one Samples View to another. 
You can right-click and Delete a Samples View, or any of the links it contains, without deleting any 
saved spectra from disk. If you Rename a link, a new spectrum it is not automatically saved to 
disk. 

Using the Spectrum Browser 
When you are viewing a Samples View selected using the Data Explorer, the graph tab includes a 
table known as the spectrum browser, which enables you to select the spectra you want to work 
with. 
Each selected spectrum is marked by a    and its curve drawn in full color. Any unselected spectra 
are drawn dimmed. 

•       To select more than one spectrum, press the CTRL key as you select the next spectrum. 

•       To select a block of spectra, press the SHIFT key as you select the first and last spectrum in 
the block. 

•       To select all the spectra in the Samples View, press CTRL+A. 

Additional Information 
To learn more about saving spectra, and setting up paths to directories, see Saving Spectra. 
To learn more about opening files, removing spectra from view, and deleting spectra from disk, see 
Opening, Removing and Deleting Files. 
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Processing Data 
The Process menu in Spectrum FL includes a number of commands that enable you to process 
one or more of your spectra. 
For example, you can convert curves between Absorbance units (A) and Transmittance units (%T). 
You can also perform an automatic Baseline Correction or an Interactive Baseline Correction on 
your selected spectra. The Arithmetic command enables you to apply one or more operations to, 
for example, divide one spectrum by another or to multiply the ordinate values in a spectrum by a 
constant. 
If you use any of these tools frequently, you may want to show it on the Process bar. 
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Publishing Results 
Spectrum enables you to format and label the curves in Viewing Area and then send the prepared 
graph to WordPad or, if installed, to a Microsoft Word document for publishing. 
You can also: 

•       Review a Print Preview and Print. 

•       Copy and Paste from the currently displayed tab in the Viewing Area to another location. 

NOTE: Formatting and Labeling are not saved to disk with spectra, and are not preserved when 
you Exit Spectrum FL. 

•       Use the Report command on the Data Analysis File menu to output a report. 

Additional Information 
You can also Export spectra to another data management application or for processing. 
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Exit and Save Options 
When you want to Exit Spectrum FL: 

1. Select Exit from the File menu. 

          OR 
          Click Close (X) at the top right of the Spectrum FL window. 

          If you have Spectrum FL ES, you will be prompted to sign the workspace on exit. 
          The Save Options dialog is displayed. 

2. Select the appropriate option. 
          If you have Spectrum FL Standard, select to: 

a. Save any unsaved data, and open Spectrum with your default settings and layout 
next time, which enables you to preserve your current workspace for when you next 
login to Spectrum FL at this PC. 

b. Save any unsaved data, and reload the current spectra, settings and layout next 
time, which enables you to carry on with your work from where you left off when 
you next login to Spectrum FL at this PC. 

c. Exit without saving any unsaved data, layout or settings information, which restores 
the default workspace when you next login to Spectrum FL at this PC. 

          If you have Spectrum FL ES, select to: 
a. Reload spectra next time – Save any unsaved data, and reload the current spectra, 

settings and layout next time, which enables you to carry on with your work from 
where you left off when you next login to Spectrum FL at this PC. 

b. Don't load spectra next time – Clear for reload next time, which will load a new 
workspace, with a new Workspace ID, next time you login to Spectrum FL at this PC. 

        If you have Spectrum FL ES and have loaded a workspace created by another user, select 
to: 

a. Return to workspace – Reload the previous workspace. 

b. Exit the software. The previous workspace is restored next time you login to 
Spectrum FL at this PC. 

3. If required, select which group workspace you want to load and then click OK. 
If the group workspace you are currently using has not been changed, then Use Existing 
Configuration will also be available. 

Spectrum closes. 
The Choose Group Default Workspace is displayed in Spectrum FL ES when Don't load 
spectra next time is selected and the default workspace of one or more groups of which 
you are a member has been updated since you last created a new workspace in Spectrum. 
Any new workspace created subsequently will be based on the group workspace you have 
selected. The Choose Group Default Workspace dialog will not be displayed again until one 
of the group workspaces is updated. 

Refer to Assigning a New Default Workspace for more information. 



 

 

Method Setup 
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Spectra Scan 
This Scan application is used for collecting various types of spectral data in a variety of modes 
(fluorescence, phosphorescence, and bioluminescence) and dimensions (single and 3D scans).  

Data Collection Tab 
Scan Type 
There are five types of scans available from the Spectra Scan mode: 

• An Excitation Scan is recorded using a fixed emission wavelength. The start and final 
wavelengths refer to the excitation monochromator. 

• An Emission Scan is recorded using a fixed excitation wavelength. The start and final 
wavelengths refer to the emission monochromator. 

• A Synchronous (δλ) Scan, where both monochromators are scanned simultaneously 
with a constant wavelength difference between the excitation and emission 
monochromators. This technique is used for rapid screening in environmental analysis, for 
example for differentiating between various types of crude oil (oil fingerprinting), since the 
technique greatly simplifies the spectra of complex mixtures with overlapping spectral 
components. In a synchronous scan, the start and final wavelengths always refer to the 
excitation monochromator and the emission monochromator always starts at a higher 
wavelength than the excitation monochromator. 

• A Synchronous (δE) Scan, where both monochromators are scanned simultaneously 
with a constant energy difference between excitation and emission monochromators. The 
emission monochromator accelerates relative to the excitation monochromator.  In a 
synchronous energy scan, a synchronous spectrum is recorded at a constant energy 
difference between excitation and emission monochromator.  This technique can be used 
for the investigation of very complex mixtures where the spectral sensitivity at constant 
wavelength difference is too low. Scanning at constant energy difference between the 
monochromators has an advantage over the recording of spectra at constant wavelength 
difference by having a higher spectral resolution and lower background fluorescence. 

• A Pre-Scan using either one or both monochromators can be used to determine the 
optimum excitation and emission wavelength for unknown samples. See Performing a 
Pre-Scan. 

• A Background Correction scan Measures the current background intensity. This value is 
used for all subsequent reference measurements.  

Instrument Settings 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence Mode: Select Fluorescence or Phosphorescence. 
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Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 

120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Bioluminescence  (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

NOTE:  A Synchronous (δE) Scan does not support Real-time Dark for the FL 8500. 

Chopper (Hz): Select a Chopper value of 10, 20, or 40 from the drop-down list. 

Phosphorescence 

Ex. Corr: Select On, Off, or File. 

Chopper (Hz): Select a Chopper value: 10, 20, or 40 from the drop-down list. 

Bioluminescence (No additional settings required) 
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Excitation 

Scan Type setting:  Excitation Scan, Synchronous (δλ) Scan, Synchronous (δE) Scan  

Excitation Mono Setup 

Excitation Start Wavelength (nm): Enter a value. 
Excitation End Wavelength (nm): Enter a value. 

Or click the Full Range button (190 - 900 nm) 
Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-down list. 

NOTE: Click this button to access the Filter Setting dialog which allows a user to read or modify 
the current filter configuration for the connected instrument.  A user can also enter a 
custom name in the FilterCustom field. 

Scan Speed (nm/min): Select a value from the drop-down list. 

NOTE:  As you move up in power, Scan Speed options will change. 

Accumulation Number: Enter a value from 1 to 100. 

Scan Type setting: Emission Scan Type 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value. 

Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Scan Type setting: Excitation Scan 

Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 
Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Scan Type setting: Emission Scan 

Emission Mono Setup 

Emission Start Wavelength (nm): Enter a value. 

Emission End Wavelength (nm): Enter a value. 
Or click the Full Range button (190- 900 nm) 
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Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 
Scan Speed (nm/min): Select a value from the drop-down list. 

NOTE:  As you move up in power, Scan Speed options will change. 

Accumulation Number: Enter a value. 

Scan Type setting: Synchronous (δλ) Scan 

Emission Mono Setup 

Delta Lambda (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Scan Type setting:  Synchronous (δE) Scan 

Emission Mono Setup 

Delta Energy (cm-1): Enter a value. 
Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list. Select Custom to enter a value from 0 to 1250. 

Response Width (nm): Select 0, 0.5, 0.75, 1, 2.5, 5, 10, or 20 

NOTE: In order to get a better repeatability data, it is suggested to set the response width at 
least to be value nearest (Excitation slit width +Emission slit width)/2. Eg. When set 
Excitation slit width to be 5 nm, Emission slit width to be 2.5 nm, it is suggested to set 
response width to be 5 nm. 

Em. Corr.: Select On, Off, or File from the drop-down list. 

NOTE: In the Phosphorescence Mode you need to enter two additional settings; a Delay 
(us) time value and a Gate (ms) time value. 

Gain  
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Scan Mode 
Single Scan: Select Intensity, Polarization, or Anisotropy. 
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3D Scan 
Scan Type setting: Excitation Scan 

Enter the Number of Scans and the Emission increment(nm). 
Scan Type setting: Emission Scan 

Enter the Number of Scans and the Excitation increment(nm). 

Scan Type setting: Synchronous (δλ) Scan 

Enter the Number of Scans and the Delta lambda increment(nm). 

Scan Type setting: Synchronous (δE) Scan 

Enter the Number of Scans and the Delta energy increment(cm-1) 
Repeat Scan: Enter the Number of Scans and a Repeat Option (select Repeat with 

time or Repeat with User Prompt). 

Auto Peak (Displays only when Pre-Scan is selected as the Scan Type) 
Solvent: Select Water, Ethanol, Cyclohexane, Chloroform, Carbon tetrachloride, Other. 

Raman Wavenumber (cm-1):  This number is based on the Solvent selection. When 
selecting Other enter a value. 

Rayleigh scatter check: Click the check box to select Rayleigh scatter check. 

Raman scatter check: Click the check box to select Raman scatter check. 

2nd order check: Click the check box to select 2nd order check. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 

For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 
Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 
Import or Export a sample table. 

Fill Down or Clear Measured table rows. 
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Single Read 
The Single Read application method enables measurements (intensity, concentration, polarization, 
anisotropy) to be made at fixed wavelengths. The data are saved on the hard disk in an Excel 
compatible file format.  

Data Collection Tab 
Calculation Mode 

Select Intensity, Polarization, or Anisotrophy. 
Background Correction: Measures the current background intensity. This value is used for 
all subsequent reference measurements. 

Save Results: Saves the results after analysis. 

Instrument Setting 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 
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Power Maximum Frequency 
20 200 
40 200 
80 100 

120 50 
 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Bioluminescence  (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Chopper (Hz): Select a Chopper value of 10, 20, or 40 from the drop-
down list. 

Phosphorescence 

Ex. Corr: Select On, Off, or File. 

Chopper (Hz): Select a Chopper value: 10, 20, or 40. 
Bioluminescence (No additional settings required) 

Excitation 
(Not applicable in the Bioluminescence Mode.) 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 
Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 

Excitation Filter: Click the Choose Filter button or select from the drop-down list. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 
Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 
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Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list.  Select Custom to enter a value. 

Intrgration Time (ms): Enter a value. 
Em. Corr.: Select On, Off, or File from the drop-down list. 

NOTE: In the Phosphorescence Mode only enter a Delay (us) time value and a Gate (ms) 
time value. 

Gain  

PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 
Note:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 
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Time Drive 
This application method allows a user to make luminescence (fluorescence, phosphorescence and 
bioluminescence) measurements at fixed wavelengths with well-defined intervals over a specified 
period of time.  

Data Collection Tab 
Immediate Mode: Click the check box to set Immediate Mode. 

Backgroung Correction: Click the check box to set Background Correction. 
Remote Start: Click the check box for remote start. 

NOTE: Select Remote Start if you wish to have data collection with a device which can provide 
external signal, for example a Rapid Mixing device. Data collection is initiated on 
receiving a trigger signal. 

Instrument Setting 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
NOTE: The maximum frequency for each power is listed in the following table. 
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Power Maximum Frequency 
20 200 
40 200 
80 100 

120 50 
 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Bioluminescence  (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Chopper (Hz): Select a Chopper value of 10, 20, or 40 from the drop-
down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File. 
Chopper (Hz): Select a Chopper value: 10, 20, or 40. 

Bioluminescence (No additional settings required) 

Excitation 
(Not applicable in the Bioluminescence Mode.) 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 

Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 

Excitation Filter: Click the Choose Filter button or select from the drop-down list. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 
Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 
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Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list.  Select Custom to enter a value. 

Response Time (sec): Enter a value. 

Em. Corr.: Select On, Off, or File from the drop-down list. 

NOTE: In the Phosphorescence Mode only enter a Delay (us) time value and a Gate (ms) 
time value. 

Gain  

PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Time 

Time Drive Settings 

Duration: Enter a Duration time.  Select Second or Minute. 

Data Interval: Enter a Data Interval value.   
Event Marker Active: Click the check box to set the Event Marker Active. 

NOTE: Select Event Marker Active to mark events during a time drive run, for example 
marking the addition of a reagent to the sample. Timed events can be marked using 
press event button which located at the front of instrument. Once data acquisition starts, 
the data file with the extension *.td plus a second file using the same name but with the 
file extension *.tde will be displayed in the graph panel. This has a constant ordinate 
value -100 except for the marked events which result in a spike for each event.  

Delay Before Measure: Enter a delay time. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 
Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 
For each sample row you can Add, Insert, Remove, and move the row Up or Down. 

Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 
Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 



Method Setup . 25 

 

 

Import or Export a sample table. 

Fill Down or Clear Measured table rows. 

Advanced Tab 
In a table format, Add, Remove, or Clear a process associated with the method. 

Settings: If available modify any editable settings. 
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Lifetime 
This application method measures the phosphorescence lifetime (delayed fluorescence) of sample.  

Data Collection Tab 
Remote Start: Select the check box if you have a remote start. 

Instrument Setting 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence Mode: Select Phosphorescence (short) or Phosphorescence (long). 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

NOTE: The Flash Count value in only necessary when the Luminescence Mode is 
Phosphorescence (long). 

Power (kW): Select a power value: 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select a frequency value: 50, 100, or 200 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence Mode: Select Phosphorescence (short) or Phosphorescence (long).   

When you select Phosphorescence (long) enter an Open Time (ms). 
When you select Phosphorescence (short) select a Chopper value: 10, 20, or 40 Hz 
from the drop-down list. 

Ex. Corr: Select On, Off, or File from the drop-down list 
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Excitation 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 

Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 

Excitation Filter: Click the Choose Filter button or select a value from the drop-down list. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 
Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list.  Select Custom to enter a value. 

Response Time (sec): Enter a value. 
Em. Corr.: Select On, Off, or File from the drop-down list. 

Delay (us): Enter a Delay time value. 
Gate (ms):  Enter a Gate time value 

Gain 
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Lifetime 
Data Interval: Enter a Data Interval value. 

NOTE:  Enter a Data Interval value only when Phosphorescence (long) is selected. 

Description Tab 
Method Name: Type a name for your method. 
Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 
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Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 
For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 

Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 

Import or Export a sample table. 
Fill Down or Clear Measured table rows. 
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Quantification 
This application method is used for the determination of unknown concentration of a sample by 
assuming a relationship between fluorescence intensity of the unknown and concentration. The can 
be measured at a fixed excitation/emission wavelength (wavelength quantification) or on a peak 
height or area (scanning quantification). 

Data Collection Tab 
Quant Mode 

Select Wavelength Quant or Scan Quant. 

Settings 
For each of the settings in the table (Setting1, Setting2, Setting3) select Active or BG by 
clicking in the check box. 

Instrument Settings 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Realtime Dark 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count:  Enter a value from 1 to 10. 
Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 
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Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Bioluminescence (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Realtime Dark 

Chopper (Hz): Select 10, 20, or 40 from the drop-down list. 
 Phosphorescence 

Ex. Corr: Select On, Off, or File from the drop-down list. 
Chopper (Hz): Select 10, 20, or 40 from the drop-down list. 

Bioluminescence (No additional settings required) 

Excitation 
(Not applicable in the Bioluminescence Mode.) 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Start Wavelength. 

Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 
Excitation Filter: Click the Choose Filter button or select from the drop-down list. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Scan Quant - Emission Mono Setup  

Click the Full Range button or set your own values: 

Emission Start Wavelength (nm): Enter a value. 

Emission End Wavelength (nm): Enter a value. 
Emission Slit Width (nm): 0.5, 1, 2.5, 5, 10 or 20 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 
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Scan Speed: Enter a value in nm/min. 

NOTE:  As you move up in power, Scan Speed options will change. 

Wavelength Quant - Emission Mono Setup  

Emission Wavelength (nm): Enter a value. 

Emission Slit Width (nm): 0.5, 1, 2.5, 5, 10 or 20 
Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list. Select Custom to enter a value. 
Response Width (nm): Select 0, 0.5, 0.75, 1, 2.5, 5, 10, or 20 from the drop-down list. 

Em. Corr.: Select On, Off, or File from the drop-down list. 

NOTE: In the Phosphorescence Mode only enter a Delay (us) time value and a Gate (ms) 
time value. 

Gain  

PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 
Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Quant Tab 
Component: View or modify the component type and Units. 

Calibration 
Type: Select the calibration type from the drop-down list (Calibration Curve or User Defined Curve). 
Type of curve: Select the curve type from the drop-down list (Auto, Linear, Cubic, or 
Quadratic). 

Force through zero:  Click this check box to force the curve through zero. 

Units 
Correlation (r^2): Click this check box to select or enter a correlation value. 
Standard tolerance (%): Click this check box to select or enter a standard tolerance value. 

Control samples tolerance (%): Click this check box to select this setting. 
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Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 

For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 

NOTE: In the Design tab, by entering multiple Replicates or Measurements allow a user to 
get average quantification results for sample type.  In addition, note that the 
Concentration column is a mandatory field for Standard and Control Type.  If using the 
Calibration Curve type for quantification without force through zero, at least 2 standards 
need to be added.  

Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 
Import or Export a sample table. 

Fill Down or Clear Measured table rows. 

Advanced Tab 
In a table format, Add, Remove, or Clear a process associated with the method. 

Settings: If available modify any editable settings. 
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Wavelength Program 
This application method allows for a routine acquisition of time-dependent, multi-channel (multiple 
Excitation/Emission combinations).  

Data Collection Tab 
Measured Num: Select a value from the drop-down list or enter a value. 

Background Correction: Click the check box to set Background Correction. 
Remote Start: Click the check box for remote start. 

Instrument Setting 

 

Source 
Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
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Bioluminescence  (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Chopper (Hz): Select a Chopper value of 10, 20, or 40 from the drop-
down list. 

Phosphorescence 
Ex. Corr: Select On, Off, or File. 
Chopper (Hz): Select a Chopper value: 10, 20, or 40. 

Bioluminescence (No additional settings required) 

Excitation 
(Not applicable in the Bioluminescence Mode.) 

Excitation Setup 

For each ID in the table enter: 
Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 
Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 
Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Emission Setup 

For each ID in the table enter: 

Emission Wavelength (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list. 

Select Custom to enter a value. 
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Integration Time (ms): Enter a value. 

Em. Corr.: Select On, Off, or File from the drop-down list. 

NOTE: In the Phosphorescence Mode only enter a Delay (us) time value and a Gate (ms) 
time value. 

Gain  
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Time 

Time Drive Settings 

Duration: Enter a Duration time.  Select Second or Minute. 
Data Interval: Enter a Data Interval value. 

Delay Before Measure: Enter a delay value. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 
Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 
For each sample row you can Add, Insert, Remove, and move the row Up or Down. 

Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 
Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 

Import or Export a sample table. 

Fill Down or Clear Measured table rows. 
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Kinetics 
This is an application that is based on the Time Drive method. It allows for the automatic 
calculation of initial reaction rates and reaction velocities for enzyme kinetics  

Data Collection Tab 
Background Correction: Click the check box to set Background Correction. 
Remote Start: Click the check box for remote start. 

Instrument Setting 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power(kW): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency(Hz): Select 50, 100, or 200 from the drop-down list. 

 Phosphorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Bioluminescence  (No additional settings required) 
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Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Chopper (Hz): Select a Chopper value: 10, 20, or 40. 
Phosphorescence 

Ex. Corr: Select On, Off, or File from the drop-down list. 
Chopper (Hz): Select a Chopper value: 10, 20, or 40. 

Bioluminescence (No additional settings required) 

Excitation 
(Not applicable in the Bioluminescence Mode.) 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 
Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 
Excitation Filter: Click the Choose Filter button or select a filter from the drop-down. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 
Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list. Select Custom to enter a value. 
Response Time (sec): Enter a value. 

Em. Corr.: Select On, Off, or File from the drop-down list. 

NOTE: In the Phosphorescence Mode only enter a Delay (us) time value and a Gate (ms) 
time value. 
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Gain  
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Time 

Time Drive Settings 

Duration: Enter a Duration time.  Select Second or Minute. 
Data Interval: Enter a Data Interval value or select a value from the drop-down list. 

Kinetics 
Calculation Time (s): Enter a Start and End time. 

Kinetics Model:  
Select Enzyme Kinetics then select the following plots from the drop-down list: 
Michaelis-Menten Plot, Lineweaver-Burk Plot, Hofstee Plot, or Eadie-Hofstee Plot. 
or 
Select Reaction Rate then select one of the following from the drop-down list: Zero 
Order, Initial Rate, First Order, or Delta AU. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 
Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 

For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 

NOTE: In the Enzyme Kinetics Model, the Concentration field is mandatory to fill in the 
value of substrate concentration. 

Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 
Import or Export a sample table. 

Fill Down or Clear Measured table rows. 
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Quenching 
This application method monitors the deactivation (quenching) of the excited state of fluorescence 
molecules in the presence of quencher molecules. The can be measured at a fixed 
excitation/emission wavelength (wavelength quenching) or on a peak height or area (scanning 
quenching) and yields the Stern-Volmer constant. 

Data Collection Tab 
Mode 

Select the Wavelength or Scan mode. 
Select the Background Correction check box to measure the current background intensity. 
This value is used for all subsequent reference measurements. 

Instrument Setting 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File.  (Does not apply for Bioluminescence) 

Dark Apply (Does not apply for Bioluminescence) 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Phosphorescence 

Ex. Corr: Select On, Off, or File. 
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Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Bioluminescence  (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: View the source mode, Pulse or Continuous.  This is set when you select 
your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File. 

Dark Apply (Does not apply for Bioluminescence) 

Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Chopper (Hz): Select a Chopper value: 10, 20, or 40. 
Phosphorescence 

Ex. Corr: Select On, Off, or File. 

Chopper (Hz): Select a Chopper value: 10, 20, or 40. 
Bioluminescence (No additional settings required) 

Excitation 
(Not applicable in the Bioluminescence Mode.) 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 

Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 
Excitation Filter: Click the Choose Filter button or select from the drop-down. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Wavelength Mode - Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 
Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 

Scan Mode - Emission Mono Setup 

Click the Full Range button or set your own values: 
Emission Start Wavelength (nm): Enter a value. 

Emission End Wavelength (nm): Enter a value. 
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Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 
Scan Speed (nm): Select 30, 60, 240, 1200, or 2400 from the drop-down list. 

NOTE:  As you move up in power, Scan Speed options will change. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list.  Select Custom to enter a value. 

Wavelength Mode - Integration Time (ms): Enter a value. 
Scan Mode - Response Width (nm): Select a value from the drop-down list. 

Em. Corr.: Select On, Off, or File. 

NOTE: In the Phosphorescence Mode only enter a Delay (us) time value and a Gate (ms) 
time value. 

Gain  
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Quenching 
Select a Model from the drop-down list: F0/F vs [Q] or (F0/F-1)[Q] vs [Q]. 

Description Tab 
Method Name: Type a name for your method. 
Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, Type, and 
Concentration. There is also an indicator to show if the sample has been measured or not. The 
right side contains buttons to control the samples. 

For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 

NOTE: The Concentration field is mandatory to fill in the quencher concentration.  The 1st 
entry should be a sample without any quencher, so the concentration should be 0.  

Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the table. 
Import or Export a sample table. 
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Fill Down or Clear Measured table rows. 
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Quantum Yield 
This application method measures the ratio of the number of photons emitted to the number of 
photons absorbed.  This method provides the option of measuring either the relative or absolute 
fluorescence quantum yields. The absolute quantum yield require the use of the integrating sphere. 

Data Collection Tab 
Calc Mode 
Select Absolute or Relative. 

Absolute: If selecting Absolute then select a Calc Method of Simplification or De Mello. 
Relative: If selecting Relative then select or deselect the Background Correction check 
box. 

Instrument Setting 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Fluorescence. 
Ex. Corr: Select On, Off, or File 

Dark Apply 

Initial Dark: Click the check box to set Initial Dark. 
Realtime Dark 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
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Luminescence: Fluorescence. 
Ex. Corr: Select On, Off, or File 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Realtime Dark 
Chopper (Hz): Select a Chopper value of 10, 20, or 40 from the drop-down list. 

Excitation 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value for the Excitation Wavelength. 
Excitation Slit Width (nm): Enter a value for the Excitation Slit Width. 
Excitation Filter: Click the Choose Filter button or select a filter from the drop-down 
list. 

Accessory 
Accessory Setup: Select an Accessory from the drop-down list. 

Emission 

Emission Mono Setup 

Click the Full Range button or set your own values: 

Emission Start Wavelength (nm): Enter a value. 
Emission End Wavelength (nm): Enter a value. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down list. 
Scan Speed: Select a value of 30, 60, 240, 1200, or 2400 from the drop-down list. 

NOTE:  As you move up in power, Scan Speed options will change. 

Acquisition 

Detector Setup 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom 
from the drop-down list. 

Select Custom to enter a value. 
Response Width (nm): Select a value from the drop-down list. 
Em. Corr.: Select On, Off, or File from the drop-down list. 

Gain  
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Calculation 
Select Base 1 and/or Base 2 and a table contains the following columns: Name, Peak Start, 
Peak End, Peak Base 1, and Peak Base 2. 



Method Setup . 45 

 

 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 
Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 
For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 

NOTE: The column of Absorbance and Refractive is mandatory for Sample and Standard type, 
the column of Quantum Yield is mandatory for Standard type. Additionally, multiple 
measurement can allow relative Quantum Yield calculation in the Gradient mode. A 
different measurement number means a different absorbance level. 

Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 
Import or Export a sample table. 

Fill Down or Clear Measured table rows. 
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Absorbance 
This application method uses the absorbance accessory to measure the absorbance of a sample. 
The absorbance can be measured/monitored at a number of fixed wavelengths (wavelength 
absorbance) or across the entire spectrum in the scanning absorbance option.  

Data Collection Tab 
Scan Mode 

Select Wavelength or Scan 
Auto Filter Selection: Click the check box to select Auto Filter Selection. 
Background Correction: This check box is automatically selected. 

Instrument Settings 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Absorbance is automatically selected. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click this check box to select Real-time Dark. 

Power (kW): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Absorbance is automatically selected. 

Dark Apply 
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Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click this check box to select Real-time Dark. 

Chopper (Hz): Select 10, 20, or 40 from the drop-down list. 

Excitation 

Wavelength Mode 

Excitation Setup 
Excitation Wavelength (nm) table: Build a wavelength table. Add or Remove 
rows by using the buttons. 

Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list. 
Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down list. 

Scan Mode 

Excitation Mono Setup 
Excitation Start Wavelength (nm): Enter a value. 

Excitation End Wavelength (nm): Enter a value. 

Or click the Full Range button (190 - 900 nm) 
Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down list. 

Scan Speed (nm/min): Select 30, 60, 240, 1200, or 2400 from the drop-down list. 

NOTE:  As you move up in power, Scan Speed options will change. 

Accessory 
Accessory Setup 

Accessory: Select an Accessory from the drop-down list: Absorbance or Water Jacket 
Absorbance Module with Stirrer. 

Detector 

PD Amp Level: Select x1 through x8 from the drop-down list. 
Integration Time (ms): Enter an Integration Time. 

When Water Jacket Absorbance Module with Stirrer is selected select a Stirrer 
Speed of Stop, Low, Middle, or High from the drop-down list. 

Description Tab 
Method Name: Type a name for your method. 
Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 
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Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 

For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 
Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 

Import or Export a sample table. 
Fill Down or Clear Measured table rows. 
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Fast Filter  
The Fast Filter method is used to specify the data collection conditions when using the Fast Filter 
accessory. The Fast Filter accessory enables rapid measurement of intracellular concentration. This 
accessory consists of two filter wheels. Up to two pairs of filters or polarizers can be fitted on each 
filter wheel: the filter wheels rotate rapidly and enable each filter to be in the beam coincident with 
source lamp. A data point is then measured. For example, if calcium changes are being monitored 
using FURA-2, a pair of filters (340 and 380 nm) are fitted in the excitation filter wheel and the 
emission is monitored at 510 nm using emission monochromator. The data for each run is saved in 
three time drive files with an extension of .td. The file name ending N, D or A is automatically 
added for the identification of the data type contained within that file: 

*n.td= numerator for producing ratios of the measured data 

*d.td= denominator for producing ratios of the measured data 
*a.td= ratio of the intensity values of the above data 

The polarizer filter set can be fitted to calculate the polarization or anisotropy of a sample. 
Fluorescence polarization is a very powerful technique for studying the rotational movement of 
molecules dynamically.  

Polarization is calculated using the following equation: 

𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑛𝑛 =
𝐼𝐼𝐼𝐼𝐼𝐼 − (𝐺𝐺𝐺𝐺 ∙ 𝐼𝐼𝐼𝐼ℎ)
𝐼𝐼𝐼𝐼𝐼𝐼 + (𝐺𝐺𝐺𝐺 ∙ 𝐼𝐼𝐼𝐼ℎ)

 

Anisotropy is calculated using the following equation: 

𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴 =
𝐼𝐼𝐼𝐼𝐼𝐼 − (𝐺𝐺𝐺𝐺 ∙ 𝐼𝐼𝐼𝐼ℎ)
𝐼𝐼𝐼𝐼𝐼𝐼 + (2𝐺𝐺𝐺𝐺 ∙ 𝐼𝐼𝐼𝐼ℎ)

 

Where: 

Ivv= Emission intensity with both excitation and emission polarisers vertical. 
Ivh=Emission intensity with excitation polarizer vertical and emission polarizer horizontal. 

GF= Grating factor 

Data Collection Tab 
Filter Mode 

Select Excitation FFA, Emission FFA, Polarisation, Anisotropy or GF. 

Immediate Mode: Click the check box to set Immediate Mode. 

Background Correction: Click the check box to set Background Correction. 

Remote Start: Click the check box for remote start. 

Instrument Settings 
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Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Fluorescence is automatically selected. 
Ex. Corr: Select On, Off, or File 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 

Power (kW): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 

120 50 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Fluorescence is automatically selected. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 

Chopper (Hz): Chopper control is not available when using the Fast Filter 
Accessory. 

Excitation 

Excitation Mono Setup 

Excitation Wavelength (nm): Enter a value. 

NOTE: When the Excitation FFA has been selected, the excitation wavelength is fixed at zero 
order to allow the excitation wavelength to be defined solely by the Fast Filter, so the 
excitation wavelength is disabled 

Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down list. 

Accessory 
Accessory Setup 

Accessory: Fast Filter is automatically selected. 
Extra Accessory: Select an accessory from the drop-down list. 
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Fast Filter 
Excitation FFA /Emission FFA 

The fixed filter position can be selected via clicking the position ID in the below image. The Left 
image is for the Excitation filter, which is available for Emission FFA, and the right image is for the 
Emission filter which is available for Excitation FFA. The red highlighted position will be fixed during 
run a Excitation FFA or Emission FFA. 

 
Ratio 1: Click the checkbox to enable the first ratio 

Ratio 2: Click the checkbox to enable the second ratio 

Name: Enter a name for the ratio in this box. 
Numerator: Select a filter to use as the numerator for the ratio. 

NOTE: Selecting a filter for the numerator will cause the denominator value to be automatically 
set. 

 Edit Filters: Click this to open and edit the filter information. 

  Save as Global: Saves the current Fast Filter Settings as the default. 
  Load Global Setting: Reverts the Fast Filter Settings to the last saved global settings 

 Stirrer Control: Select a stirrer speed from the dropdown list. 
Polarization/Anisotropy/GF 

When selecting Polarization/Anisotropy mode, the excitation filter will be fixed at the filter position 
which has been specified as Excitation Vertical polarizer. 

When selecting GF mode, the excitation filter will be fixed at filter position which has been 
specified as the Excitation Horizontal polarizer. 
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Excitation: 
Verticality:  Selecting a filter for Verticality Polarizer in Excitation filter wheel of Fast Filter. 

NOTE: Selecting a filter for the Verticality will cause the Horizontality value to be automatically 
set. 

Emission: 

Verticality:  Selecting a filter for Verticality Polarizer in Emission filter wheel of Fast Filter. 

NOTE: Selecting a filter for the Verticality will cause the Horizontality value to be automatically 
set. 

Edit Filters: Click this to open and edit the filter information. 

  Save as Global: Saves the current Fast Filter Settings as the default. 
  Load Global Setting: Reverts the Fast Filter Settings to the last saved global settings 

 Grating Factor: 
GF Calculate: Enter the Grating factor in this textbox manually or calculated by pressing 
the “GF Calculate” button. This parameter is only available when selecting 
Polarization/Anisotropy. 

 Stirrer Control: Select a stirrer speed from the dropdown list. 

Emission 
Emission Mono Setup 

Emission Wavelength (nm): Enter a value. 

NOTE: When emission FFA has been selected, the emission wavelength is fixed at the zero 
order position, which selects the emission light according to the filters fitted. 

Emission  Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list. 
Emission Filter: Click the Choose Filter button or select a filter from the drop-down 
list. 

Detector 
Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list.  Select Custom to enter a value. 

Response Time (sec): Enter a value. 
Em. Corr.: Select On, Off, or File from the drop-down list. 

Gain  
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Time 
Duration: Enter a Duration time.  Select Second or Minute. 

Data Interval: Enter a Data Interval value.   
Delay Before Measure: Enter a delay time. 
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Description Tab 
Method Name: Type a name for your method. 
Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 

For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 
Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 
Import or Export a sample table. 

Fill Down or Clear Measured table rows. 
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Microplate Reader 
This Scan application is used for collecting various types of spectral data in a variety of modes 
(fluorescence, phosphorescence, and bioluminescence) using the Microplate Reader accessories.  

Data Collection Tab 
Measured Num: Enter the number of scans for each sample cell here. 

Instrument Settings 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence Mode: Select Fluorescence, Phosphorescence or Bioluminescence. 

      Ex. Corr: Select On, Off, or File from the drop-down list. 

      Dark Apply: 
Initial Dark: Click the check box to set Initial Dark. 

      Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence or Bioluminescence. 

 Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 

Chopper (Hz): Chopper control is not available when using the Microplate Reader 
Accessory. 
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Excitation 
Excitation Setup 

Excitation Wavelength (nm): Enter a value for each ID in the table 

Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list for 
each ID in the table 

NOTE: The number of entries in the excitation setup is dependent on the number of 
measurements selected. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down list. 

Accessory 
Accessory Setup 

Accessory: Microplate Reader is automatically selected. 
Extra Accessory: No extra accessories can be selected in this method type. 

Measurement Option 
Center of Cell: Measurements are taken from the centre of the cell on the microplate. 

Customize: Enable custom settings for cell measurement.  

The points of measurement are selected by clicking on the blue circle. 

 
Clear: clears the selected points of measurement in the cell. 

Calculation Mode 

 Average: the measured value is the average intensity of the points selected in customized 
measurements. 

 Sum: The measured value is the sum of intensities of the points selected in customized 
measurements.  

NOTE: Calculation Mode is only enabled when the Customize option is selected. 

Cycle Settings 
 Cycle Number: Set the number of cycles of the selected spots measured in a customized 

measurement. 

 Time Interval (s): Sets the time interval between selected points in a customized 
measurement.  
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Emission 
Emission Wavelength (nm): Enter a value for each ID in the table. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list for each ID 
in the table. 

NOTE: The number of entries in the excitation setup is dependent on the number of 
measurements selected. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down list. 

Detector 

Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list. Select Custom to enter a value. 
Em. Corr.: Select On, Off, or File from the drop-down list. 

Integration Time (ms): Enter an Integration Time. 
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE: The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 

Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 
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Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 
The Position tab opens the Microplate view, in the configuration which has been set in Options. 
Sample positions can be added here either by left clicking on the desired plate position or dragging 
a block in the image to select multiple lines and rows 

 
For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 
Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 
Import or Export a sample table. 

Fill Down or Clear Measured table rows. 
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Simple Read Method 
This Scan application is used for collecting tabular reading in Intensity, Polarization or Anisotropy. 
It can also be used for collecting reading in Intensity/Polarisation/Anisotropy based on ramp 
temperature.  

Data Collection Tab 
Measured Num: Enter the number of scans for each sample cell here. 

Calculation mode: Select Intensity, Polarization, or Anisotropy. 

Instrument Settings 

 

Source 

Source Setup (FL 6500) 

Source Mode: Pulse.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 

NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

 
Phosphorescence 

Ex. Corr: Select On, Off, or File from the drop-down list. 
Flash Count: Enter a value from 1 to 10. 

Power (kw): Select 20, 40, 80, or 120 from the drop-down list. 
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NOTE: The maximum frequency for each power is listed in the following table. 

Power Maximum Frequency 
20 200 
40 200 
80 100 
120 50 

Frequency (Hz): Select 50, 100, or 200 from the drop-down list. 
Bioluminescence  (No additional settings required) 

Source Setup (FL 8500) 

Source Mode: Continuous.  This is set when you select your Instrument Connection.  
Luminescence: Select Fluorescence, Phosphorescence, or Bioluminescence. 

Fluorescence 
Ex. Corr: Select On, Off, or File from the drop-down list. 

Dark Apply 
Initial Dark: Click the check box to set Initial Dark. 
Real-time Dark: Click the check box to set Real-time Dark. 

Chopper (Hz): Select a Chopper value of 10, 20, or 40 from the drop-
down list. 

Phosphorescence 

Ex. Corr: Select On, Off, or File. 

Chopper (Hz): Select a Chopper value: 10, 20, or 40. 
Bioluminescence (No additional settings required) 

Excitation 
Excitation Setup 

Excitation Wavelength (nm): Enter a value for each ID in the table. 
Excitation Slit Width (nm): Select 1, 2.5, 5, 10 or 20 from the drop-down list for 

each ID in the table. 

NOTE: The number of entries in the excitation setup is dependent on the number of 
measurements selected. 

Excitation Filter: Click the Choose Filter button or select a filter from the drop-
down list. 

Accessory 
Accessory Setup 

Accessory: select the Single Cell Holder, Single Cell Peltier Holder or 4-position multi-
cell peltier holder from the dropdown list. 

Extra Accessory: select the Auto Sipper or S10 Autosampler from the dropdown list. 
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Emission 
Emission Wavelength (nm): Enter a value for each ID in the table. 

Emission Slit Width (nm): Select 0.5, 1, 2.5, 5, 10 or 20 from the drop-down list for 
each ID in the table. 

NOTE:  The number of entries in the excitation setup is dependent on the number of 
measurements selected. 

Emission Filter: Click the Choose Filter button or select a filter from the drop-down 
list. 

Detector 
Photomultiplier Voltage (V): Select Low (400), Medium (550), High (700), or Custom from 
the drop-down list. Select Custom to enter a value. 

Em. Corr.: Select On, Off, or File from the drop-down list. 

Integration Time (ms): Enter an Integration Time. 
PMT: Select a gain of x1, x8, x64, x512, or Auto from the drop-down list. 

NOTE:  The PMT Gain is a multiplier of the Photomultiplier Voltage. 

Description Tab 
Method Name: Type a name for your method. 

Notes: Type notes specific to this method. 
Signatures (ES version): Select Sign, Review, or Approve from the drop-down list. 

Sample Table Tab 
The Sample Table provides a listing of samples by Sample ID, Description, and Type. There is 
also an indicator to show if the sample has been measured or not. The right side contains buttons 
to control the samples. 
For each sample row you can Add, Insert, Remove, and move the row Up or Down. 
Format Sample Table: Opens a Table Builder dialog where you can add Preparation 
information, add custom Columns, and add ID information. 

Setups...: Opens a Sample Table Setups dialog where you can Save the current Sample Table, 
Delete, Set as current, Import, Export, and with Signatures, Sign, Review and Approve the 
table. 

Import or Export a sample table. 
Fill Down or Clear Measured table row



 

 

Accessories Setup 
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Accessories Overview  
Some of the accessories for the FL6500/FL8500 Fluorescence Spectrometers require setup in the 
software; this includes the Microplate Reader Accessory, Multi-Cell holder and Multi-Cell 
Peltier holder Accessories and the S10 Autosampler Accessory. All the accessory setup 

options are accessed from the Options tab  
 
This section will give a brief overview of the functions for the accessory setup tools in Spectrum FL. 
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Multi-Cell Accessory Setup 
 
The Multi-Cell setup menu is compatible with all the Multi-Cell accessories used in the 
FL6500/FL8500 Fluorescence Spectrometers. Multi-cell setup functions are accessed from the 

Multi Cell page
  

under the Options tab. 

 

Calibration 
Total Step: the total number of motor steps the Multi-cell can travel. (Cannot be altered) 
PMT Voltage (V): Enter a value between 0 and 1250V which could not make peak saturated. 

Scan Speed (nm/minute): Select a value from the drop-down list. 
Calibrate: Begins the automated calibration of the Mutli-Cell accessory.  
Stop: Stops the automated calibration procedure (only available once the calibration has been 
started) 

Cell Position 
Cell 1, Cell 2, Cell 3, Cell 4: Values for cell position are entered here after calibration has 
finished. Values can also be entered manually. 

Save: Save the current cell position values. 
Load: Load the previous saved cell position values from the hardware. 

NOTE: In the ES version, only the user need permission of “Cell Changer Calibration” to 
Calibrate and Save the cell position. 

Move 
Move to: Moves to the saved position of the cell selected from the dropdown list. 
Reset: Returns the Multi-cell to its default position. 

 
Multi-cell setup parameters in the method can be accessed when selecting a multicell accessory in 
the method. 
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Step 1: Select the cell changer accessory from Accessory drop-down list under Accessory block. 

 
 
Step 2: Set the Active Cell by selecting or deselecting the check boxes to the left of the cell 
numbers. Only the actived cell(s) can be shown in the sample table for sample measurement. 
 

 
 
 
 

 
 
Step 3: When Background Correct is selected, a correction option can also be selected. 
 

 
Background correction at each cell: Perform background correction for each cell 
position, and apply background data according to cell position number. 
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Background correction at Position: Perform background correction for specified cell 
position, and apply same background data for all samples. 

 
Step 4: Set the Stirrer Speed when selecting an accessory with stirrer controls. 

 
 
Step 5: Set option of Sequential or Simultaneous in Time drive, Kinetic or Wavelength 
Program methods. 

 
Sequential: scan sample sequentially which means start next sample measurement after 
scanning the previous sample completely. 

Simultaneous: scan samples “simultaneously”, which means after mearsurement is 
started, a maximum of four samples are analyzed in the same run. 

 
Step 6: Cell position should be selected when running a method which uses a multi-cell changer 
accessory. 
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Microplate Reader Accessory Setup 
The Microplate reader menu is used to align and provide image configuration selection. Microplate 

reader setup functions are accessed from the Microplate Reader
  

page under the 

Options tab. 

P late Information 
Plate Setting: Select a set of default Microplate dimensions 
or a previously saved custom dimensions. 
Column Count: The number of columns present on the 
microplate. Values are set when a plate setting is selected, or 
can be entered manually. 

Row Count: The number of rows present on the microplate.  
Start X (mm): X-Axis start position of the Microplate Reader 
(Cell A1), calculated by distance from the edge of the plate. 
Start Y (mm): Y-Axis start position of the Microplate Reader 
(Cell A1), calculated by distance from the edge of the plate. 
Interval X (mm): The distance between the center point of 
two microplate cells on the X-axis. 

Interval Y (mm): The distance between the centre point of 
two microplate cells on the Y-axis. 
Radius (mm): The distance from the edge to the centre 
point of a Microplate Cell. 

NOTE: These values are populated when a default or saved plate dimensions are selected from 
the plate setting dropdown list. Details can also be entered manually. 

Reload: Reload the last saved entries for the selected plate setting 
Save: Save the current plate information. 

Manual Alignment: Opens the manual alignment wizard.  
Show Dimensions: Click the check box to see a visible representation of the listed distances 
on the plate diagram. 
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Operation 
Push out Plate: Moves the plate to a position from which it can 
be easily removed from the Microplate Reader Accessory. 

Move to Start Position: Moves the plate to the start position 
(the upper right-most limit that theplate can move). 
Lamp on: Activates the source lamp of the FL6500/FL8500 
Fluorescence Spectrometer. 
Lamp off: Deactivates the source lamp of the FL6500/FL8500 
Fluorescence Spectrometer. 

Move to: Moves the plate to the cell entered into the text box. 
 
Microplate Reader parameters in the method can be accessed when “Microplate Reader” is selected 
in Accessory setup. 
 

NOTE: The description here only details the settings in methods except Microplate Reader Type. 

 
Step 1: Select Microplate Reader from Accessory drop-down list under Accessory block. 

 
 
Step 2: When the Background Correction option is selected in the method, click the Select 
button and select Background Well Position,  then left-click on the desired well position. 

 
 
Step 3: Set the option of Sequential or Simultaneous in method of Time drive, Kinetic or 
Wavelength Program. 
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Sequential: scans samples sequentially, which the next sample measurement begins after the 
previous sample scan is completed. 
 
Simultaneous: scan samples “simultaneously”, which means after mearsurement is started, a 
maximum of 384 samples are analyzed in the same run. 
 
Step 4: A well position should be selected when running a method which uses microplate Reader 
accessory. 
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S10 Autosampler Acessory Setup 
 
The S10 Autosampler menu is used to initialize the S10, manage movement settings and set sipper 
parameters. Autosampler setup functions are accessed from the S10 Autosampler page 

 
under the Options tab. 

 

S10 Autosampler 
Initialize: Begins the initialization procedure of the S10. 
Port Number: Select a correct COM port from the dropdown 
list. (Defaults to the COM port used to connect the Autosampler 
to the PC). 
NOTE: The Max COM Port number is 9. 
Tray Layout: select a tray layout from the dropdown list. The 
selected layout will be shown in the display. 

Autosampler Move Setting  
Probe Depth (mm): enter a value (between 0 and 146) for 
the depth the autosampler probe descends. 
Move to Cell: Enter a numerical position from the displayed 
layout and click “move to cell” to move the Autosampler to the 
specified location. 
Move to X/Move to Y (mm): Enter a specified distance in the 
X and Y axes and click “move to” to move the Autosampler to 
the specified location. 

Autosampler Sipper Setting  
Pump Speed (RPM): set the pump speed (between 20 and 

120) of the sipper function. 
Fill Time (s): Enter a timespan that liquid is passed through the sample flow cell. 
Delay Time (s): Enter a timespan to delay between sample filling and flushing of the flow 
cell.  

Flush/Return Time (s): Enter a timespan that solvent is used to flush the flow cell after 
sampling and/or liquid is returned to the sample bay from the flow cell. 

Flush/ Return Option 
Flush: sets the Autosampler and sipper to flush the flow cell after sampling. 
Sample Return: sets the Autosampler and sipper to return sample from the flow cell. 

Fill: Starts the sipper motor, moving fluid in the direction of the Flow Cell 

Flush: Starts the sipper motor, drawing fluid from the flow cell. 
Stop: Stops the sipper motor. 
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To access S10 Autosampler setup parameters in the method, follow this procedure: 
S10 parameters in the method can be accessed when “S10 Autosampler” is selected in the Extra 
Accessory list. Normally, it will be compatible with single cell holder accessory. 
Step 1: Select Single Cell Holder from the Accessory list drop-down list, then from the the 
Extra Accessories drop-down list select S10 Autosampler. 

 
Step 2: Setup S10 Autosampler parameters as shown below: 

 

Pump Speed (RPM) Enter the pump speed (between 20 and 120) of the sipper function. 

Probe Depth (mm) Enter a value (between 0 and 146) for the depth the autosampler probe 
descends. 

Fill Time (s) Enter the amount of time that the pump pulls sample through for. 

Delay Time (s) Enter the amount of time between the end of filling and the start of 
data collection. This is to allow for bubbles, turbulence, etc. 

Purge Direction Select “Flush” for a forward flush which pulls sample into the waste; 
select “return” for a backwards flush which returns sample to the 
original reservoir. Flushing occurs after data collection; 

Purge Time (s) Allows you to set the time for flushing or returning the sample using the 
internal peristaltic pump. 

Flush/Return Allows you to control the sipper directly. Starts to flush the flow cell as 
set by the selection of Flush or Return and the Purge Time. 

Fill Cell from 
Position 

Allows you to specify the position for background solvent. Then when 
background measurement, the sample will be filled from here. 

 

Step 3: Set customize parameter for Fill Time, Flush/Return Time (s), Delay Time, Probe 
Depth, AS Position, and Return Postion (only available when select Sample Return) in sample 
table when run a method which select S10 Autosampler accessory. 
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Sipper Accessory Setup 
 
The sipper accessory can be auto-connected once the Sipper’s USB port is recognized via the 
software. Sipper manual control dialog can be accessed via clicking the arrow button for Sipper 
accessory. 
 

 
 

Sample Time (s) Enter the amount of time that the pump pulls sample through for. 

Delay Time (s) Enter the amount of time between the end of filling and the start of data 
collection. This is to allow for bubbles, turbulence, etc. 

Speed (RPM) Enter the rotation speed in RPM. 

Purge Direction Select “Flush” for a forward flush which pulls sample into the waste; select 
“Return” for a backwards flush which returns sample to the original 
reservoir. Flush occurs after data collection; 

Purge Time (s) Allows you to set the time for flushing or returning the sample using the 
sipper. 

Save Save current setting which will be displayed next time. And moreover, it 
will be the default setting for the sipper when create a new method. 

Default Restore to default setting 

Fill Allows you to control the sipper directly. Starts to fill the flow cell as set by 
the Sample time. 

Flush/Return Allows you to control the sipper directly. Starts to flush the flow cell as set 
by the selection of Flush or Return and the Purge Time. 

Stop Allow you to stop Fill or Flush/Return 

The Sipper’s parameters in the method can be accessed when “Auto Sipper” is selected in the Extra 
Accessories list. Normally, it will be compatible with the single cell holder accessory. 

Step 1: Select Single Cell Holder accessory from the Accessory drop-down list, and then select 
Auto Sipper from the Extra Accessories drop-down list. 
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Step 2: Setup Auto Sipper parameters in the method as shown below: 
 

 

Sample Time (s) Enter the amount of time that the pump pulls sample through for. 

Delay Time (s) Enter the amount of time between the end of filling and the start of data 
collection. This is to allow for bubbles, turbulence, etc. 

Speed (RPM) Enter the rotation speed in RPM. 

Purge Direction Select Flush for a forward flush which pull sample into waste, select 
Return for a backwards flush which return sample to the original 
reservoir. Flush occurs after data collection; 

Purge Time (s) Allow you to set the time for flushing or returning the sample using the 
sipper. 

Prompt before 
flushing the 
sample during 
data collection  

Select for a prompt to be called before flushing the sample at the end of 
data collection. 

Step 3: Set customized parameters for Fill Time, Flush/Return Time (s), and Delay Time in 
sample table when run a method which select Auto Sipper accessory. 
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Peltier Accessory Setup: 
 
Step 1: Click the Connect button to connect Peltier Control.  
 

 
 

Step 2: You can manually control control the peltier using the following screen. 

 

 
 

Probe Settings  This function is used to adjust temperature for Probe reading. It 
is only used for the manufacturing process, so do not modify the 
values except under help of PerkinElmer Service. 

Get Read the offset value from the hardware. 

Set Enter a new offset value and click “Set”, this will set the new 
offset value into hardware. 

Temperature settings  

Monitor  Select the temperature used to monitor during measurement. 
Options include: Block, Probe 1 or Probe 2.  

Temperature (℃)  Enter the target temperature for the experiment.  
NOTE: Starting temperature of experiment needs to be set up 
in the method window.  
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Range (℃)  Enter the error tolerance range.  

Go to Temp  Peltier control starts heating up or cooling down to the set 
temperature, meanwhile the Set temperature can be read in 
hardware screen.  

Auto Tuning  This function is used to minimize the temperature fluctuation at 
the target temperature. Click this button and wait until you see 
the warning of “Auto Tuning successful”. 

System Off  This function is used to stop the heating up or cooling down to 
the set Temperature in the Temperature Settings.  

Temperature Display  Select which temperature will be displayed on the panel: Block,  
Probe 1 or Probe 2. Note that the selected temperature is only 
displayed in real time. 

Save Settings  Save the Probe, Temperature and Temperature Display 
setting parameters. 

 

Save temperature settings and display as a default setting the 
next time the software software is reloaded. 

Step 3: Select either Single Cell Peltier Holder or 4-Position Multi-Cell Peltier Holder from 
the Accessory drop-down list in the method setup. 

 
Step 4: Select Temperature Mode and setup the parameters according to below table. 
 
Constant Mode: 

 
Constant mode  The measurement is only performed with isothermal state in 

the constant mode.  

Temperature (℃)  Enter the target temperature for experiment.  

Error Range (℃)  It shows the temperature tolerance between the target and 
monitored temperature. The measurement will start when 
the temperature tolerance reaches within the set error range.  
Example: Set the temperature at 20℃ and error range 0.2℃ 
and then the measurement will start when the temperature 
reaches between 19.8℃ and 20.2℃.  
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Monitor  Select temperature used to monitor during measurement. 
Options include: Block, Probe 1 or Probe 2.  

Return Temperature  Allows user to input a safety temperature, to which, the 
system can be returned before inserting a new sample or at 
the end of experiment. If this option is unchecked, it will 
keep current temperature for Constant mode. 

Ramp Mode: 

 

Ramp mode  The Ramp mode can be set up according to desired 
temperature conditions.  
Note: this option is only available in Spectra Scan 
method and Simple Read Method. 

Start (℃)  Enter the start temperature for the measurement.  

End (℃)  Enter the end temperature for the measurement.  

Interval (℃)  Enter the measurement interval temperature. For 
instance: when set at 5℃, the sample will be measured 
from start temperature to end temperature every 5℃.  

Rate (℃/min)  Enter the heating (or cooling) temperature rate in each 
temperature range.  

Hold (min)  Enter the holding time. For example, if you set 1 min, the 
measurement will start one minute after the temperature 
reaches at the set point.  

Waiting (min)  Enter the waiting time at the end of current gradient. For 
example, in the grade 1 setting, the measurement will be 
start after holding 1 min at each interval temperature 
(20, 25, 30, 35, 40), and it will wait 10 min after 
measurement at 40℃, then start next grade or finish 
current method.  

Error Range (℃)  It shows the temperature tolerance between the target 
and monitored temperature. The measurement will start 
when the temperature tolerance is measured within the 
set error range.  
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Example: Set the temperature at 20℃ and error range 
0.2℃ then, the measurement will start when the 
temperature is reached between 19.8℃ and 20.2℃.  

Add/Delete  Click on Add and Delete to edit the temperature range 
and the rate.  

Monitor  Select the temperature used to monitor during 
measurement. Options include: Block, Probe 1 or Probe 
2.  

Return Temperature  Allows the user to input a safety temperature, which can 
be returned before inserting new sample or at the end of 
experiment. If this option is unchecked, it will go to start 
temperature for Ramp Cycle 1. 

 
 



 

 

Collecting Data 



78 . Spectrum FL User's Guide 

 

Collecting Data 
Data is collected based on the type of method that is setup.   

• Spectra Scan 
• Single Read 
• Time Drive 
• Lifetime 
• Quantification 
• Wavelength Program 
• Kinetics 
• Quenching 
• Quantum Yield 
• Absorbance 
• Fast Filter 
• Microplate Reader 
• Simple Read 

After selecting and setting-up a method. To collect data: 

 Click Run in the Action Bar. 
                     OR 

     Click Run in the Action menu. 
The following points list some ways to use Spectrum FL to collect data using your instrument. 

• Collecting data from a single sample. 

• Collecting background spectra. 

• Collecting data and running a process. 

Backgrounds 
When collecting data to generate sample spectra, a first step is to collect a background spectrum 
from the instrument with no sample present. 
The background spectrum is subtracted from the sample spectrum to eliminates features 
introduced by the instrument response, the sampling accessory or sample cell, and features 
introduced by atmospheric absorption. 
If no valid background spectrum is available, a background spectrum must be collected before you 
begin to scan samples. 
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Data File Extension Summary 
The following table lists the data file extensions: 

  Data File 
Extension 

Spectra Scan - Single Scan .sp 
Spectra Scan - 3D Scan .sp3 
Spectra Scan - Repeat Scan .sp3 
Spectra Scan - Ramp Scan .sp3 
Single Read .wl 
Time Drive .td 
Time Drive Event .tde 

.tdex 
Lifetime .lt 

.ltx 
Wavelength Program .wl 
Absorbance .sp 
Fast Filer .td 
Simple Read – Ramp Scan .td 

  
 





 

 

Data Analysis 
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Processing Data 
These topics describe the range of processing commands that enable you to modify selected 
spectra. 

Absorbance 
%Transmittance 

Data Tune-up 
Baseline Correction 

Interactive Baseline Correction 
Difference 

Normalization 

Interpolate 
Convert X 

Smooth 
Derivative 

Arithmetic 

Deconvolution 
Polarization 

Anisotropy 
Peak Table 

Peak Area/Height 
Equations, available on the Data Analysis Navigation menu by default, requires you 
to set up one or more equations. 

NOTE: Before using a process ensure that it is appropriate for your data. For example, some 
processes may not be suitable for Raman data. 

To invoke a process command: 
➤     Select the appropriate command from the Process menu. 
          OR 

          Click the appropriate icon in the Process bar. 

          OR 
          Right-click on the curve you want to process in the Viewing Area pane, select Process 

from the shortcut menu, and then select the appropriate process command. 
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Absorbance 
Use the Absorbance process command to transform one or more spectra whose ordinate scale is in 
transmittance (%T) units to spectra whose ordinate scale is in absorbance (A) units. 

1.    Display and select the spectrum or spectra that you want to transform to absorbance (A) 
units. 

2.    Select Absorbance from the Process menu, or click  on the Process bar. 

          The selected spectra are transformed and displayed with absorbance (A) units. 

NOTE: Applying the Absorbance command to a spectrum in Spectrum FL Standard 
software does not generate a new result spectrum. However, the application of 
this data transform is logged in the spectrum History. In Spectrum FL ES 
software, a new spectrum is added to the Samples View (with _1 appended to 
the sample name) and the original spectrum is added to the Recycle Bin. 

Additional Information 
The natural result of the Fourier transform of the interferogram is a spectrum in Transmission. This 
scale, however, is multiplicative. If a film of thickness n of a material has a transmission of 90% at 
a certain position, a film of thickness 2n will not have a transmission of 80%, but 90% of 90% 
transmission, that is, 81% transmission. When using a transmittance scale the noise level is 
independent of the energy level, so the influence of noise on the spectrum is greater at low 
transmittance levels than at high transmittance levels. 
The Absorbance scale is a logarithmic transform of the multiplicative transmission scale that is 
additive. This means that absorbance spectra can be more reliably used for quantitative analysis 
(for example, Beer’s Law). 
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% Transmittance 
Use the Transmittance process command to transform one or more spectra whose ordinate scale is 
in absorbance (A) units to spectra whose ordinate scale is in transmittance (%T) units. 

1.    Display and select the spectrum or spectra that you want to transform to transmittance 
(%T) units. 

2.    Select Transmittance from the Process menu, or click  on the Process bar. 

          The selected spectra are transformed and displayed with transmittance (%T) units. 

NOTE: Applying the Transmittance command to a spectrum in Spectrum FL Standard 
software does not generate a new result spectrum. However, the application of 
this data transform is logged in the spectrum History. In Spectrum FL ES 
software, a new spectrum is added to the Samples View (with _1 appended to 
the sample name) and the original spectrum is added to the Recycle Bin. 

Additional Information 
The natural result of the Fourier transform of the interferogram is a spectrum in Transmission. This 
scale, however, is multiplicative. If a film of thickness n of a material has a transmission of 90% at 
a certain position, a film of thickness 2n will not have a transmission of 80%, but 90% of 90% 
transmission, that is, 81% transmission. When using a transmittance scale the noise level is 
independent of the energy level, so the influence of noise on the spectrum is greater at low 
transmittance levels than at high transmittance levels. 
The Absorbance scale is a logarithmic transform of the multiplicative transmission scale that is 
additive. This means that absorbance spectra can be more reliably used for quantitative analysis 
(for example, Beer’s Law). 
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Data Tune-up 
Use the Data Tune-up command to smooth, and to perform a baseline correction to remove any 
slope from, one or more spectra using a single command. 

CAUTION: Use the Data Tune-up process with discretion. The Smoothing component of the 
process can remove important data and generate misleading results by reducing the 
number of data points in the spectrum.  
Spectra that have plateau regions adjacent to sharp peaks (typical for gas samples) 
are especially vulnerable to excessive smoothing. 

1.    Display and select the spectrum or spectra that you want to process. 

2.    Select Data Tune-up from the Process menu, or click   on the Process bar. 

          The processed spectra are added to the Samples View and displayed in the Viewing Area. 

Additional Information 
The Smoothing component of the Data Tune-up process is a form of filtering that reduces noise, 
but also degrades the resolution of your spectra so that their features become broader. If you use 
too great a level of smoothing, bands are broadened excessively and resolution is lost. 

The Baseline Correction component of the Data Tune-up removes slope and bow from your 
spectra, but cannot remove more complex baseline features. 
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Baseline Correction 
Use the Baseline Correction process command to remove baseline features from one or more 
spectra. 

1.    Display and select the spectrum or spectra that you want to correct. 

2.   Select Baseline Correction from the Process menu, or click  on the Process bar. 

          The corrected spectra are added to the Samples View and displayed in the Viewing Area. 

Additional Information 
You can use the Baseline Correction process to remove slopes in the baseline of your spectra.  
You may want to correct the baseline of a sample spectrum before comparing it with reference 
spectra, or measuring peak intensities. 
The Baseline Correction process attempts to correct spectra without distorting the band intensities 
or introducing discontinuities. There must be significant regions of the spectrum that can be 
regarded as baseline. The process detects baseline portions of the spectra, and then bridges the 
data across the peaks to form a smoothed approximation to the baseline which is then subtracted 
from the original spectra in absorbance. 
The calculations are performed internally in absorbance to help preserve band intensities. 

As well as the automatic Baseline Correction, an Interactive Baseline Correction is available. The 
Interactive Baseline Correction allows you select multiple base points to create a baseline that will 
be subtracted from the spectrum. 
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Interactive Baseline Correction 
Interactive Baseline Correction (i-Baseline) enables to you to use the vertical cursor to specify 
where the base points of your spectrum lie. A smooth curve will be constructed through these 
points and subtracted from the spectrum. You can correct the baseline over the whole of the 
spectrum or the correction can be applied to a limited range of the spectrum. 
You can run the Interactive Baseline process on multiple spectra. However, note that the same 
parameters will be used to correct the baselines of all the spectra selected. If you wish to use 
different parameters for each spectrum, you should process the spectra individually. 

1.    Display and select the spectrum or spectra that you want to correct. 

2.    Select Interactive Baseline Correction from the Process menu. 
          OR 

          Click  if you have made it available on the Process bar. 

          The Interactive Baseline Correction dialog is displayed in the Viewing Area. 
        Click Overlaid to display the source spectra and the derivative curve in a single graph 

display, or Result to display the derivative curves without the source spectra. 
          If Link graph ranges is selected, changing the ordinate range displayed in one graph will 

also change the range of the other. 

3.    Select the spectrum you would like to display while defining the baseline from the drop-
down list. 

        If you selected more than one spectrum before selecting Interactive Baseline Correction, 
those spectra will be available in the drop-down list. Although only one spectrum is 
displayed, the same parameters will be used to correct the baselines of all the spectra. If 
you wish to use different parameters for each spectrum, you will need to process the 
spectra individually. 

4.    To select the base points to be used for the correction, move the Vertical Cursor to the first 
point you want to use. 

5.    To accept this value, double-click on the cursor or click the Add button. 
        The value is added to the Base Points table and the new baseline is added to the display. A 

marker is placed on the spectrum to indicate a base point. 

        If Find Min in Range is selected, range markers are added for each base point, and range 
Start and End columns are added to the Base Points table. The baseline point used will be 
the minimum value in the defined range. 

6.    To remove a base point, click on the row in the Base Point table you want to remove and 
then click Remove. 

        The base point is removed from the baseline. 
7.    Repeat steps 4 and 5 to identify as many base points as you require. 

        The baseline is updated in the Viewing Area, and another marker added, each time a new 
value is added. If only one point is added, a horizontal baseline is used; and if two points 
are added a linear baseline passing through the points is shown. If multiple base points are 
added, a curve intersecting the spectrum at these points is constructed using a cubic spline, 
and this curve is subtracted from the original spectrum 
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        If Restrict Range is selected, an offset equal to the absorbance at the highest frequency 
base point is subtracted from the region between the start of the spectrum and the start of 
the selected region. An offset equal to the absorbance at the lowest frequency base point is 
applied to the region between the end of the selected range and the end of the spectrum. 

8.    Select Overwrite if you want to overwrite the source spectrum with the corrected 
spectrum. 

        In Spectrum FL ES, Overwrite is not available. 

9.    When you are happy with the baseline, click OK to accept the result. 
        The Baseline Correction dialog closes. 
        If the Overwrite check box was not selected, the processed Source spectrum is added to the 

Samples View and displayed in the Viewing Area. 

        If the Overwrite check box was selected, the processed Source spectrum replaces the 
source spectrum in the Samples View and is displayed in the Viewing Area. In Spectrum ES 
the source spectra are sent to the Recycle Bin. 

        Processed spectra are not saved to disk automatically. 

Additional Information 
You may want to correct the baseline of a sample spectrum before comparing it with reference 
spectra, or measuring peak intensities. 
The Baseline Correction process attempts to correct spectra without distorting the band intensities 
or introducing discontinuities. There must be significant regions of the spectrum that can be 
regarded as baseline. The process detects baseline portions of the spectra, and then bridges the 
data across the peaks to form a smoothed approximation to the baseline which is then subtracted 
from the original spectra in absorbance. 
The calculations are performed internally in absorbance to help preserve band intensities. 

You can also correct the baseline of you spectra automatically. See Baseline Correction. 
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Difference 
Use the Difference command to perform a weighted subtraction of one spectrum from another. 

1.    Display and select the two spectra whose difference spectrum you want to calculate. 
        If either or both of the selected source spectra are displayed in Absorbance (A), then both 

the source spectra and the difference spectrum are displayed in Absorbance. If both of the 
source spectra are displayed in Transmittance (%T), the difference spectrum is displayed in 
Transmittance. 

        The calculation is always performed in Absorbance. 

2.    Select Difference from the Process menu. 

          OR 

        Click  if you have made it available on the Process bar. 

        The Difference dialog is displayed in the Viewing Area. This dialog contains interactive 
controls below a Split view; the upper graph display contains the two source spectra, and 
the lower graph contains the calculated difference spectrum. 

        Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the display of the other. 

        Click Overlaid to display the source spectra and the difference spectrum in a single graph, 
or Result to display the difference spectrum without the source spectra. 

3.    If you want to subtract other source spectra, select the spectrum needed using the drop-
down lists for Source and Spectrum to subtract. 

        You can, for example, swap the spectra being subtracted, by clicking Swap Source, or 
select any spectrum available in the Samples View. 

4.    Enter any scaling Factor you want applied to the spectrum that is being subtracted, that is, 
Spectrum to subtract. 

        This enables you to overcome, for example, the effect of differences in concentration or 
sample thickness between the two source spectra. 

          OR 

        Click Auto. 
        The scaling factor is calculated automatically by performing a least squares fit of the two 

source spectra, over the range currently displayed in the graph. 
        In Spectrum FL ES, Overwrite is not available. 

5.    Click OK to accept the result. 
        This dialog is closed. 

        If the Overwrite check box was not selected, the difference spectrum (that is, the 
processed Source spectrum) is added to the Samples View and displayed in the Viewing 
Area. 
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        If the Overwrite check box was selected, the difference spectrum replaces the source 
spectrum in the Samples View and is displayed in the Viewing Area. In Spectrum FL ES the 
source spectra are sent to the Recycle Bin. 

        Processed spectra are not saved to disk automatically. 

Additional Information 
Typically, you calculate the difference between two spectra to remove the contribution of some 
components and see what remains. For example, you can: 

•       find the spectrum of a solute by subtracting the solvent spectrum from the solution 
spectrum 

•       find the spectrum of an unknown component of a mixture by subtracting the spectra of the 
known components 

•       subtract the background spectrum of a sampling accessory. 

The Difference calculation is performed in absorbance because it is absorbance that varies linearly 
with concentration or path length. If the source spectra contain regions where the absorbance is 
very high, the noise level in these regions of the difference spectrum will be high. 
Difference spectra are very sensitive to small changes in the shapes and positions of bands. Use 
identical instrument conditions to collect the two source spectra to be subtracted. 
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Normalization 
Use the Normalization process command to set a common peak in one or more spectra to the 
same ordinate limit, which enables you to compare other peaks in these spectra. 

1.    Display and select the spectrum or spectra that you want to normalize. 

2.    Select Normalization from the Process menu. 
          OR 

        Click  on the Process bar. 

        The Normalization dialog is displayed in the Viewing Area. This dialog contains interactive 
controls below a Split view; the upper graph display contains the selected source spectra, 
and the lower graph display contains the converted spectra. 

        Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

        Click Overlaid to display the source spectra and the normalized spectra in a single graph 
display, or Result to display the normalized spectra without the source spectra. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the display of the other. 

3.    In Normalize ordinate to, enter the value, or height, that the common peak should be 
normalized to. 

4.    Select the Abscissa Position where the common peak can be found in your source 
spectra. 

        By default, the Maximum ordinate value in the spectrum of your spectra is selected. 
        If you want to normalize your source spectra to a particular peak, click Maximum 

ordinate value over defined range, and then enter (or drag the vertical cursor in the 
source graph to) a Start value to the left, and an End value to the right, of the common 
peak. 

          OR 
        If you want to normalize your source spectra to an intensity at a particular wavelength, click 

Defined position, and then enter (or drag the vertical cursor in the source graph to) the 
appropriate value. 

5.    Select the Zero Point for the baseline of your normalized spectra. 
        By default, the Minimum ordinate value found in your source spectra is set to zero in the 

normalized spectra. 
        If you don't want a baseline correction applied, click none. 

          OR 
        If you want to zero your normalized spectra to the abscissa value at a particular 

wavelength, click Selected abscissa point, and then enter (or drag the vertical cursor in 
the source graph to) the appropriate value. 

6.    Select Overwrite if you want to overwrite the source spectrum with the corrected 
spectrum. 

        In Spectrum FL ES, Overwrite is not available. 
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7.    Click OK to accept the result. 
        This dialog is closed. 
        If the Overwrite check box was not selected, the normalized spectra are added to the 

Samples View and displayed in the Viewing pane. 

        If the Overwrite check box was selected, the normalized spectra replace the selected 
spectra in the Samples View and are displayed in the Viewing Area.  In Spectrum FL ES the 
source spectra are sent to the Recycle Bin. 

          Processed spectra are not saved to disk automatically. 

Additional Information 
The Normalization process multiplies the ordinate value of each data point in a spectrum by a 
factor that scales a particular peak to a set limit. This enables you to compare the spectrum with 
spectra that include the same peak scaled to the same limit. All %T calculations are performed 
internally in Absorbance, to minimize any effect on the shape of the peaks. 
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Interpolation 
Use the Interpolation process command to change the number of data points in one or more 
spectra and, if necessary, their range. 

1.    Display and select the spectrum or spectra that you want to interpolate. 

2.    Select Interpolation from the Process menu. 
          OR 

        Click  if you have made it available on the Process bar. 

        The Interpolation dialog is displayed in the Viewing Area. This dialog contains interactive 
controls below a Split view; the upper graph display contains the selected source spectra, 
and the lower graph display contains the converted spectra. 

        Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

        Click Overlaid to display the source spectra and the interpolated spectra in a single graph 
display, or Result to display the interpolated spectra without the source spectra. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the range of the other. 

3.    If you want to use part of the Full range of your selected source spectra, click Selected 
range, and then enter (or drag the vertical cursor in the source graph to) the Start and 
End values for your range of interest. 

4.    If necessary, enter an appropriate new Data point interval. 
        The default data interval maintains the number of points in the source spectra. 
5.    Select Overwrite if you want to overwrite the source spectrum with the corrected 

spectrum. 

        In Spectrum FL ES, Overwrite is not available. 

6.    Click OK to accept the result. 
        This dialog is closed. 
        If the Overwrite check box was not selected, the interpolated spectra are added to the 

Samples View and displayed in the Viewing pane. 

        If the Overwrite check box was selected, the interpolated spectra replace the selected 
spectra in the Samples View and are displayed in the Viewing Area. In Spectrum FL ES the 
source spectra are sent to the Recycle Bin. 

        Processed spectra are not saved to disk automatically. 

Additional Information 
Use the Interpolation process command to: 

•       Save part of a spectrum 

•       Reduce the number of data points. 

        The number of data points in a spectrum is included in the Sample section its History tab. 
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The Interpolation process adds data points to a spectrum by adding new points between the points 
that already exist, and removes data points from a spectrum by selecting every nth point in a 
spectrum and deleting it. 
The number of data points needed in a spectrum depends on the width of the features in the 
spectrum. If the separation of the data points is smaller than is needed to define the features in 
the spectrum, the number of points can be reduced without reducing the amount of information in 
the spectrum. 
Increasing the number of data points in a spectrum cannot increase the amount of information in 
the spectrum. 
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Convert X 
Use the ConvertX process command to convert the abscissa units of your spectra to and from 
wavenumbers, microns, or nanometers. 

1.    Display and select the spectrum or spectra that you want to convert. 

2.    Select ConvertX from the Process menu. 
          OR 

        Click  if you have made it available on the Process bar. 

        The ConvertX dialog is displayed in the Viewing Area. This dialog contains interactive 
controls below a Split view; the upper graph display contains the selected source spectra, 
and the lower graph display contains the converted spectra. 

       Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

       Click Overlaid to display the source spectra and the converted spectra in a single graph 
display, or Result to display the converted spectra without the source spectra. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the display of the other. 

3.    Select the New abscissa unit that you want to convert to. 

4.    If necessary, enter an appropriate Data point interval. 
        The current data interval is selected by default. This maintains the number of points in the 

source spectra. 
5.    If you want the converted spectra to replace your source spectra, select the Overwrite 

check box. 
        In Spectrum FL ES, Overwrite is not available. 

6.    Click OK to accept the result. 

        This dialog is closed. 
        If the Overwrite check box was not selected, the converted spectra are added to the 

Samples View and displayed in the Viewing Area. 
        If the Overwrite check box was selected, the converted spectra replace the selected spectra 

in the Samples View and are displayed in the Viewing Area. In Spectrum FL ES the source 
spectra are sent to the Recycle Bin. 

        Processed spectra are not saved to disk automatically. 
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Smooth 
Use the Smooth process command to reduce the noise level in one or more spectra. 

CAUTION: Use the Smooth process with discretion. It can remove important data and 
generate misleading results by reducing the number of data points in the spectrum. 
Spectra that have plateau regions adjacent to sharp peaks (typical for gas samples, 
and some NIR and Raman spectra) are especially vulnerable to excessive 
smoothing. 

1.    Display and select the spectrum or spectra that you want to smooth. 

2.    Select Smooth from the Process menu, or click  on the Process bar. 

3.    Select the Smooth Factor you wish to apply. 
4.    If you want the smoothed spectra to replace your source spectra, select the Overwrite 

check box. 
        In Spectrum ES, Overwrite is not available. 

5.    Click OK. 

        This dialog is closed. 
        If the Overwrite check box was not selected, the smoothed spectra are added to the 

Samples View and displayed in the Viewing Area. 
        If the Overwrite check box was selected, the smoothed spectra replace the selected spectra 

in the Samples View and are displayed in the Viewing Area. 

Additional Information 
Smoothing is a form of filtering that reduces noise, but also degrades the resolution of your 
spectrum so that the features in the spectrum become broader. If you use too great a level of 
smoothing, bands are broadened excessively and resolution is lost. 
Smoothing should not change band areas or the position of symmetrical bands. 
The Smooth process used is an adaptive procedure that estimates the signal-to-noise ratio of the 
data within a window and then applies an appropriate degree of smoothing. Areas with a high 
signal-to-noise ratio have no smoothing applied to them, and noisy areas are heavily smoothed. 
The window size is appropriate for 4 cm-1 resolution data, which means that the smooth algorithm 
is unsuitable for spectra with very sharp peaks. 
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Derivative 
Use the Derivative process command to generate a first, second, third or fourth order derivative 
curve from your selected spectrum. 

1.    Display and select the spectrum, or spectra, that you want to process. 

2.    Select Derivative from the Process menu. 
          OR 

        Click if you have it available on the Process bar.  

        The derivable dialog is displayed in the Viewing Area. This dialog contains interactive 
controls below a Split view; the upper graph display contains the selected source spectra, 
and the lower graph contains the calculated derivative curves. 

        Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

        Click Overlaid to display the source spectra and the derivative curve in a single graph 
display, or Result to display the derivative curves without the source spectra. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the range of the other. 

3.    Select the Order of the derivative, and the Number of Points to provide the required 
degree of smoothing. 

4.    If you want the calculated derivative curves to replace your source spectra, select the 
Overwrite check box. 

        In Spectrum FL ES, Overwrite is not available. 

5.    Click OK to accept the result. 
        This dialog is closed. 

        If the Overwrite check box was not selected, the derivative curves are added to the Samples 
View and are displayed in the Viewing Area. 

        If the Overwrite check box was selected, the derivative curves replace the selected spectra 
in the Samples View and are displayed in the Viewing Area. In Spectrum FL ES the source 
spectra are sent to the Recycle Bin. 

        Processed spectra are not saved to disk automatically. 

Additional Information 
Derivative curves usually have sharper features than the original spectra, which can enable you to 
reduce the effects of overlapping bands and to suppress background effects. You can use 
derivative curves in quantitative methods to eliminate some baseline effects. For example, the 
amplitudes of features in derivative curves can be used in the same way as peak absorbances. 

Order 
The first derivative removes any baseline offset and linear slope. 
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The second derivative removes any parabolic baseline effects. These curves have sharp minima 
where there are maxima in the original spectrum, which can enable you to identify band positions 
in complex regions. 
The third derivative removes any cubic baseline effects, and the fourth derivative any fourth order 
baseline effects. Both third and fourth order derivative curves can be difficult to interpret, and are 
only useful when the original spectra had a high signal-to-noise ratio. 

Smoothing by varying the number of data points used for the slope calculation 
Derivative curves emphasize narrow features, including noise, relative to broad ones. You can 
control this to some extent by varying the width (that is, the Number of Points used to calculate 
the slope) of the derivative function, which is equivalent to applying some smoothing to the 
derivative curve. 
The Derivative process uses the Savitzky-Golay procedure to estimate the derivative of a smooth 
curve, constructed through the original data points of your original spectrum. It uses a number of 
neighboring data points to estimate the curve. As the number of data points used in the calculation 
is increased, the contribution of broader features increases relative to narrow features. 

Raman data 
Derivative is particularly useful to correct for spikes in your Raman data, for example, due to 
cosmic rays. It is also useful for removing baseline slope due to fluorescence. 
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Arithmetic 
Use the Arithmetic process command to apply one or more of the following operations to your spectra: 

+ addition requires an operand 
- subtraction requires an operand 
x multiplication requires an operand 
/ division requires an operand 
log log base 10   
ln log base e   
sqr square   
sqrt square root   

For example, you could multiply the ordinate values in a spectrum by a constant (such as 2), or 
divide one spectrum by another spectrum. 

1.    Display and select the spectrum that you want to process. 
2.    Select Arithmetic from the Process menu. 

          OR 

        Click  if you have made it available on the Process bar. 
        The arithmetic dialog is displayed in the Viewing Area. This dialog contains interactive 

controls below a Split view; the upper graph display contains the selected source spectrum, 
and the lower graph display will contain the processed spectrum. 

        Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

        Click Overlaid to display the source spectra and the interpolated spectra in a single graph 
display, or Result to display the processed spectrum without the source spectra. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the range of the other. 

3.    Select the Operator you require from the drop-down list. 
4.    Enter the value of the Constant to apply to your spectrum. 

        For example, Current Sample x 2 multiplies the ordinate values in your spectrum by 2. 
          OR (and provided you selected the +, -, x or / operator) 

        Deselect the Constant button, and then select another spectrum from the Operand drop-
down list; the browse option enables you to select any *.sp file available to your PC. 

        The operation is performed and the Arithmetic Result graph display is updated. 

NOTE: If you select log, ln, sqr, or sqrt the Operand field is not available because no 
other spectrum is required to complete these operations. 

OR 
If the sample table contains a File Path custom column, click the Column button and select 
the name of the custom column from the drop-down list. 
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The operation is performed on the sample using the spectrum file in the custom column of 
the sample table. 

5.    Select Overwrite if you want to overwrite the source spectrum with the corrected 
spectrum. 

        In Spectrum FL ES, Overwrite is not available. 

6.    Click OK to accept the result.  
        This dialog is closed. 
        If the Overwrite check box was not selected, the processed spectra are added to the 

Samples View and displayed in the Viewing Area. 
        If the Overwrite check box was selected, the processed spectra replace the selected spectra 

in the Samples View and are displayed in the Viewing Area.  

        In Spectrum FL ES, Overwrite is not available. 

        Processed spectra are not saved to disk automatically. 

Additional Information 
Negative values in the logarithmic and square root operations 
For logarithmic and square root operations, negative input values are set to zero. 
Adding Spectra 
If you add two spectra with the same units and the same range but with different data intervals, 
the resulting spectrum is constructed using the smaller data interval. 
If you add two spectra with the same units and data intervals but with different ranges, the 
resulting spectrum is the sum of the overlapping regions only. 
Subtracting Spectra 
If you subtract two spectra with the same units and range but different data intervals, the resulting 
spectrum is constructed using the smaller data interval. 
If you subtract two spectra with the same units and data intervals but different ranges, the 
resulting spectrum is the difference of the overlapping regions only. 
Multiplying Spectra 
If you multiply two spectra with the same units, data interval and range, the resulting spectrum is 
the product of the two spectra. 
If you multiply two spectra with the same units and ranges but different data intervals, the 
resulting spectrum is constructed using the smaller data interval. 
If you multiply two spectra with the same units and data intervals but different ranges, the 
resulting spectrum is the product of the overlapping regions only. 
Dividing Spectra 
If you divide two spectra with the same units, data interval and range, the resulting spectrum is 
the ratio of the two spectra. 
If you divide two spectra with the same units and ranges but different data intervals, the resulting 
spectrum is the ratio constructed from the smaller data interval. 
If you divide two spectra with the units and data intervals but different ranges, the resulting 
spectrum is the ratio of the overlapping regions only. 
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Deconvolution 
Deconvolution applies a line-narrowing process so that interference between unresolved features is 
reduced. This means that you can see peaks that are present more easily. Deconvolution is used in 
estimating the positions and intensities of overlapping absorption bands. 

1.    Display and select the spectrum or spectra that you want to deconvolute. 
2.    Select Deconvolution from the Process menu. 

          OR 

          Click  on the Process bar. 

        The Deconvolution dialog is displayed in the Viewing Area. This dialog contains interactive 
controls below a Split view; the upper graph display contains the selected source spectra, 
and the lower graph display contains the converted spectra. 

        Change the relative sizes of the two graph displays in the Split view by dragging the bar 
between them. The mouse pointer changes to a two-headed arrow when it is positioned 
over the bar. 

        Click Overlaid to display the source spectra and the normalized spectra in a single graph 
display, or Result to display the normalized spectra without the source spectra. 

        If Link graph ranges is selected, changing the ordinate range displayed in one graph will 
also change the range of the other. 

3.    Enter the Gamma value, which defines the line-narrowing and can take values between 0 
and 100; larger values give more narrowing. 

        The reduction in linewidth for an ideal Lorentzian line is given by: 4 * Gamma * data 
interval. For spectra with a data interval of 1, typical gamma values are less than 3. 

4.    Select the smoothing Length. 
        Length defines the smoothing that is applied to limit the noise generated by line-narrowing. 

It can take values between 0 and 95, with 95 corresponding to maximum smoothing. For 
spectra of different data intervals, equivalent smoothing is achieved for equal values of (100 
length) x data interval. 

5.    Select the appropriate radio button for either Bessel or Boxcar smoothing. 
        You should choose Bessel for real data. 

6.    Select Overwrite if you want to overwrite the source spectrum with the corrected 
spectrum. 

         In Spectrum FL ES, Overwrite is not available. 

7.    Click OK to accept the result. 
        This dialog is closed. 
        If the Overwrite check box was not selected, the processed Source spectrum is added to the 

Samples View and displayed in the Viewing Area. 

        If the Overwrite check box was selected, the processed Source spectrum replaces the 
source spectrum in the Samples View and is displayed in the Viewing Area. In Spectrum FL 
ES the source spectra are sent to the Recycle Bin. 

        Processed spectra are not saved to disk automatically. 
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Additional Information 
Deconvolution applies a line-narrowing process so that interference between unresolved features is 
reduced. This has traditionally been done by taking derivatives of the spectrum. For example the 
second derivative of a band has a narrow minimum at the frequency corresponding to the 
maximum of the original band. The disadvantage of derivative spectra is that secondary maxima 
and minima are generated along with the central features. Deconvolution achieves line-narrowing 
with minimal subsidiary features. 

Deconvolution uses a method called Fourier self-deconvolution which operates on the Fourier 
transform of the spectrum. It can be thought of as involving two steps. A line narrowing filter 
removes broadening corresponding to a Lorentzian line shape. This filter is characterized by 
Gamma. Increasing the magnitude of Gamma produces narrower lines, but eventually leads to 
subsidiary features (sidelobes) around the narrowest bands. It also increases the noise. To reduce 
these undesired effects a smoothing function is applied. The degree of smoothing is controlled by a 
parameter called length. Increasing the length leads to a greater degree of smoothing. This 
reduces noise and sidelobes, but at the expense of some line broadening. 
Deconvolution is an interactive routine to find the most appropriate combination of these 
parameters. It has to be used with caution since sidelobes from large bands can be confused with 
small overlapping bands. 
Deconvolution works best with noise-free data where all the bands are Lorentzian and have the 
same width. Even with ideal data the line width cannot be reduced below the resolution at which 
the spectrum was collected. With real data, the degree of narrowing that can be achieved is limited 
either by noise or by the subsidiary features associated with the sharpest bands. 
There is no correct result for real data. For example, small negative sidelobes may be perfectly 
acceptable when trying to identify band positions. 
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Polarization 
Fluorescence polarization is used to study the rotational movement of small molecules in solution 
or suspension. For example the technique is used to measure the binding of coenzymes to 
proteins, in the study of antigen-antibody reactions, in determining low molecular weight haptens, 
and to measure cell membrane fluidity.  
Select this option to calculate the polarization of a sample. Your instrument must have an 
excitation and an emission fast filter wheel fitted, and the positions of the horizontal and vertical 
polarizer for the excitation and the emission fast filter wheel must have been defined in the Status 
application. 

1. Display and select the spectrum or spectra that you want to measure. 
2. Select Polarization from the Process menu. 

OR 

Click  on the Process bar. 
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Anisotropy 
Select this option to calculate the anisotropy of a sample. Your instrument must have an excitation 
and an emission fast filter wheel fitted, and the positions of the horizontal and vertical polarizer for 
the excitation and the emission fast filter wheel must have been defined in the Status application. 

1. Display and select the spectrum or spectra that you want to measure. 

2. Select Anisotropy from the Process menu. 
OR 

Click  on the Process bar. 
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Peak Table 
Peak Table is a process command that automatically produces a table of the peaks in your 
spectrum or spectra. The parameters used to generate the Peak Table are defined on the Setup 
Peak Detection tab. 

1.    Display and select the spectrum or spectra that you want to process. 
2.    Select Peak Table from the Process menu. 

          OR 

          Click  if you have made it available on the Process bar. 

The results are displayed on the Peak Table tab in the Viewing Area. 
•       The upper left quadrant of the Peak Table tab lists each spectrum. 

          You can select which columns to display in the table using the column selector in its top left 
corner. 

          To view this table in detail, it may be helpful to drag the borders between the quadrants. 
•       The List of Peaks for each spectrum is tabulated in the upper right quadrant of the Peak 

Table tab. 
          You can select which columns to display in the table using the column selector in its top left 

corner. 

          To view this table in detail, it may be helpful to drag the borders between the quadrants. 

•       Your source spectrum or spectra are displayed in a graph below the results tables with the 
peak X and Y positions labeled. 

•       Use the shortcut menu to Copy the Peak Table to the clipboard, or use the Send To 
command to copy the contents of the Viewing Area into a Word or WordPad document. 

The results are also displayed on the Results Table tab. 

Additional Information 
The results of the Peak Area/Height process are also added to the Peak Table tab. Each time you 
run a Peak Table or Peak Area/Height process on a spectrum, a new row is appended to the 
results. 
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Peak Area/ Height 
Peak Area/Height is a process command that enables you to produce a table of the areas and 
heights of the peaks in your spectrum or spectra. You can auto-generate a peak table, or add 
peaks individually. You can use it to measure: 

•       Peak areas relative to a linear baseline, between two baseline points, or between two other 
points on the spectrum. 

•       Peak heights from a peak maximum to a baseline. 

•       The maximum height in a selected region. 

•       The ratio of two peaks. 

You can run the Peak Area/Height process on multiple spectra. However, note that the same 
parameters will be used to produce the results for all the spectra selected. If you wish to use 
different parameters for each spectrum, you should process the spectra individually. 

1.    Display and select the spectrum or spectra that you want to process. 
2.    Select Peak Area/Height from the Process menu. 

          OR 

          Click  if you have made it available on the Process bar. 

          The Peak Area/Height dialog is displayed in the Viewing Area. 
3.    Select the spectrum you would like to display while defining the peaks from the drop-down 

list. 
        If you selected more than one spectrum before selecting Peak Area/Height, those spectra 

will be available in the drop-down list. Although only one spectrum is displayed, the same 
parameters will be used to generate the results for all the spectra. If you wish to use 
different parameters for each spectrum, you will need to process the spectra individually. 

4.    Select to display the Area or Height graph marker. 
5.    In the Calculation section, choose whether to calculate Area, Height or Max Height. 

        Areas and heights are calculated in the same units as the spectrum. If you want to use units 
different from the current units of the spectrum, you must convert the spectrum to the 
correct units first. 

6.    Select the number of Bases. 
        Select Base 1, Base 2. If one or more bases are selected, then Min Bases becomes 

available. 
        If no bases are selected, the zero absorbance is used as the baseline. If Base 1 is selected, 

a horizontal baseline is drawn at that ordinate value. If Base 1 and Base 2 are selected, the 
baseline is drawn between the two points. 

        Min Bases adds range markers for each base point. The base point used is the minimum 
value between the markers. 

7.    Click Add to add a peak (defined at the current Vertical Cursor position) to the table. 
          OR 

        Double click on the Vertical Cursor to add a peak to the table. 
          OR 

          Click Auto to automatically find the peaks and populate the table. 
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8.    Use the graph markers to adjust the position of the baseline markers, the range over which 
the peak area or maximum height will be calculated, or the point on the curve at which the 
height will be determined, as required. 

9.    Select the results you want to be displayed in the Results Table. 
        The options are the X and/or Y coordinates, Height and Area. The results added to the 

Results Table will be available as variables in Equations. 

10.  Click OK to exit the Peak Area/Height dialog. 
        The Peak Table tab and Results Table tab are updated. 

Area 
An area is defined by a start and end abscissa value and two base points. 

 

Height 
Height is defined by an abscissa value (X in the table) and two base points. If no bases are 
selected, the Height is measured from the curve to zero absorbance. If one or two bases are 
selected, the max height is measured from the curve to the baseline. 
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Max Height 
Max height is defined by a start and end abscissa value and two base points. The Max 
Height is the maximum peak height between the start and end abscissa values. If no bases 
are selected, the max height is measured from the curve to zero absorbance. If one or two 
bases are selected, the max height is measured from the curve to the baseline. 

 

Defining a Ratio 
The Ratio option is only available when two rows are selected in the table. 

1.    Click in the left-hand column of the peak row that you wish to be the numerator. 
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        The row is highlighted. 
2.    Hold down the CTRL button on your keyboard, and then select the left-hand column of the 

peak row that you wish to be the denominator. 

        Both rows are highlighted. 

3.    Click Ratio. 
        A new row is added to the table, and automatically named [Peak Name Row 1]/[Peak Name 

Row 2]. 

NOTE: If you modify the parameters of either peak row, then the ratio values are automatically 
updated. 

Removing a Row  from the Table 
➤     Select the row or rows in the table containing the peak positions that you want to remove, 

and then click Remove. 

Peak Area/ Height Results 
The results are displayed on the Peak Table tab in the Viewing Area. 

•       The upper left quadrant of the Peak Table tab lists each spectrum. 

          You can select which columns to display in the table using the column selector in its top left 
corner. 

          To view this table in detail, it may be helpful to drag the borders between the quadrants. 
•       The List of Peaks for each spectrum are tabulated in the upper right quadrant of the Peak 

Table tab. 
          You can select which columns to display in the table using the column selector in its top left 

corner. 

          To view this table in detail, it may be helpful to drag the borders between the quadrants. 

•       Your source spectrum or spectra are displayed in a graph below the results tables with the 
peak X and Y positions labeled, and the peak areas shaded and heights marked. 

•       Use the shortcut menu to Copy the Peak Table to the clipboard, or use the Send To 
command to copy the contents of the Viewing Area into a Word or WordPad document. 

The results are also displayed on the Results Table tab. 

Additional Information 
The results of the Peak Table process are also added to the Peak Table tab. Each time you run a 
Peak Table or Peak Area/Height process on a spectrum, a new row is appended to the results for 
that Samples View. 
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Equations 
Equations are process commands that perform calculations on one or more spectra, or on the data 
obtained from other processes. An equation must be defined before it can be used. 

To apply an equation that you have previously defined: 
1. Display and select the spectrum or result that you want to process. 
2. Select Equations from the Process menu, and then click on the name of the equation that 

you want to apply.  

OR 

Select the  icon labeled with the name of the equation that you want to apply from 
the Equations drop-down list on the Process bar. 
By default, an Equation icon and label is added to the Equations drop-down list on the 
Process bar each time a new equation is defined. 
The Results Table tab is updated. If the result amends the source spectrum, the processed 
spectrum is displayed in the Viewing Area and added to the Samples View. 

Processed spectra are not saved to disk automatically. 

Additional Information 
Defining Equations 
For further information about adding a new equation, see Setup Equations. 
For further information about modifying an equation, see Setting up an Equation. 
For further information about formatting the numeric results obtained by applying an equation, see 
Formatting Equation Results. 



 

 

View ing Spectra 
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View ing Spectra 
These topics describe how to format your results so that they are presented as clearly as possible: 

Optimizing the Viewing Area 

Optimizing Graphs 
Autorange X, Y, XY 

Previous Range 
Formatting a Graph 

Graph Labels 
Labeling Graphs using the Vertical Cursor 

Label Peaks 

Horizontal Cursor 
Autoscale Y 

Optimize 
Panning, Zooming and Offsetting Spectra 

NOTE: Your formatting is not stored when you save your curve as a *.sp file, or preserved if 
you select Save for reload next time when you Exit Spectrum FL. 

Additional Information 
You can print or publish your formatted results. See Publishing Results. 
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The Data Explorer 
In the Data Anaylsis mode use the Data Explorer together with the Viewing Area to organize your 
sample data in the Spectrum FL workspace. 

•       The Data Explorer pane is on the left of the Spectrum FL workspace. 

          It contains Samples Views and links that help you organize the spectra that you open, 
collect, process, or publish. 

NOTE: Samples Views are virtual folders that are a useful way to organize your spectra 
in the Spectrum FL Workspace. They have no explicit relationship with where, or 
whether, spectra are saved. 

•       If you have Spectrum FL ES, the Data Explorer will also contain a Recycle Bin. Any spectra 
that are deleted from a Samples View will be stored in the Recycle Bin. 

•       When you are connected to an instrument, the Data Explorer also enables you to open the 
Sample Table, which you use to set up data collection from a batch of samples. 

•       The Viewing Area is in the center of the Spectrum FL workspace. 
          The contents of the Viewing Area, arranged on one or more tabs, reflect the Samples View 

or spectrum selected in the Viewing Area. 
This organization is preserved when you Exit Spectrum FL provided that you choose to Save for 
reload next time. 

Working w ith Samples Views 
Creating a New Samples View  

➤     Select New from the File menu. 

Adding a Saved Spectrum FL in a Samples View  
1.    Select the Samples View, right-click, and then select Open spectrum. 

          The Open File dialog is displayed. 
2.    Browse to, and select, the spectrum you want, and then click Open. 

Renaming a Samples View  
1.    Select the Samples View, right-click, and then select Rename. 
          The Rename Samples View dialog is displayed. 

2.    Enter a valid name, and then click OK. 
          If the name is not valid, an advisory message is displayed in the dialog. 

Deleting a Samples View  
➤     Select the Samples View, right-click, and then select Delete. 
          The Samples View, and any links it contains, are deleted from the Data Explorer. Any saved 

spectra are not deleted from disk. 

NOTE: 
If you have Spectrum FL ES, you may be prompted to enter an electronic 
signature for the Delete Graph signature point. The contents of the Samples 
View will be stored in the Recycle Bin. 
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Working w ith Sample Links 
Creating New  Links 
New links are added automatically as you collect, open and process spectra. The contents of a 
Samples View reflect the work you have done on this sample. 

Copying a Link into a New Samples View  
➤     Select the link, right-click, and then select Copy to New Folder. 

Renaming a Sample 
1.    Select the link, right-click, and then select Rename. 
          The Rename Sample dialog is displayed. 

2.    Enter a valid name, and then click OK. 
          If the name is not valid, an advisory message is displayed in the dialog. 

Deleting a Link 
➤     Select the link, right-click, and then select Delete. 
          The link is deleted from the Data Explorer. If saved, the spectrum is not deleted from disk. 

NOTE: If you have Spectrum FL ES, you may be prompted to enter an electronic 
signature for the Delete Graph signature point. The contents of the Samples 
View will be stored in the Recycle Bin. 

Copying a Link from one Samples View  into Another 
➤     Select the link, and drag it to the Samples View you want to copy to. 
          If a link of the same name already exists in the Samples View, a suffix is added to the new 

link name. 

Working w ith the Recycle Bin (Spectrum FL ES only) 
Restoring a Sample 

➤     Right-click on the sample link in the Recycle Bin and then select Restore. 
          The sample link is restored in the Samples View. If the Samples View had been deleted 

previously, it is recreated and the samples link added. 

Restoring Samples Views 
➤     Right-click on the Recycle Bin in the Data Explorer pane and then select Restore All. 
          Any Samples Views in the Recycle Bin will be recreated in the Data Explorer, together with 

any spectra they contained. 

NOTE: If you have Spectrum ES, the contents of the Samples View will be added to the 
Recycle Bin. 

Additional Information 
Opening and Closing Panes 
 To open or close the Data Explorer, click the long button at the center of the left edge of the 

Viewing Area. 



Viewing Spectra . 115 

 

 

OR 

Select Data Explorer from the View menu. 
 To open or close the Navigation pane, click the long button at the center of the right edge of 

the Viewing Area. 

OR 
Select Navigation Pane from the View menu. 

 To open or close the Dialog pane, click the long button at the center of the bottom of the 
Viewing Area. 

OR 
Select Dialog Pane from the View menu. 

 To open or close the Data Explorer, Navigation and Dialog panes simultaneously, hold down 
the SHIFT key and click the button that opens or closes any of these panes. 

Resizing Panes 
 Open the pane, and then drag the edge of the pane containing the button (not the button 

itself) to the width or height required. 
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Optimizing the View ing Area 
When you are working in the Viewing Area, right click in a clear area to display a shortcut menu 
containing a selection of useful commands: 

• Previous Range 

• Full Scale 

• Vertical Cursor 

• Horizontal Cursor 

• Split Display 

• Set Anchor Point 

• Add Text 

• Add Range Marker 

• Add Bitmap Image 

• Print 

• Copy to Clipboard 

• Properties 

Additional Information 
If you right click on a particular curve, a shortcut menu containing a different selection of useful 
commands is displayed. 
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Optimizing Graphs 
When you are working in the Viewing Area, right click on a curve to display a shortcut menu 
containing a selection of useful commands: 

Set Anchor Point     
Select Only This Curve     
Label This Point     
Label Peaks     
Process > Absorbance 

    %Transmittance 

    Data Tune-up 

    Baseline Correction 

    Interactive Baseline Correction 

    Difference 

    Normalization 

    Interpolation 

    ConvertX 

    Smooth 

    Derivative 

    Arithmetic 

    Deconvolution 

    Polarization 
    Anisotropy 
    Peak Table 

    Peak Area / Height 

Equations > Equation n 

Save As Binary     
Save As ASC     
Remove Curve     
Status     
Appearance     

 NOTE: If you are using the Viewing Area to display a particular curve, rather than a Samples 
View, the shortcut menu does not include Process commands. 

Additional Information 
If you right click away from a curve, rather than on a curve, a shortcut menu containing a different 
selection of useful commands is displayed. 
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Autorange 
Use the Autorange X, Autorange Y, and Full Range commands to rescale the axes so that your 
selected spectra fill the graph, making their features easier to see. 

Autorange X 
1.    Select the spectra that you want to be fitted on to the graph. 

2.    Select Autorange X from the View menu, or click Auto X on the Graph toolbar (hidden by 
default). 

          The Y range stays the same, but the X range is set to the Start and End data points of the 
selected spectra. 

Autorange Y 
1.    Select the spectra that you want to be fitted on to the graph. 
2.    Select Autorange Y from the View menu, or click Auto Y on the Graph toolbar (hidden by 

default). 
          The X range stays the same, but the Y range is set to the minimum and maximum of the 

selected spectra. 

Full Range 
1.    Select the spectra that you want to be fitted on to the graph. 
2.    Select Full Range from the View menu, or click Auto XY on the Graph toolbar (hidden by 

default). 
          The X range is set to the Start and End data points, and the Y range is set to the minimum 

and maximum, of the selected spectra. 

Additional Information 
• Use the Previous Range command to undo the Autorange X command or Autorange Y 

command. Use the Previous Range command twice to undo the Autorange XY command; 
once to undo the Y component and once again to undo the X component. 

• Use the Autoscale Y command to rescale every feature in your spectrum. 

• Use the Optimize command to rescale every feature in your spectrum, excluding any noise 
spikes or unwanted peaks from atmospheric CO2 or water vapor. 

• Use Cancel Offset command to fit any offset spectra onto the graph. 
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Previous Range 
Use the Previous Range command to undo a command that changes the X or Y range displayed by 
the graph. The range may have been changed by zooming using a grow box, or by using the 
Autorange X, Autorange Y or Full Range (Auto XY) commands. 

➤     Select Previous Range from the View menu. 

          OR 
          Right-click in a clear area of your graph and then select Previous Range. 

          The graph is redisplayed. 
If you have applied a series of commands that affect the ranges displayed, you can use the 
Previous Range command to undo them one by one. 

NOTE: To undo the Full Range (Auto XY) command, use the Previous Range command twice; 
once to undo the X component and once again to undo the Y component. 
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Formatting a Graph 
Use the Graph Properties dialog to customize the graph display, or to change how the curves are 
displayed. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

 Select Format graph from the View menu, or right-click on the graph and select Properties 
from the pop-up box. 

    The Graph Properties dialog opens at the Axes tab. 
The Graph Properties dialog has four tabs: 

•       Use the General tab to apply a title and description to your graph. 

•       Use the Axes tab to change the range and units applied to the X and Y axes. 

•       Use the Appearance tab to enable gridlines; and to apply color to text, to line elements, and 
to the curves. 

•       Use the Advanced tab to change whether, and how, data points are displayed; whether 
units or numbers are suppressed on the graph axes; the information associated with the 
curve tooltip; and the interpolation, size (width), and style applied to the curves. 

Additional Information 
When you are customizing a graph display, perhaps prior to copying it to the clipboard or sending 
it to a WordPad or Word document, you may prefer to use shortcut menus. For example: 

 To amend the X or Y axes, place the mouse pointer in a clear area of the graph, right-click 
and then select Properties. 

The Graph Properties dialog opens at the Axes tab. 
 To change the color of a selected curve, right-click on the curve and then select 

Appearance. 

The Graph Properties dialog opens at the Appearance tab. 
The Graph properties dialog enables you to customize the display of the graph currently displayed. 
To set up the default settings for all new graphs, see the Setup View topics. 

Graph Title and Description 
Use the General tab in the Graph Properties dialog to apply or edit the title or the description of a 
curve or graph display. 

NOTE: The properties of a graph display are separate to the properties from any curve it 
contains. 

1.    Select Format graph from the View menu, or click Format in the Graph toolbar. 
          OR 

          Right-click in the graph display and select Properties (of the graph display) or 
Appearance (of a curve). 

2.    Select the General tab. 
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3.    Enter your Title and/or Description. 
        The Title is displayed at the top center of the graph, using the font size and color specified 

on the Appearance tab. 

4.    To confirm changes without closing the dialog, click Apply. 

          OR 
          To close the dialog keeping only applied changes, click Cancel. 

          OR 
          To confirm all changes and close the dialog, click OK. 

Range and Units for the X and Y Axes 
Use the Axes tab in the Graph Properties dialog to change the range and units applied to the X and 
Y axes of a graph or Samples View. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

1.    Select Format graph from the View menu, or click Format in the Graph toolbar (hidden 
by default). 

          OR 
          Right-click in the graph display and select Properties (of the graph) or Appearance (of a 

curve). 

2.    If it was not selected by default, select the Axes tab. 

          The options available are: 

Properties of Select whether your changes on this tab apply to All Curves or only to 
a selected curve. 

Display Mode  
  

Select whether the graph display mode should be Overlay (where the 
curves are displayed on a common set of axes) or Split (where the 
curves are displayed on a common X, but separate Y, axes).  
If a curve is selected in the Data Explorer pane, this field is not 
applicable as only one curve is shown. 

Y Axis By default the Y axis is autoranged to the largest value and the 
smallest value in all the curves present.  
This panel allows you to enter a range of your choice. If you select 
another unit make sure that you select appropriate range values. 

X Axis By default the X axis is autoranged to the largest value and the 
smallest value in all the curves present.  
This panel allows you to enter a range of your choice, enhance the 
fingerprint region using the scale-change at 2000 cm-1 convention, if 
appropriate, and to label the X axis units. 

3.    To confirm changes without closing the dialog, click Apply. 
          OR 
          To close the dialog keeping only applied changes, click Cancel. 
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          OR 
          To confirm all changes and close the dialog, click OK. 

Colors for Curves, Graph Elements, and Gridlines 
Use the Appearance tab in the Graph Properties dialog to customize the color of a curve and of 
other elements in the graph display. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

1. Select Format graph from the View menu, or click Format in the Graph toolbar (hidden 
by default). 
OR 
Right-click in the graph display and select Properties (of the graph) or Appearance (of a 
curve). 

2. If it was not selected by default, select the Appearance tab. 
          The options available are: 

Enable Gridlines Select this check box if you want to see gridlines under your curves.  
You can change the color of the major and minor gridlines in the 
Text and Lines panel. The major and minor gridline intervals depend 
on the graph display. 

Text and Lines Select the element, such as the title or background, of the graph 
display whose color you want to change, and then click Color to 
open the Color dialog. Select a Basic color, or one of the Custom 
colors you may have defined, and then click OK.  
When you select a text element, the Size selector enables you to 
select a font size from the drop-down list; select Auto to revert to 
the default font size. 

Curves Select whether your changes on this tab apply to All Curves or only 
to a selected curve. Click Color to open the Color dialog. Select a 
Basic color, or one of the Custom colors you may have defined, 
and then click OK. 

3.    To confirm changes without closing the dialog, click Apply. 

          OR 
          To close the dialog keeping only applied changes, click Cancel. 

          OR 

          To confirm all changes and close the dialog, click OK. 
The Graph properties dialog enables you to customize the display of the graph currently displayed. 
To set up the default settings for all new graphs, see the Setup View topics. 

Advanced Curve Format Settings 
Use the Advanced tab in the Graph Properties dialog to change whether, and how, data points are 
displayed; whether units or numbers are suppressed on the graph axes; the information associated 
with a curve tool tip; and the interpolation, size (line thickness), and style applied to curves. 
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NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

1.    Select Format graph from the View menu, or click Format in the Graph toolbar (hidden 
by default). 

          OR 
        Right-click in the graph display and select Properties (of the graph) or Appearance (of a 

curve). 
2.    Select the Advanced tab. 

          The options available are: 

Properties of Select whether your changes on this tab apply to All Curves or only to a 
selected curve. 

Hide Select one or more of Hide X Axis Units, Hide Y Axis Units, Hide X 
Axis Numbering, and Hide Y Axis Numbering to suppress the labels 
applied to the X and Y scales.  
Select Hide Information Pane to suppress the curve selector that 
would otherwise, for example, be copied to the clipboard with the graph 
display. 

Tool Tip Display Deselect one or more of these check boxes to suppress elements in the 
tooltip that appears when the mouse pointer is near a curve or data 
point. 

Points Select whether to display data points in the curve, and if so, how they 
should be marked. 

Line Select the Interpolation algorithm (Cubic, Linear, or none) applied to 
the curve joining the data points.  
Select a new Size, in pixels, from the drop-down list to amend the curve 
thickness, perhaps prior to copying the graph display to the clipboard or 
to emphasize a particular curve.  
The Style options enable you to display the curve using a solid, dashed, 
or dotted line. 

3.    To confirm changes without closing the dialog, click Apply. 
          OR 

          To close the dialog keeping only applied changes, click Cancel. 
          OR 

          To confirm all changes and close the dialog, click OK. 

Additional Information 
The Graph properties dialog enables you to customize the display of the graph currently displayed. 
To set up the default settings for all new graphs, see the Setup View topics. 
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Graph Labels 
Use the Label Properties dialog to add, edit or customize labels on the graph. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

The tabs displayed in the dialog depend on which type of label you are working with: 

• Text label, which enables you to place text at any position on the graph. 

• Point label, which enables you to use your mouse pointer, or the vertical cursor, to label 
particular points on your curve(s), such as when you want to compare the position and/or 
intensities of features. 

• Bitmap label, which enables you to place an image, such as your company logo, on the 
graph display. 

Additional Information 
The graph title label and axis labels are properties of the graph format. 

Text Labels 
Use the Label Properties dialog to add a text label to the graph display. 

NOTE: Labels are not stored when you save your curve as an *.sp file, or preserved if you select 
Save for reload next time when you Exit Spectrum FL. 

1.    Select Add Text from the View menu, or click Text in the Graph toolbar. 

          OR 
          Right-click in the graph display and select Add Text. 

          The Label Properties dialog opens and displays the General tab.  The options available are: 

Text Type the text for the label. Use the ENTER key to enter a new line. 
The size of the label is auto-fitted to your text. 

Orientation Select whether the label text should be horizontal or vertical.  
A vertical label reads from bottom to top, which matches the Units 
label on the Y axis. 

Font Size Select the size of the label text. 

Insert Enables you to insert one or more variables into the Text field, 
including the current <Date> and <Time> 

Draw Border Select this check box if you want a box drawn around the label. 

Color If you want to change the color of the label text and any border, click 
Color to open the Color dialog. Select a Basic color, or one of the 
Custom colors you may have defined, and then click OK.  
The label background is transparent, so the color of the graph 
background shows through. 
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2.    To confirm changes without closing the dialog, click Apply. 

          OR 
          To close the dialog keeping only applied changes, click Cancel. 
          OR 
          To confirm all changes and close the dialog, click OK. 

Additional Information 
 Moving a Text Label:  Select the graph label, and then drag it to its correct position on the 

graph. 

 Editing a Text Label:  Select the graph label, right-click and then select Properties. 
The Label Properties dialog is displayed, as described above. 

 Deleting a Text Label: Select the graph label, right-click and then select Remove. 
 Adding a Bitmap Image:  You cannot paste a graphic element into a text label. You can, 

however, place an image, such as your company logo, into the graph using the Add Bitmap 
Image command. 

 Adding other Labels:  You can also add Point labels and Peak labels to your graph.  

Point Labels 
Use point labels to compare the position and/or intensities of features. A point label includes a tie-
line to, and the X value of, a particular position on the curve. 

NOTE: Labels are not stored when you save your curve as an *.sp file, or preserved if you select 
Save for reload next time when you Exit Spectrum. 

1.    Select the position in the curve that you want to label, right-click and then select Label this 
Point. 

        The Label Properties Dialog opens and displays the General tab. The options available are: 

Text By default, this contains <X Value>. Edit the text as needed.  
Use the ENTER key to enter a new line. The size of the label is auto-fitted 
to your text. 

Orientation Select whether the label text should be horizontal or vertical. A vertical 
label reads from top to bottom, which matches the Units label on the Y 
axis. 

Font Size Select the size of the label text. 

Insert Enables you to insert one or more variables into the Text field.  
The <Curve Name> and <Description> are taken from the Results table; 
you can also insert X and Y values and their units. 

Draw Border Select this check box if you want a box drawn around the label. 

Color If you want to change the color of the label text and any border, click 
Color to open the Color dialog. Select a Basic color, or one of the Custom 
colors you may have defined, and then click OK. The label background is 
transparent, so the color of the graph display background shows through. 
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2.    Select the Advanced tab. 
          The options available are: 

Show Tie Line This default option draws a line between a label and the peak. 

Label Position Relative to tie point (default): Label pans as the graph is panned.  
Relative to screen: Label stays in a fixed position on the screen as the 
graph is panned. If the tie line is shown, it is redrawn automatically. 

3.    To confirm changes without closing the dialog, click Apply. 
          OR 

          To close the dialog keeping only applied changes, click Cancel. 
          OR 

          To confirm all changes and close the dialog, click OK. 

Point Labels Using the Vertical Cursor 

1.    Select Vertical Cursor from the View menu, or clck  in the Graph toolbar. 

          OR 

          Right-click in a clear area of the graph display and select Vertical Cursor. 
          The Vertical Cursor is displayed on the graph, with its position on the X axis value displayed 

at its base. 

2.    Drag the cursor line to a point of interest. 
          Position the mouse pointer over the Vertical Cursor until the mouse cursor changes to a 

double-headed arrow . Hold down the left mouse button and then move the mouse left or 
right to drag the cursor to the new position. Release the mouse button. 

3.    Double-click the left mouse button. 

          A label is applied to each curve crossed by the vertical cursor. 

Additional Information 
 Moving a Point Label: Select the label, and then drag it to its correct position on the graph. 
 Editing a Point Label: Select the label, right-click and then select Properties. 

The Label Properties dialog is displayed, as described above. 

  Deleting a Point Label: Select the graph label, right-click and then select Remove. 

 Removing the Vertical Cursor: Click  in the Graph toolbar. 

OR 

Right-click in the graph display and deselect Vertical Cursor. 
 Adding other Labels: You can also add Text labels, Bitmap labels, and Peak labels to your 

graph.  

Bitmap Labels 
Use the Add Bitmap Image command to add a graphic, such as your company logo, to the graph 
display. 
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NOTE: Labels are not stored when you save your curve as an *.sp file, or preserved if you select 
Save for reload next time when you Exit Spectrum. 

1.    Right-click in a clear area of the graph display and select Add Bitmap Image. 

          The Label Properties Dialog opens and displays the Bitmap tab. 

          The options available are: 

Filename Click Browse and select the *.bmp file that you want to apply to the 
graph. You cannot crop or resize this image within Spectrum. 

Transparent 
Background 

Select this check box if you want the graph background color to 
replace any white areas in your image. 

2.    To confirm changes without closing the dialog, click Apply. 

          OR 
          To close the dialog keeping only applied changes, click Cancel. 

          OR 
          To confirm all changes and close the dialog, click OK. 

Additional Information 
 Moving a Bitmap Image: Select the image, and then drag it to its correct position on the 

graph. 
 Editing a Bitmap Image:  Select the image, right-click and then select Properties. The 

Label Properties dialog is displayed, as described above. 

 Deleting a Bitmap Image:  Select the image, right-click and then select Remove. 
 Adding other Labels:  You can also add Text labels, Point labels, and Peak labels to your 

graph.  
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Labeling Graphs using the Vertical Cursor 
Use the Vertical Cursor command to place a vertical line on the graph display that you can drag 
horizontally along the X axis. You can label the position of the cursor in your spectra at any point, 
which enables you to compare the position and/or intensities of features. 

NOTE: Labels are not stored when you save your curve as a *.sp file, or preserved if you select 
Save for reload next time when you Exit Spectrum. 

1.    Select Vertical Cursor from the View menu, or click  in the Graph toolbar. 

          OR 

          Right-click in the graph display and select Vertical Cursor. 
          The Vertical Cursor is displayed on the graph, with its position on the X axis value displayed 

at its base. 

2.    Drag the cursor line to a point of interest. 
          Position the mouse pointer over the Vertical Cursor until the mouse cursor changes to a 

double-headed arrow . Hold down the left mouse button and then move the mouse left or 
right to drag the cursor to the new position. Release the mouse button. 

3.    Double-click the left mouse button. 

          A Point label is applied to each curve crossed by the vertical cursor. 

Additional Information 
 Removing the Vertical Cursor: Select Vertical Cursor from the View menu. 

          OR 

          Click  in the Graph toolbar.  

          OR 
          Right-click in the graph display and deselect Vertical Cursor. 

 Moving a Point Label: Select the label, and then drag it to its correct position on the graph. 
 Editing a Point Label: Select the label, right-click and then select Properties. The Label 

Properties dialog is displayed, as described for Point labels. 
 Deleting a Point Label: Select the graph label, right-click and then select Remove. 

The Vertical Cursor in Process commands 
For some process commands, including Interpolation, the vertical cursor is displayed by default, as 
an aid to selecting the Start and End values for your Selected range. 

Adding other Labels   
You can also add Text labels, Bitmap labels, and Peak labels to your graph.  
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Labeling Peaks 
Use the Label Peaks command to label the peaks in your selected spectra Peaks according to the 
criteria set up in Setup Peak Detection. 

NOTE: Labels are not stored when you save your curve as a *.sp file, or preserved if you select 
Save for reload next time when you Exit Spectrum. 

1.    Select the spectrum whose peaks you want to label. 

2.    Select Label Peaks from the View menu. 
          OR 

          Click  on the Graph Bar. 

          OR 
          Place your mouse pointer on the spectrum whose peaks you want to label, right-click, and 

then select Label Peaks. 

Additional Information 
 Clearing Peak Labels: To remove all the peak labels from the selected spectrum, select 

Label Peaks from the View menu. 

          OR 

          Click  on the Graph Bar. 

          OR 
        Place your mouse pointer on the spectrum whose peaks you want to remove, right-click, 

and then select Label Peaks. 
 Moving a Peak Label: Select the peak label, and then drag it to its correct position on the 

graph. 

 Deleting a Peak Label: Select the peak label, right-click and then select Remove. 
 Adding other Labels: You can also add Text labels, Point labels, and Bitmap labels to your 

graph.  
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Horizontal Cursor 
Use the Horizontal Cursor command to place a horizontal line on the graph display that you can 
drag vertically along the Y axis. 

1.    Select Horizontal Cursor from the View menu, or click  in the Graph toolbar. 

          OR 
        Right-click in the graph display and select Horizontal Cursor. 
        The Horizontal Cursor is displayed on the graph, with its position on the Y axis value 

displayed at its end. 

2.    Drag the cursor line to a point of interest. 
        Position the mouse pointer over the Horizontal Cursor until the mouse cursor changes to a 

double-headed arrow . Hold down the left mouse button and then move the mouse up or 
down to drag the cursor to the new position. Release the mouse button. The Y axis value is 
updated. 

Additional Information 
 Removing the Horizontal Cursor: Select Horizontal Cursor from the View menu. 

          OR 

        Click in the Graph toolbar.  

          OR 

        Right-click in the graph display and deselect Horizontal Cursor. 
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Autoscale Y 
Use the Autoscale Y command to display your selected spectra so that each spectrum fills the 
graph vertically, which enables you to compare spectra of different intensities. 

1.    Select the spectra that you want to be fitted on to the graph display. 

2.    Select Autoscale Y from the Data Analysis toolbar. 
        The selected spectra are scaled, vertically, so that the spectra completely fill the graph. The 

ordinate scale is removed because the spectra are on different scales. 

Additional Information 
Removing Autoscale Y 
 Select Autoscale Y from the View menu, or click Autoscale Y on the Graph toolbar. 

The autoscaling is removed from the selected spectra. 

Offset 
Removing Autoscale Y also removes any vertical offset applied to the selected spectra. 
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Optimize 
Use the Optimize command to rescale your graph, while ignoring any large noise spikes or peaks 
from atmospheric CO2 or water vapor. 
These unwanted features can dominate the spectrum, making peaks in regions of interest difficult 
to see. 

1.    Select the spectra that you want to be fitted on to the graph. 
        The names of the selected spectra are underlined. 

2.    Select Optimize from the View menu. 
        The spectrum is rescaled. 

        The ordinate range stays the same, but the abscissa range is rescaled to the next whole 
number. 

NOTE: The Optimize command changes the way your spectra are displayed in the 
Viewing Area. Your data is not changed. 

Additional Information 
Use the Autorange X command to rescale every feature in your spectrum, including any spikes or 
peaks from atmospheric CO2 or water vapor. 
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Overlay/ Split 
Use the Overlay/Split command to switch between the overlay display mode and the split display 
mode when displaying two or more curves. 

Split 
Split Display mode displays each curve in its own coordinate system. It formats the graph such that 
all the spectra are autoscaled and automatically offset, one above the other. Any spectra that are 
added to the graph later are also autoscaled and offset. 

Overlay 
Overlay display mode formats the graph such that the spectra are displayed on top of each other, 
in the same coordinate system. 
In Overlay mode, you can vertically offset one spectrum from another, which may enable you to 
see its features more easily. 
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Panning, Zooming and Offsetting Spectra 
Use the techniques and tools described in these topics to: 

•       Zoom in on a region of the graph; 

•       Offset a spectrum so that its features can be seen more clearly; 

•       Pan a spectrum up and down or left and right; 

•       Expand or contract the X and Y scale around a fixed point. 

NOTE: These techniques only change the way the spectra are displayed, they do not modify the 
data in any way. 

Zooming to a Region of Interest 
Use the mouse to draw a grow box in the graph. You can be move and resize this grow box. Once 
the box surrounds the region of interest, you can zoom in by double-clicking inside the grow box. 
The region of interest is displayed on the whole graph display: 

1.    Position the mouse pointer at the top-left corner of the region of interest. 
2.    Hold down the left mouse button and drag the mouse diagonally until the grow box covers 

the region of interest. 

3.    Release the left mouse button. 
          A grow box has been drawn around the region of interest. 

4.    Double-click inside the grow box. 

          The graph is zoomed to display only the region of interest. 

Additional Information 

Changing the Size of a Grow Box 

1.    Position the mouse pointer on the border of the grow box. 

          The cursor changes to a two-headed arrow . 
          You can resize the box diagonally by positioning the pointer at a corner, or in one direction 

only by positioning the pointer at an edge. 
2.    Hold down the left mouse button and drag the mouse until the grow box is the size you 

require. 

3.    Release the mouse button. 

Moving a Grow Box 

1.    Position the mouse pointer inside the grow box. 

          The cursor changes to a four- headed arrow . 
2.    Hold down the left mouse button and drag the grow box to the required position. 

3.    Release the mouse button. 
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Removing a Grow Box 

 Position the mouse pointer outside the grow box and click. 

Returning to the Previous Ranges 

 Select Previous Range from the View menu, or click on the Graph Bar. 

Offsetting Spectra 
In Overlay mode, you can vertically offset one spectrum from another, which may enable you to 
see its features more easily. If you select one or more spectra, they will be offset relative to the 
other spectra. If you select all the spectra, they are panned vertically rather than offset. 

 Use the  or  keys to move the spectrum. 

          OR 

        Move your mouse pointer close to the Y axis and drag the vertical pan pointer to move the 
spectrum. 

        The Y range start and end values for the graph change, but the X range values do not. The 
numbers on the Y scale disappear when you introduce an offset. 

Additional Information 

Autorange Y 

When you introduce an offset, you may find that one or more spectra have moved off the top or 
bottom of the graph. 

1.    Select the spectra that you want to fit on to the graph. 
          The spectra are underlined, indicating that they are selected. 

2.    Select Autorange Y from the View menu or from the Graph Bar. 

          The spectra are fitted onto the graph, and the offset is maintained. 

Canceling Offsets and Restoring the Y Scale 

1.    Select the spectra whose offset you want to cancel. 
2.    Select Cancel Offset from the View menu. 

          Any offsets are removed from the selected spectra. 

NOTE: If spectra are removed so that the graph contains only one spectrum, any offset is 
automatically removed and the Y scale is restored. 
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Panning and Expanding 
Moving Spectra to the Left or Right 
 Move your mouse pointer close to the X axis and drag the horizontal pan pointer left or right 

to move your spectra. 
The X range start and end values for the graph change, but the Y range does not. 

Moving Spectra Up or Down 
1. Select the spectra you want to move. 

2. Use the  or  keys to move the spectra.  

OR 

Move your mouse pointer close to the Y axis and drag the vertical pan pointer to move the 
spectra. 
The Y range start and end values for the graph change, but the X range does not. 

NOTE: In Overlay mode, if you have one or more spectra selected from a larger number 
of spectra in the graph, the selected spectra are offset. 

Using an Anchor Point 
1. Select the spectra you want to move. 

2. Right-click in the graph and select Set Anchor Point.  
An anchor point is placed at the position of the mouse pointer. 

3. Drag the anchor point horizontally or vertically to move the selected spectra. 

NOTE: In Overlay mode, if you have one or more spectra selected from a larger number 
of spectra in the graph, the selected spectra are offset as you drag up or down. 

Expanding or Contracting the X or Y Scales 
To expand or contract the X or Y scales around a fixed point: 

1. Right-click in the graph and select Set Anchor Point.  
An anchor point is placed at the position of the mouse pointer. 

2. Move your mouse pointer close to the X axis and drag the horizontal pointer right or left to 
expand or contract the X axis around the anchor point.  
OR 
Move your mouse pointer close to the Y axis and drag the vertical pointer up or down to 
expand or contract the Y axis around the anchor point. 

NOTE: In Split mode, all spectra are panned or expanded horizontally. However, each spectrum 
is treated separately when panned or expanded vertically, so be careful to place your 
anchor point in the graph for the correct spectrum. 

 



 

 

Finding and Saving 
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Finding and Saving 
The Open, Save, and Export commands that you use to open spectra and save spectra to disk are 
available in the Data Analysis File menu. 
Some of these file management commands are also available via keyboard shortcuts and shortcut 
menus. To display a shortcut menu, right click your mouse on the object of interest. 
It is important to distinguish between the commands you use to manage stored files, and the 
Samples Views that you use to organize spectra in the Spectrum FL workspace. 

The following topics address these subjects in more detail: 
• Navigation, which describes the Spectrum Browser, the Data Explorer, and 

the Results Table. 

• Samples Views, which are the virtual folders displayed in the Data Explorer. 

• Opening, Removing and Deleting Files, which describes opening files 
from disk, removing curves from a Samples View, and deleting files from disk. 

• Saving Spectra, which describes the Save commands, setting up the default 
path to a Save location, and the Auto-Save option. 

• Exporting Spectra, which describes how to save a spectra data sets in a 
format that can be read by a spreadsheet, LIMS, or another spectral 
application. 

Additional Information 
The Data Explorer Pane 
The Data Explorer pane provides a visual representation of the spectra and curves generated by 
scanning samples and processing your data. You can create Samples Views in the Data Explorer 
pane, and copy spectra between Samples Views via shortcut menu commands and drag-and-drop 
operations. 
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Samples Views 
A Samples View is a virtual folder that you use to manage your spectra. The currently selected 
Samples View is displayed in the Viewing Area. All the available Samples Views are displayed in the 
Data Explorer pane. 

Creating an Empty Samples View  
Use the New command on the Method Setup File menu to create an empty Samples View. 

1.    Open the Data Explorer pane. 

2.    Select New from the Method Setup File menu, or press CTRL+N. 
        A new Samples View is added to the Data Explorer and given the default name Samples 

View n, where n is an incremented integer. 
3.    To give the Samples View another name, right-click on the folder name and select 

Rename, and then enter your preferred name in the editing box. 

Copying a Spectrum to a New  Samples View  
1.    Open the Data Explorer, right-click the name of the spectrum you want to copy, and select 

Copy to New Folder. 
        A new Samples View containing a copy of the spectrum is added to the Data Explorer and 

given the default name Samples View n, where n is an incremented integer. 
2.    To give the Samples View another name, right-click on the folder name and select 

Rename, and then enter your preferred name in the editing box. 

Removing a Samples View  
 Right-click on the Samples View name in the Data Explorer pane and then select Delete. 

          The Samples View is removed, together with all its contents. 

          No files are deleted from disk. 

NOTE: If you have Spectrum FL ES, you may be prompted to enter an electronic 
signature for the Delete Graph signature point. The contents of the Samples View 
will be stored in the Recycle Bin. 

Restoring Samples Views (Spectrum FL ES only) 
 Right-click on the Recycle Bin in the Data Explorer pane and then select Restore All. Any 

Samples Views in the Recycle Bin will be recreated in the Data Explorer, together with any 
spectra they contained. 

Additional Information 
For further information about organizing spectra using Samples Views, see Data Explorer. 
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Opening, Removing, and Deleting Files 

Opening a File 
Use the Open command on the File menu to open any file that can be used with Spectrum FL. 

1.    Select Open from the File menu, or press CTRL+O. 
          OR 

        In the Data Explorer pane, select a Samples View, right-click and then select Open Spectrum. 

        The Open File dialog is displayed. 
By default, all the binary spectra (*.sp files) in the C:\ pefl_data\spectra folder are 
displayed. You can also open, for example, interferograms (*. ig files), JCAMP files (*.dx), 
Omnic files (*.spa), GRAM files (*.spc), Opus files (*.opu), or spectra saved as data points 
in a PerkinElmer ASCII text format (*.asc files). 
By default, your spectra are displayed with thumbnail previews. To discover more about 
the spectrum, hover your mouse pointer over a thumbnail (or icon in the Tiles, Icons, or 
List views). In the Details view you can choose to display the columns Analyst, Spectrum 
Description, Ordinate, Abscissa, Scan Start, Scan End and Scan Interval. 

 

NOTE: The properties of a Samples View are separate from the properties of any graph 
it contains. 

2.    Click the filename you want to select. 
The file is selected, and all other files deselected. 
To select a block of files, hold down SHIFT and click the first and the last filenames in the 
block. 
To select or deselect a file, leaving the others selected, hold down CTRL as you click the 
filenames. 

3.    Click Open. 

          Your selected spectra are displayed in the selected Samples View. 

NOTE: If you have Spectrum FL ES, and you are opening non-ES data, then you may be 
prompted to enter an electronic signature for the Data signature point. The 
spectrum will be added to the database. 

Removing a Spectrum from a Samples View  
1.    Open the Data Explorer pane, and then select the Samples View. 
2.    Right-click the link you want to remove, and then click Delete. 

          The spectrum is removed from the Samples View. 

          If the spectrum has been saved, the file is NOT deleted. 

NOTE: If you have Spectrum FL ES, you may be prompted to enter an electronic signature 
for the Delete Graph signature point. The spectrum will be stored in the Recycle 
Bin. 
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Alternatively: 
 Right-click the spectrum you want to remove in the Viewing Area, and then click Remove 

Curve. 

The spectrum is removed from the Samples View. 

If the spectrum has been saved, the file is NOT deleted. 
 

NOTE: If you have Spectrum FL ES, you may be prompted to enter an electronic 
signature for the Delete Graph signature point. The spectrum will be stored in the 
Recycle Bin. 

Removing all Selected Spectra from a Samples View  
 Open the Data Explorer pane, right-click the Samples View, and then press the Delete key. 

          All selected curves are removed from the Samples View. 
          NO files are deleted from the hard disk. 

NOTE: If you have Spectrum FL ES, you may be prompted to enter an electronic 
signature for the Delete Graph signature point. The contents of the Samples View 
will be stored in the Recycle Bin. 

Deleting a File from Disk 
Use the Open command on the File menu to delete a saved file. 

1.    Select Open from the File menu. 

OR 
Press CTRL+O. 

OR 
In the Data Explorer pane, select a Samples View, right-click and then select Open 
Spectra. 

The Open File dialog is displayed. 
By default, all the binary spectra (*.sp files) in the C:\pefl_data\spectra folder are 
displayed. You can also view spectra saved as data points in a PerkinElmer ASCII text 
format (*.asc files), or any type of file (*.* files). 

By default, your each spectrum is displayed with a thumbnail previews. To discover more 
about the spectrum, hover your mouse pointer over a thumbnail (or filename in the List 
and Detail views). 

2.    Right-click the filename you want to delete from disk, and then click Delete. 
You can select a number of filenames to delete using the SHIFT and CTRL keys, right-click 
on any selected filename, and then click Delete. 
The selected spectra are deleted from disk. The spectrum will not be removed from the 
Samples View. 
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Saving Spectra 
The Viewing Area's Results Table tab includes, by default, a column that indicates whether or not a 
particular spectrum has been saved. 

The Save Command 
Use the Save command to save selected spectra using their current filename and file format. 

1.    Select the spectra you want to save. 
You can use the Data Explorer to select a single spectrum from a Samples View. 
Alternatively, you can use the spectrum browser to select one or more spectra from the 
selected Samples View. 

2.    Select Save from the File menu. 

OR 
Press CTRL+S. 

If you have Spectrum FL ES, you will be prompted to enter an electronic signature for the 
Output step. 
The selected file, or files, are saved. 

If a spectrum has not been saved before, the Save As dialog is displayed. 

The Save All Command 
Use the Save All command to specify new filenames, or to specify a new default path for all 
Samples Views. 

1.    Select Save All from the File menu. 

The Save All Spectra dialog is displayed, which tabulates all the spectra in all the Samples 
Views. 

2.    In the Save column, select (check) all the spectra you want to save, and deselect (uncheck) 
all the spectra that should not be saved. 
The icon to the right of the check box indicates whether a spectrum has already been 
saved. 

3.    Amend any Filenames that you want to change, remembering that some characters cannot 
be used in filenames. 

If you amend a filename, the icon to its left indicates that the file has not been saved. 
4.    To amend the path used to store a particular spectrum, hover your mouse pointer over the 

Save File Path entry for the spectrum, and the click the  button that appears. Select the 
directory in the Browse for Folder dialog and then click OK. 
The Save File Path is amended for this spectrum. 

OR 

To amend the path used to store these spectra, click the   button on the right of the 
directory field at the bottom of the dialog, select the directory in the Browse for Folder 
dialog and click OK. the directory field is updated. Then click Apply to all.   
The Save File Path is amended for all the spectra. 

5.    Click Save. 
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If you have Spectrum FL ES, you will be prompted to enter an electronic signature for the 
Output step. 

The Save As Command 
Use the Save As command to specify new filenames, or to specify a new default path for the 
selected Samples View. 

1.    In the Data Explorer pane, select the Samples View that contains the spectra you want to 
save. 

2.    Select Save As from the File menu. 
The Save Spectra As dialog is displayed, which tabulates all the spectra in the selected 
Samples View. 

3.    In the Save column, select (check) all the spectra you want to save, and deselect (uncheck) 
all the spectra that should not be saved. 
The icon to the right of the check box indicates whether a spectrum has already been 
saved. 

4.    Amend any Filenames that you want to change. 
If you amend a filename, the icon to its left indicates that the file has not been saved. 

5.    To amend the path used to store a particular spectrum, hover your mouse pointer over the 
Save File Path entry for the spectrum, and the click the  button that appears. Select the 
directory in the Browse for Folder dialog and then click OK. 

The Save File Path is amended for this spectrum. 
OR 

To amend the path used to store these spectra, click the   button on the right of the 
directory field at the bottom of the dialog, select the directory in the Browse for Folder 
dialog and click OK. the directory field is updated. Then click Apply to all.   

The Save File Path is amended for all the spectra. 
6.    Click Save. 

If you have Spectrum FL ES, you will be prompted to enter an electronic signature for the 
Output step. 

Additional Information 
Auto-Save 
The Auto-Save option saves each spectrum after data collection automatically. This option is 
selected by default; see Setup Instrument Data Collection. 

Saving Files from the Graph tab 
You can save a spectrum in either binary (*.sp) or ASCII (*.asc) format using shortcut menu 
commands. This method allows you to save the file with any filename and to any location. 

1.    Hover your mouse pointer over a spectrum and right-click to display a shortcut menu. 
2.    Select Save as Binary or Save as ASC. 

The Save As dialog is displayed. 
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3.    Browse to the location where you want the file to be saved. 
Initially the dialog displays the contents of C:\pefl_data\spectra. If you use the dialog more 
than once, the location of your last save is displayed. 

4.    Type or choose a filename. 

You do not need to include the filename extension because the extension that is displayed 
in the file selector is added automatically. 

5.    Click Save. 

If a Samples View is selected so that the spectrum browser is displayed: 
1.    Hover your mouse pointer over the curve names in the spectrum browser, and right-click 

when the name of the spectrum you want to save is underlined. 
2.    Select Save as Binary or Save as ASC. 

The Save As dialog is displayed. 

3.    Continue from step 3 above. 
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Exporting Reports 
Reports in Spectrum FL are generated from templates prepared using PerkinElmer's Report 
Designer software. You can either prepare these templates in advance or create one when required 
and use it to generate a report immediately. 

1.    To generate a method report, select the Method Setup mode in navigation panel,  select 
the method you are interested, then go to step 2. 

OR 

To generate an experiment report, select Previous Results mode in navigation panel, 
select the experiment you are interested, then go to step 2. 
OR 
To generate the report of a single spectrum, select the spectrum name in the Data 
Explorer, then go to step 2. 

NOTE: Check the appearance of the data that you will include in the report.  Depending on the 
settings in the template you have selected, the appearance of the data in Spectrum FL 
may be duplicated in the report. 

2.    Select Report from the File menu. 

The Report dialog opens. 

3.    Select the Reports Options tab. 

4.    Select the Save report check box if you want to save the report(s). 
5.    Select Show saved report if you want the report(s) to be displayed when generated. 

6.    Select the Print report check box to print the report(s) to the currently active printer. 
7.    If necessary, click Browse, find the template file that you want to use to generate the 

report, and click Open. 
Templates created in Report Designer have a *.tplx filename. 

OR 

Click Create and Report Designer will open so that you can create a new template. 
You can also select a template and then click Edit if you want to make any changes in 
Report Designer before you generate a report. Remember to save the template in Report 
Designer before you generate the report. See the on-screen Help in Report Designer for 
further details. 
In Spectrum FL ES, you can also select a template from a list of those used previously in 
the workspace. 

8.    Select the type of report(s) you want to generate from the options available. 
The report options available will depend on the items included in the selected template and 
on the data selected in Spectrum. For example, if the template only contains items related 
to data for multiple spectra (that is, all the spectra in the Samples View), then the single 
spectrum report option is disabled. If you have selected a single spectrum name in the 
Data Explorer in step 1, then the multiple spectra report option is disabled. 
Select the Include option next to the Samples View Name if you want to generate a 
report for all the spectra in the Samples View. 
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If you selected the Samples View in step 1, select the Include option next to the 
Spectrum Name if you want to generate an individual report for a spectrum. All the 
spectra are selected by default. To select or deselect all the spectra, check or uncheck the 
Select all single spectra reports option. 

9.    Select the Report Edit tab. 

10.  Select the Report format from the drop-down list. 
In Spectrum FL the options are rich text format (*.rtf) and portable document format 
(*.pdf).  
In Spectrum FL ES the report is saved in a secured and encrypted portable document 
format. 

11.  If necessary, browse to another (or create a new) folder for the generated report(s). 

By default, all reports are saved to C:\pefl_data\reports. 
12.  Select the sections to be included in the report from the Section Name list, which are 

derived from the template. 
To select all or deselect all the possible sections, check or uncheck the Select all check 
box. 

13.  Click Report. 
If you have Spectrum FL ES, you may be prompted to enter an electronic signature for the 
Output step. 

The report is generated. 
The filename generated for saved multiple spectra reports is derived from the Samples 
View name. The file name for an individual spectrum report is derived from the Samples 
View name and the Sample ID. 

Each time a report file is generated, a number is appended to the name. 

No output will be produced if the file cannot be created. 

Additional Information for Spectrum FL ES 
You can only generate reports in Spectrum FL ES if you have the appropriate permission. Similarly, 
you can only open Report Designer to create or edit a template if you have the appropriate 
permission. 
You can only select a template if it has the correct status. The acceptable status levels are shown 
in the drop-down list in the Report Options tab. If you are a user with the appropriate permission, 
you can change these settings, but otherwise you will only be able to select templates which meet 
these criteria. The status for each template is shown in the dialog when you click Browse to find a 
template. 
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Opening an ES Report 
Use the Open ES Report command on the File menu to open a secure (checksummed) report file 
in Spectrum ES. 

1. Select Open ES Report from the File menu, or press CTRL+T. 
By default, all the secured PDF report files (*.spdf files) in the C:\ pefl_data\reports folder 
are displayed. You can also open secured RTF report files (*.srtf files). 

2. Click the filename you want to select. 
The file is selected, and all other files deselected. 

3. Click Open. 
A *.pdf or *.rtf file is created in the reports folder, opened and displayed in the default 
application for PDF or RTF files. The *.srtf and *.spdf files remain unchanged. 
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Exporting Spectra 
Use the Export command save your spectra to a specified folder as data files that are accessible to 
other applications. 

1. Select Export from the File menu. 
The Export Data dialog opens. By default, all the spectra available in the Data Explorer 
pane are displayed. 

2. Deselect any spectra that you do not want to export. 

3. If necessary, click  to browse to another (or to create a new) folder for the exported 
files, and then click Apply to All to specify that this folder should be used (rather than the 
current default directory). 

4. If your selected folder already contains files with the same names that you wish to 
overwrite, tick the Overwrite files check box. 

5. Select the Format for your exported files. 

Custom Defined File uses the settings defined on the Setup Export tab. 
Comma Separated Value (*.csv) is a common file format that can be read into, for 
example, a Microsoft Excel spreadsheet or a Laboratory Information Management System 
(LIMS). 
JCAMP-DX (*.DX) is a standard file format for spectral data specified by the International 
Union of Pure and Applied Chemistry (IUPAC). You can also export to (*.SPC) file format. 

6. Click Export. 
If you have Spectrum ES, you will be prompted to enter an electronic signature for the 
Output step. 

Your selected spectra are exported to the specified folder. 

Additional information 
You can also save spectra in the binary *.sp (*.ig for interferograms) or the plain text ASCII 
(*.asc) file formats. 
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Navigation 
The Viewing Area, in the center, shows all the curves in the current Samples View on the Graph 
tab. 

The Spectrum Browser 
The Graph tab includes a table, or spectrum browser, that enables you to select which curves you 
want to work with. The names of the selected spectra are marked by a  , and are drawn in full 
color; any unselected curves are not marked and are drawn dimmed. 

 To select a curve in the spectrum browser, click its name. 
OR 

Hover your mouse over the curve, right-click and then select Select Only This Curve. 
The curve is selected, and all other files deselected. 

 To select a block of curves, hold down SHIFT and click the first and the last name in the 
block. 

 To select or deselect a curve, leaving the others selected, hold down CTRL as you click the 
name of the curve. 

 To select all the curves in the Samples View, press CTRL+A. 

The Data Explorer 
The Data Explorer pane, on the left, provides a visual representation of all the Samples Views 
containing all that the spectra that are currently open. 





 

 

Publishing Results 
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Publishing Results 
These topics describe the editing and printing options that enable you to publish your results. 

Once you have processed and formatted your results, you can: 

• Use the Send To command on the Data Analysis File menu to send your results to a 
WordPad or, if installed, a Microsoft® Word document, Microsoft Excel workbook data 
table. You can also send your results as an email attachment. 

• Use the Report command on the File menu to output a report. 

• Review a Print Preview and Print. 

• Copy and Paste from the currently displayed tab in the Viewing Area to another location. 

Additional Information 
If you prefer to process and format your results outside Spectrum FL, you can: 

• Use a File menu command to Export each spectrum as a comma separated value (*.csv), 
or JCAMP-DX (*.dx) file. 

• Save your spectra as binary (*.sp) or ASCII (*.asc) files. 
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Send to WordPad or Word 
Use the Send To command to copy the contents of the Viewing Area into an editable document. 

1. Select the tab in the Viewing Area that contains the results or curves that you want to 
copy. 

2. If the tab contains curves, format and label them until you are happy with their 
presentation. 
All your labels will be copied. If you copy into a Word document your labels are placed in 
text boxes. 

3. Select Send To from the File menu, then Word or WordPad, and then select the 
document you require. 

The Microsoft® WordPad™ option copies into a rich text format (.rtf) file that you can edit 
using the WordPad accessory, which is a simple word processing program supplied with 
Windows. 

If Microsoft® Word™ is installed, the Word option copies into a native Word (.doc or .docx) file. 

The document sub-menu enables you to create a new document or to select any WordPad 
(.rtf) or Word (.doc or .docx) document that is open or minimized on your PC. 
Your results are copied into the selected document. 

4. If you created a new document, open the minimized file. 

5. Complete and publish your document. 

Additional Information 
Editable Objects Included in the Document 

• When you send the Results Table tab or History tab, today's date is included in your 
document. 

• When you send the Sample Table tab, today's date and the current time is included in your 
document. 

• When you send a curve, the contents of the Results panel are included in your document. 

Non-Editable Objects Included in the Document 
By default, the Samples View includes the spectrum browser. When you send a graph display the 
contents of the spectrum browser are included in your document, which acts as a key to the graphic. 

If you do not want this information to be included, hide the spectrum browser before sending: 
1. Right-click in the Samples View, and then select Properties. 

The Graph Properties dialog is displayed. 
2. Select the Advanced tab, select the Hide Information Pane option, and then click OK. 

The spectrum browser or Results pane is hidden. 

3. Select Send To from the File menu, then Word or WordPad. 
Your results, but not the contents of the spectrum browser, are copied into the selected 
document. 

4. Restore the Samples View by clearing the Hide Information Pane check box. 
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Send to Excel 
Use the Send To command to copy the contents of the Viewing Area into an Excel workbook. 

1. Select the tab in the Viewing Area that contains the results that you want to copy. 
2. Select Send To from the File menu, then Excel, and then select the document you 

require. 

If Microsoft Excel is installed, the Excel option copies into a native Excel (.xls or .xlsx) file. 
The document sub-menu enables you to create a new workbook or to select any Excel 
workbook that is open or minimized on your PC. 
Your results are copied into new worksheets in the selected workbook. The number of 
worksheets created will depend on the tab currently displayed. 

3. If you created a new worksheet, open the minimized file. 
4. Complete and publish your file. 

Additional Information 
• When you send the Graph tab to Excel, the X and Y data of the spectrum or spectra are 

added to a new worksheet. Each worksheet is named after the spectrum. 
• When you send the Results Table tab to Excel, the Results are added to a new worksheet 

named Results. 

• When you send the Sample Table tab, the Sample Table is added to a new worksheet 
named Sample Table. 

• When you send the Search tab, four worksheets are added to the workbook: Source 
Spectra Search Results, Search Hit List, and the X and Y data of the sample spectrum and 
the best hit spectrum. If your Search tab contains multiple source spectra, only the data 
for the row selected in Source Spectra Search Results will be sent. 

• When you send the Compare tab, four worksheets are added to the workbook: Source 
Spectra Compare Results, List of Compared References, and the X and Y data of the 
sample spectrum and the best hit spectrum. If your Compare tab contains multiple source 
spectra, only the data for the row selected in Source Spectra Compare Results will be sent. 

• When you send the History tab to Excel, four worksheets are added to the workbook: 
Sample, Instrument, History and Quality Checks, corresponding to the four sections of the 
History tab. If no Quality Checks were selected when the sample spectrum was collected, 
then the Quality Checks worksheet will not be created. 
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Send To Email 
Before you use the Send To Email command, you will need to define the email settings on the 
Email tab. 
Use the Send To Email command to copy the contents of the Viewing Area into an email. 

1. Select the tab in the Viewing Area that contains the results or curves that you want to 
email. 
If the tab contains curves, format and label them until you are happy with their 
presentation. 

All your labels will be copied. If you copy into a Word document your labels are placed in 
text boxes. 

2. Select Send To from the File menu, then Email. 
The Send Email dialog is displayed with your results added to the Attachments pane at the 
bottom of the dialog. The Total Attachment Size is shown in megabytes (MB). The 
From field is automatically populated with the User name entered on the Setup Email tab. 

3.  Enter the recipients email address in the To field. 
4. If you want to remove any of the attached files, deselect the check box. 

The Total Attachment Size is updated. 
5. If you wish to add any further attachments to the email, click Add Attachments, and 

then browse to the file(s) you would like to add. 
The Total Attachment Size is updated. 

6. Complete your email message, and then click Send. 

Additional Information 
• If you selected the Samples View tab, you will receive an email with an rtf file attached 

that contains the spectra in a graph window, and the spectra attached as *.sp files. 

• If you select the Graph view of an individual spectrum, the rtf file attached contains the 
spectrum in a graph window. The spectrum is also attached as an *.sp file. 

• If you select the Results tab, the rtf file attached contains the date of the document and 
the content of the Results Table as a table. The spectra are also attached as *.sp files. 

• If you select the History tab for the sample selected, the rtf file attached includes the date, 
the Sample data, Instrument Settings, and History.  The spectrum is also attached as an 
*.sp file. 

• If you select the Compare tab, the rtf file attached includes the user ID, the date of the 
document, the Compare results, the detail of the spectrum, and the graph display. The 
spectrum selected in the Compare Results is also attached as an *.sp file. 

• If you select the Peak table tab, the rtf file attached includes the user ID, the date of the 
document, the peak table and the graph display with the peaks marked. The spectrum 
selected in the Results is also attached as an *.sp file. 

Editable Objects Included in the Document 
• When you send the Results Table tab or History tab, today's date is included in your 

document. 
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• When you send the Sample Table tab, today's date and the current time is included in your 
document. 

• When you send a curve, the contents of the Results panel are included in your document. 

Non-Editable Objects Included in the Document 
By default, the Samples View includes the spectrum browser. When you send a graph display the 
contents of the spectrum browser are included in your document, which acts as a key to the 
graphic. 

If you do not want this information to be included, hide the spectrum browser before sending: 
1. Right-click in the Samples View, and then select Properties. 

The Graph Properties dialog is displayed. 
2. Select the Advanced tab, select the Hide Information Pane option, and then click OK. 

The spectrum browser or Results pane is hidden. 
3. Select Send To from the File menu, then Email. 

Your results, but not the contents of the spectrum browser, are copied into the selected 
document, which is added to the email. 

4. Restore the Samples View by clearing the Hide Information Pane check box. 
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Print and Print Setup 

Print 
Use the Print command in the File menu to print a pre-formatted version of the contents of the 
Viewing Area. 

This dialog also enables you to select a specific Printer and its Properties dialog. 
Alternatively, if you want to print a graph display, right-click in the Graph tab and then select 
Print. 
If you have Spectrum FL ES, you may be prompted to enter an electronic signature for the Output 
signature point. 

Print Preview  
Use the Print Preview command in the File menu to review the printed output. The Print Preview 
dialog enables you to: 

• Review a multi-page document. 

• Amend the Page Setup, which includes the page Size, Orientation and Margins. 

• Zoom in to a particular area of the document, and to use a Snapshot tool to select and 
copy a detail from the document to the Clipboard as a Windows metafile. 

When you have finished reviewing the output, click Print from the File menu. This document is 
sent to your default printer using the current printer settings.  
If you have Spectrum FL ES, you may be prompted to enter an electronic signature for the Output 
signature point. 
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Exporting Reports 
Reports in Spectrum FL are generated from templates prepared using PerkinElmer's Report 
Designer software. You can either prepare these templates in advance or create one when required 
and use it to generate a report immediately. 

1. To generate a method report, select the Method Setup mode in navigation panel,  select 
the method you are interested, then go to step 2. 

OR 
To generate an experiment report, select Previous Results mode in navigation panel, select 
the experiment you are interested, then go to step 2. 

OR 
To generate the report of a single spectrum, select the spectrum name in the Data 
Explorer, then go to step 2. 

NOTE: Check the appearance of the data that you will include in the report.  Depending on the 
settings in the template you have selected, the appearance of the data in Spectrum FL 
may be duplicated in the report. 

2. Select Report from the File menu. 
The Report dialog opens. 

3. Select the Reports Options tab. 
4. Select the Save report check box if you want to save the report(s). 

5. Select Show saved report if you want the report(s) to be displayed when generated. 
6. Select the Print report check box to print the report(s) to the currently active printer. 

7. If necessary, click Browse, find the template file that you want to use to generate the 
report, and click Open. 
Templates created in Report Designer have a *.tplx filename. 

OR 
Click Create and Report Designer will open so that you can create a new template. 

You can also select a template and then click Edit if you want to make any changes in 
Report Designer before you generate a report. Remember to save the template in Report 
Designer before you generate the report. See the on-screen Help in Report Designer for 
further details. 
In Spectrum FL ES, you can also select a template from a list of those used previously in 
the workspace. 

8. Select the type of report(s) you want to generate from the options available. 
The report options available will depend on the items included in the selected template and 
on the data selected in Spectrum. For example, if the template only contains items related 
to data for multiple spectra (that is, all the spectra in the Samples View), then the single 
spectrum report option is disabled. If you have selected a single spectrum name in the 
Data Explorer in step 1, then the multiple spectra report option is disabled. 

Select the Include option next to the Samples View Name if you want to generate a 
report for all the spectra in the Samples View. 
If you selected the Samples View in step 1, select the Include option next to the 
Spectrum Name if you want to generate an individual report for a spectrum. All the 
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spectra are selected by default. To select or deselect all the spectra, check or uncheck the 
Select all single spectra reports option. 

9. Select the Report Edit tab. 

10. Select the Report format from the drop-down list. 
In Spectrum FL the options are rich text format (*.rtf) and portable document format 
(*.pdf).  
In Spectrum FL ES the report is saved in a secured and encrypted portable document 
format. 

11. If necessary, browse to another (or create a new) folder for the generated report(s). 
By default, all reports are saved to C:\pefl_data\reports. 

12. Select the sections to be included in the report from the Section Name list, which are 
derived from the template. 
To select all or deselect all the possible sections, check or uncheck the Select all check 
box. 

13. Click Report. 

If you have Spectrum FL ES, you may be prompted to enter an electronic signature for the 
Output step. 
The report is generated. 
The filename generated for saved multiple spectra reports is derived from the Samples 
View name. The file name for an individual spectrum report is derived from the Samples 
View name and the Sample ID. 
Each time a report file is generated, a number is appended to the name. 

No output will be produced if the file cannot be created. 

Additional Information for Spectrum FL ES 
You can only generate reports in Spectrum FL ES if you have the appropriate permission. Similarly, 
you can only open Report Designer to create or edit a template if you have the appropriate 
permission. 
You can only select a template if it has the correct status. The acceptable status levels are shown 
in the drop-down list in the Report Options tab. If you are a user with the appropriate permission, 
you can change these settings, but otherwise you will only be able to select templates which meet 
these criteria. The status for each template is shown in the dialog when you click Browse to find a 
template. 
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Setting up a Results File for Exporting 
A file of accumulated results from each of the main spectral processing functions (Compare) can be 
collected by Spectrum FL for export as a *.csv file to another software application for further 
analysis. 

1. Click the Setup Results File tab for the process whose results you want to record in an 
accumulated result file. 
There is a Setup Results File tab in each set of tabs displayed from the Setup menu or 
Navigation Pane. 

2. Check the Create results file at this location checkbox. 

3. If required, click Browse and select a different location for the result file. 
The file will be named automatically based on the process and, where applicable, the 
specific method being used to process the data. 

4. Choose whether to Overwrite the data each time the process is run for a set of samples, 
or Append the new data to the existing data in the file. 

Similar files can also be generated using the Setup Results File tab in Ready Checks and 
Instrument Verification. These collate the results for all the checks performed into a single file, 
except for Pharmacopoeia tests which are recorded separately. 

Once the files have been created and contain some data, you can export them for further analysis. 
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Copying and Pasting 
Use the Copy (CTRL+C) keyboard shortcut to place information on the Windows Clipboard, and the 
Paste (CTRL+V) keyboard shortcut to paste information from the Clipboard into another location. 
The behavior of these keyboard shortcuts depends on the type of information that you are copying 
and pasting. If the keyboard shortcut is not enabled, you may be able to right-click and select a 
command. 

NOTE: If you have Microsoft® Word™, you can manage the clipboard using the Office Clipboard 
task pane. In Word 2003, select Office Clipboard from the Edit menu. In Word 2007, 
click the Clipboard dialog launcher in the Clipboard group on the Home tab. 

Samples View  and Graph tab selected 
To copy the graph display, including all labels and curves, whether selected or not: 

 Right-click and then select Copy to Clipboard. 
The CTRL+C shortcut is not enabled. 

NOTE: The graph display is copied as a Windows metafile. You can paste spectra only into 
Windows applications that support metafiles 

Samples View  and Results tab selected 
To copy the Name and Description of the selected row: 
 Right-click and then select Copy. 

ORadmin 
Press CTRL+C.   
A table containing the name and Description is copied. 

Spectrum FL and [Sample Name] tab selected 
To copy the graph display of a single spectrum, including all labels: 
 Right-click and then select Copy to Clipboard. 

The CTRL+C shortcut is not enabled. 

NOTE: The graph display is copied as a Windows metafile. You can paste spectra only into 
Windows applications that support metafiles 

Spectrum FL and History tab selected 
To copy the data from a panel: 

1. Make sure that you have not selected a particular Setting or Value. 

If a Setting or Value is selected, the copy function is not enabled. 
2. Right-click in a panel and then select Copy. 

OR 
Press CTRL+C. 

Each Settings and Value in the panel is copied as a paragraph with tab separators. 
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Sample Table selected 
To copy a selected field as ASCII text, or the contents of a selected row as tab separated text: 

 Right-click and then select Copy. 

OR 
Press CTRL+C. 

NOTE: You can use the Copy and Paste keyboard shortcuts and commands to help you 
complete a sample table with multiple rows for collecting spectra from a batch of 
samples. However, any duplicate Sample ID entries will be shaded pink and cannot be 
run. Make sure you have entered unique Sample ID entries before collecting data from 
your samples. 

 



 

 

Setup and Administration 
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Setup and Administration 
These topics describe the range of Setup and Administration commands that enable you to: 

• Administer the login names and passwords (if required) for each Spectrum FL 
user. To set up users, you must be logged into Spectrum FL as an 
Administrator. 

• Administer the list of instruments available to Spectrum FL. 

• Set up the connected Instrument. 

• Set up instrument Ready Checks. 

• Set up the custom Export of your spectra. 

• Set up the email account that will be used for Send To Email. 

• Set up how peaks in your spectra are detected and labeled. 

• Setup the default graph View. 

• Define, or edit, an Equation to perform calculations on one or more spectra, 
or on the data obtained from other processes. 



Setup and Administration . 165 

 

 

Administration 
Provided that you are logged into Spectrum FL Standard or Spectrum FL ES as an administrator, 
the Administration sub menu of the Setup menu enables you to: 

• Setup a login name and password (if required) for each Spectrum FL user. 

Provided that you are logged into Spectrum FL ES as an administrator, the Administration 
sub-menu of the Setup menu also enables you to: 

• Add new Groups and set the permissions for each group (except Administrators). 

• Define the operations in the software that require a Signature from a pre-defined list. 

• Administer the Users Audit Trail. 

• Set a default workspace for a group. 

Setting up Users, Groups, and Passwords 
Each person using Spectrum must be set up as a user by a person who has permission to perform 
administration tasks. 
 To set up users, select Administration from the Setup menu, and then click Setup Users. 

The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures and 
Password Control dialog (Spectrum FL ES) is displayed. 

NOTE: When making any changes in the dialog, click Apply to accept the changes and keep the 
dialog open. Click OK to apply the changes and close the dialog. 

A user's access rights depend entirely on group memberships. Spectrum FL utilizes two pre-defined 
groups, namely the Administrators group and the Users group. You cannot use Spectrum FL to 
amend the access rights applied to these groups or to create new groups. The default Spectrum FL 
user named Administrator has membership of both the Administrators group and the Users group 
for Spectrum standard. 
In Spectrum FL Enhanced Security (ES), the Administrators, Users, Reviewers and Approvers 
groups are predefined. The access rights applied to the Users, Reviewers and Approvers groups 
can be customized, and additional groups with particular access rights created. The access rights 
applied to the Administrators group cannot be customized. 
The Administrators group exists for a range of PerkinElmer software applications. The Users group 
exists for the standard versions of a range of PerkinElmer software and for Spectrum FL ES. 
A user defined for another standard PerkinElmer application will appear in the Users list for 
Spectrum FL, but that user must be enabled by a Spectrum FL administrator. 

Default Users 
The following user is pre-defined for Spectrum FL: 

User Password Group Membership 

Administrator administrator Administrators, Users 
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The following user is pre-defined for Spectrum FL ES: 

User Password Group Membership 

Administrator administrator Administrators 

Default Groups 

Spectrum FL Standard 

The following groups are predefined for Spectrum FL. These groups cannot be deleted or other 
groups added. 

Group   

Users Members of the Users group cannot set up other users. 

Administrators Only members of the Administrators group have access to the 

Setup Users command. 

Spectrum FL ES 

The following groups are predefined for Spectrum FL ES.  The Administrators group cannot be 
deleted. Other groups can be deleted or other groups added. 

Group   

Administrators Only members of the Administrators group have access to 
the Setup Users command. The permissions for the 
Administrators group cannot be changed. 

Users By default, members of the Users group can perform all 
functions in the software except those associated with 
Administrators and Return Workspace, Review and Approve. 
The permissions available are defined by the Administrator. 
Members of the Users group cannot set up other users. 

Reviewers Members of the Reviewers group are intended to act as 
reviewers of changes made by other users requiring an 
electronic signature. Members of the Reviewers group cannot 
set up other users. 

Approvers Members of the Approvers group are intended to act as 
approvers of changes made by other users requiring an 
electronic signature. Members of the Approvers group cannot 
set up other users. 

Additional Information 

The Administrators group applies across a range of PerkinElmer software applications. 
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Adding a New  User to Spectrum FL 
Use the Setup Users command to add a user to the list of users that are able to log in to Spectrum 
FL at this PC.  
You cannot add a user unless you are logged into Spectrum FL as an administrator. 

1. From the Setup menu, select Administration and then click Setup Users. 
The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures 
and Password Control dialog (Spectrum FL ES) is displayed. 

2. Select the Password Control tab. 
If the Login Type is Windows, which is a global setting, click Cancel. 

Add new users using Windows User Management. 
Otherwise: 

3. Select the Users tab and click New. 
The New User dialog is displayed. 

4. Enter the User name and Full name. 
5. If the Login Type is PerkinElmer Login, enter a user Password, and then enter this 

password again in the Confirm password field. 
The global properties of passwords, such as their minimum length, are defined on the 
Password Control tab. Passwords are case-sensitive, and can consist of letters, numbers 
and single spaces only. 

6. By default, the Status of the user is Enabled, which allows the user to log in 
straightaway. If you want to enable the login later, select Disabled. 
When you enable a previously disabled user, you must enter a new password and confirm 
it. 

7. If the Login Type is PerkinElmer Login, select whether the User must change their 
password at the next login. 

NOTE: In Spectrum FL ES User must change password at next login is mandatory. 

8. Click OK. 
The User name drop-down list is updated with the new user. 

Adding and Deleting a Group (Spectrum FL Enhanced Security Only) 
Use the Setup Users command to add a new group to those that users can be assigned to in 
Spectrum FL Enhanced Security at this PC. 

NOTE: It is not possible to create a new group within the Standard version of Spectrum FL. 

You cannot add a group unless you are logged into Spectrum FL as an administrator. 

Administrators can assign permissions to the members of a group that control what they are able 
to do in a way that is tailored to your company's working practices. For example, you can set up 
permissions that allow members of a particular group to run a Compare process, but not to modify 
the Compare parameters, such as the Correlation value, or the spectra that are used as the 
Compare references. 
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If a group does not have permission to edit a group of options, those options will not be visible in 
the software. For example, if you do not have permission to run a Deconvolution Process, that 
option will not be displayed on the Process menu. If you do not have permission to perform any of 
the processes on the Process menu, then the menu will be hidden. 

Adding a New  Group 
1.    From the Setup menu, select Administration and then click Setup Users. 
          The Users, Groups, Signatures and Passwords Control dialog is displayed. 

2.    Select the Groups tab and click New. 
          The New Group dialog is displayed. 

3.    Enter the Group name. 

4.    Click OK. 
          The new group is created. 
5.    Click OK to close the dialog, or select the Permissions and available Instruments for the 

group. 

Deleting a Group 
1.    From the Setup menu, select Administration and then click Setup Users. 

          The Users, Groups, Signatures and Passwords Control dialog is displayed. 

2.    Select the Groups tab. 
3.    Select the Name of the Group you want to delete from the drop-down list. 

4.    Click Delete. 
          A confirmation dialog asks if you are sure that you want to delete the group. 

5.    Click Yes. 

          The group is deleted. 

NOTE: Users that are not a member of a group are not able to access Spectrum FL. If you 
delete a group that has users assigned to it, check that all users are members of 
another group. 

Defining What Members of a Group Can Do 
To define with what members of a group are able to do: 

1.    From the Setup menu, select Administration and then click Setup Users. 

          The Users, Groups, Signatures and Passwords Control dialog is displayed. 
2.    Select the Groups tab. 

3.    Select the Name of the Group you want to modify from the drop-down list. 

4.    Click Show Permissions if the permissions are not displayed. 
          The Permissions area shows the available permissions for the group. 

          A tick indicates that the permission is selected for the group. 
5.    Select or deselect the Permissions for the members of the group. 

          To select all the available permissions, select the Permissions option at the top of the list. 
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          The following table lists the default permissions for the pre-defined groups in Spectrum FL: 

Group Default permissions 
Administrators The permissions of this group cannot be edited, and are 

not listed. 
Only members of the Administrators group are able to 
perform Administration tasks - setup users, groups and 
passwords. 

Users All tasks are enabled except Return Workspace, Review 
and Approve. 

Reviewers Review, Return Workspace, Import Sample Table Setups, 
Export Sample Table Setups, Import Instrument Setup, 
Export Instrument Setup, and Setup Equations only. 

Approvers Approve, Return Workspace, Import Sample Table 
Setups, Export Sample Table Setups, Import Instrument 
Setup, Export Instrument Setup, and Setup Equations 
only. 

6.    Select Show Instruments. 
7.    Select the instrument or instruments that you want the members of the group to be able to 

use. 

        To select all the available instruments, check the Instruments option at the top of the list. 

NOTE: When a new instrument is added to the Spectrum software, it will automatically 
be added to the instruments available for every group. 

8.    Click Apply to apply the settings to the group and keep the dialog open, or OK to apply the 
settings and close the dialog. 

Additional Information 
An Administrator can define a default workspace (software settings, workspace layouts and objects 
such as equations, sample table setups, and instrument setups) for each group. 

Assigning Users to, and Removing Users from, a Group 
If you are an administrator, you can assign a Spectrum FL user to the Administrators group, the 
Users group, or both. You can assign a Spectrum FL Enhanced Security user to the default groups 
Administrators, Users, Approvers and Reviewers, or to any new groups created by an 
administrator. 
To Assign a User to a Group 

1.    From the Setup menu, select Administration and then click Setup Users. 
          The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures 

and Password Control dialog (Spectrum FL ES) is displayed. 

2.    Select the Users tab, and then the user's Name from the drop-down list. 
3.    Select the Group from the list of Available groups for user and then click Add. 

         The Group is added to the User is a member of list, and removed from the Available 
groups for user list. 
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To Remove a User from a Group 
1.    From the Setup menu, select Administration and then click Setup Users. 
        The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures and 

Password Control dialog (Spectrum FL ES) is displayed. 

2.    Select the User tab, then the user's Name from the drop-down list. 

3.    Select the Group from the list of Available groups for user and then click Remove. 
        The Group is removed from the User is a member of list, and added to the Available 

groups for user list. 

Enabling, Disabling, or Deleting a User 

NOTE: These procedures are not applicable when Login Type is set as Windows Login on the 
Password Control tab of the Users and Password Control dialog. In this case, add or 
delete users using Windows User Management. 

To Disable an Existing User 
1.    From the Setup menu, select Administration and then click Setup Users . 
        The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures and 

Password Control dialog (Spectrum FL ES) is displayed. 

2.    Select the Users tab, select the user's Name from the drop-down list, and then click Edit. 

        The Edit User dialog is displayed. 
3.    In the Status area, select Disabled, and then click OK. 
        When this user attempts to login the error message 'Your user name has been locked or 

disabled. Please contact your system administrator' will be displayed. 

NOTE: To enable a previously disabled user, select Enabled on this dialog, and then enter a 
new Password and confirm it. The User must change password at next login selection is 
recommended. 

To Delete a User 
1.    From the Setup menu, select Administration and then click Setup Users. 
        The Users and Passwords Control dialog (Spectrum) or the Users, Groups, Signatures and 

Password Control dialog (Spectrum FL ES) is displayed. 

2.    Select the Users tab, select the user's Name from the drop-down list, and then click 
Delete. 

        A User Administration message will be displayed asking you to confirm that you wish to 
delete the user. 

3.    Click Yes. 

        The user is deleted. 

NOTE: It is not possible to re-use a User name that has been deleted. 
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NOTE: It is not possible to delete the Administrator from the Administrators group. 

The workspace of a deleted user remains on the computer unless deleted manually using Windows 
Explorer. You may need to use the Windows Control Panel to select Show hidden files and 
folders before you are able to view the workspace files. 

Signatures (Spectrum FL Enhanced Security Only) 
Signatures are only available in Spectrum FL ES. An electronic signature as defined by 21 CFR Part 
11 means a computer data compilation of any symbol or series of symbols executed, adopted, or 
authorized by an individual to be the legally binding equivalent of the individual's handwritten 
signature. 
In Spectrum FL ES software, all operations that cause data to be collected, administer security or 
cause spectra and results data to be saved have an associated Signature Point that requires a 
signature. The list of Signature Points within the software is pre-defined, and includes: 

•       Loading and saving instrument settings files. 

•       Reporting on ready checks and instrument validation. 

•       Generating reports. 

•       Exporting data. 

•       Deleting graphs. 

•       Creating or making changes to equations. 

•       Approving and reviewing items that have been signed by other users. 

When a Signature Point occurs in the software, a dialog will appear prompting you to enter your 
User name and Password, and then select a pre-defined Reason from the drop-down list, if 
required. In the Comments section you can add any additional information. 
Members of the Administrators group are able to define whether a signature and comment is 
required for each Signature Point individually, or apply the same settings to all Signature Points. In 
addition, for each Signature Point they can define the list of Reasons. 

NOTE: If Signature required is not selected for a signature point, you will not be prompted for 
a signature. However, if any Reasons have been set up for the signature point, you will 
still be prompted to select one. 

For some signature points, a signature can be added on demand. 

Defining the Settings for a Signature Point 
1.    From the Setup menu, select Administration and then click Setup Users. 

          The Users, Groups, Signatures and Passwords Control dialog is displayed. 

2.    Select the Signatures tab. 
3.    Select the Signature Point Name from the drop-down list of available signature points. 

          The following signature points are available in Spectrum: 
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Signature 
Point 

Description 

Approve Occurs on demand. See Reviewing and Approving for more information. 

Data Occurs when data is added to the database, for example, when opening a 
spectrum that was collected on another system. 

Data Export 
Collection 

Occurs when data is exported immediately after data collection. See Setup 
Instrument - Data Collection. 

Delete Graph Occurs when a user deletes a spectrum or Samples View from the Data 
Explorer. The spectra are added to the Recycle Bin. 

Equation Occurs on demand, accessed via the Setup Equations tab. 
If you attempt to export an unsigned equation, you will be prompted for a 
signature first. If you import an equation, you will be prompted for a 
signature first. 
If you exit Spectrum and have unsigned Equations, the Equation will be 
signed for when you sign the workspace. 

Instrument 
Validation 

Occurs immediately after selecting to run a Instrument Validation. 

Output Signature is demanded just before the output of data. 
This is before saving, printing or exporting data, and includes saving a 
report using the Report command on the File menu. 

Raman 
Instrument 
Setup 

Occurs on demand, accessed via the Instrument Settings dialog, or when 
you exit Spectrum FL software. 
If you attempt to export an unsigned instrument setup, you will be 
prompted for a signature first. If you import an instrument setup, you will 
be prompted for a signature first. 
See Load and Save for more information. 

Ready Check Occurs immediately after selecting to run a Ready Check. 

Return Occurs on demand. See Reviewing and Approving for more information. 

Review Occurs on demand. See Reviewing and Approving for more information. 

Sample Table 
Setup 

Occurs on demand, or when you exit Spectrum software. 
If you attempt to export an unsigned sample table setup, you will be 
prompted for a signature first. If you import a sample table setup, you will 
be prompted for a signature first. 
See Sample Table Setups for more information. 

Workspace Occurs on demand, or when you exit Spectrum software. The signature 
applies to the whole workspace, and covers all currently unsigned 
activities logged for the user. 
See Signing for more information. 

4.    If a Signature is required for a Signature Point, select Signature required. 

5.    If you wish the user to be able to add comments, if required, select Prompt for 
comments. 

        When the Signature Point dialog is displayed in the software, the user will be prompted to 
select a reason. The list of reasons is also defined on this tab. 
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6.    To add a new reason, click New and enter the new Reason in the New Reason dialog. 

         The reason is added to the list of reasons for the Signature Point. 
          OR 

          To delete a reason, select the Reason from the Reasons list and click Delete. 

          You will be asked to confirm that you want to delete the reason. Click Yes. 
          The Reason is deleted from the Text field. The changes are recorded in the Audit Trail. 

          OR 
        To edit a reason, select the Reason from the Reasons list, click Edit and modify the text in 

the Edit Reason dialog. 
        The Edit Reason dialog closes and the updated reason appears in the Text field. The 

changes are recorded in the Audit Trail. 

7.    Repeat as many times as necessary to add reasons for the Signature Point. 
8.    When you have finished adding reasons for the Signature Point, reorder the reasons, if 

required. 
        Items will appear in the Reason drop-down list in the order they are listed on the Signatures 

tab. 

a. Select the Reason that you wish to move the position of. 
b. Use the arrow keys on the right hand side of the list to move the Reason up or 

down as required. 
9.    Repeat steps 3 to 8 for each Signature Point Name. 

Defining the Same Settings for all Signature Points 

1.    To define the same settings for all Signature Points, click Update All. 

        The Update All Signature Points dialog is displayed. 
2.    In the Require Signature section, select either All Points require a signature, No Points 

require a signature, or Do not change the current settings. 
        If Do not change the current settings is selected, no change will be made to the 

Require Signature settings. 

3.    In the Prompt for comments, select either All Points require a prompt, No Points 
require a prompt, or Do not change the current settings. 

        If Do not change the current settings is selected, no change will be made to the 
Prompt for Comments settings. 

4.    Click OK. 

        The Update All Signatures dialog closes and the Signature Points dialog is re-displayed. 

Passwords 
Passwords 

During Login, users can be required to enter their User name and Password, or simply their User 
name. A password is not mandatory in Spectrum FL, but is mandatory in Spectrum FL ES. 

1.    From the Setup menu, select Administration and then click Setup Users. 
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        The Users and Passwords Control dialog (Spectrum) or the Users, Groups, Signatures and 
Password Control dialog (Spectrum FL ES) is displayed. 

2.    Select the Password Control tab. 
3.    In the Login Type section, select: 

a. PerkinElmer Login, which requires the user to enter a User Name and Password. 
b. No Passwords Login, which requires the user to select their User Name from a 

drop-down list containing all Spectrum users (Spectrum FL Standard only). 
c. Windows Login, which requires that the PKIUsers group created during the 

installation of Spectrum has been populated by a Windows Administrator. 

See Windows Login. 

NOTE: The No Passwords Login setting alters the behavior of the Login dialog. When selected, 
the user can select their user name from a drop-down list. When de-selected, the user 
must enter their user name manually because, for security reasons, a drop-down list is 
not available. 

Changing or Setting a Password 

NOTE: This procedure is applicable only when Login Type is set as PerkinElmer Login on the 
Password Control tab of the Users and Password Control dialog. When Login Type is set 
as Windows Login, change passwords using Windows User Management. 

Changing your Password 
You must change your password when prompted during login. This prompt occurs when an 
administrator mandates User must change password at next login, or when your password has 
expired. 
You can also change your password during login, subject to the Minimum password age set for all 
users by an administrator. 

1.    At login, enter a valid User name and Password, and then click Change Password. 
         The Change Password dialog opens. 

2.    Enter a New password, enter it again in the Confirm password field, and then click OK. 
3.    To complete the login, click OK. 

NOTE: You can always change your password when prompted during login. However, you 
cannot then change your password before the Minimum password age set by an 
administrator for all users has expired. In Spectrum FL, the Minimum password age: 
Allow changes after (days) is set to 1, so if you attempt to change your password, the 
following message is displayed: 'You have changed your password less than 1 days ago. 
You cannot change your password again.'  
To allow passwords to be changed within the first day, an administrator must set 
Minimum password age: Allow Changes Immediately. 

To Set a new Password (Administrator only) 
An administrator can set a new password for a user unable to login because their password is lost 
or forgotten: 

1.    From the Setup menu, select Administration and then click Setup Users. 
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The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures 
and Password Control dialog (Spectrum FL ES) is displayed. 

2.    On the Users tab, select the user from the Name drop-down list, then click Edit. 

          The Edit User dialog is displayed. 
3.    Enter a new Password and then enter the password again in the Confirm password 

entry field. 

NOTE: Passwords are case sensitive, and can consist of letters, numbers and single 
spaces only. 

4.    Select Enabled if you wish the user to be able to login straightaway, or Disabled if you 
wish to enable the login later. 

5.    If Enabled is selected, select whether the User must change password at next login. 

6.    Click OK. 
          The new password is implemented. 

Maximum and Minimum Password Age 

NOTE: These topics are only applicable when Login Type is set as PerkinElmer Login on the 
Password Control tab of the Users and Password Control dialog. When Login Type is set 
as Windows Login, administer passwords using Windows User Management. 

 

NOTE: The settings on the Password Control tab apply to all users. It is not possible to define 
individual Password Controls for each user. 

Maximum Password Age 
On the Password Control tab, Maximum password age defines the maximum number of days that 
users can retain the same password before they must change it. By default the password expires 
after 42 days. The minimum is 1 day and the maximum is 999 days. 
The Maximum password age cannot be set less than or equal to the Minimum password age. 

NOTE: If you want to set the Maximum password age to 1 day the Minimum password age 
must be set to Allow changes immediately. 

If it is not necessary for users to change their password, select Password never expires. 

Minimum Password Age 
On the Password Control tab, Minimum password age defines the number of days that users must 
retain the same password before being allowed to change it. The default setting for Allow 
changes after (days) is 1. Setting Allow changes after (days) prevents users from changing their 
password several times in a short space of time in order to return to a previous password. 

To allow users to change their password immediately, select Allow changes immediately. 
The Minimum password age cannot be set greater than or equal to the Maximum password age. 
The minimum is 1 day and the maximum is 999 days. 

NOTE: If you want to set the Maximum password age to 1 day the Minimum password age 
must be set to Allow changes immediately. 
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Password Length 

NOTE: These topics are only applicable when Login Type is set as PerkinElmer Login on the 
Password Control tab of the Users and Password Control dialog. When Login Type is set 
as Windows Login, administer passwords using Windows User Management. 

Minimum password length on the Password Control tab defines the minimum number of characters 
that must be used in the password. By default, the At least (characters) setting is 6. The 
minimum setting is 1 character, and the maximum is 16 characters. 
Allow blank password (Spectrum FL only) means that users who have never logged in before 
(or who opted not to enter a password when they last changed their password) are not required to 
enter a password at login. In Spectrum FL ES, Allow blank password is not available as entering a 
password is mandatory. 

NOTE: If a blank password expires (the Maximum password age setting is not Password never 
expires), a second blank password cannot be used immediately unless the Password 
uniqueness setting is Do not keep a password History. 

Re-Using Passwords 

NOTE: These topics are only applicable when Login Type is set as PerkinElmer Login on the 
Password Control tab of the Users and Password Control dialog. When Login Type is set 
as Windows Login, administer passwords using Windows User Management. 

Password Uniqueness 
Password uniqueness on the Password Control tab defines the number of new passwords that must be 
used before a previous password can be reused. For example, if the first password is 'spectrumid', and 
Number of passwords to remember is set to 24 (the default setting), a user must use 24 other passwords 
(in addition to their current password) before being able to use 'spectrumid' again. 

The minimum Number of passwords to remember is 1 and the maximum is 24. 
An additional Password uniqueness setting is Do not keep a password history, where no record of 
previous passwords is kept. 

Password Records 
By default, a record of previous passwords is made automatically. 

Changes to passwords are logged. However the actual passwords are not visible; the word Hidden 
is displayed instead. 
Select Do not keep password history (Spectrum FL only) if you do not wish to retain a record 
of the number of previous passwords. 

Password Lockout 

NOTE: These topics are only applicable when Login Type is set as PerkinElmer Login on 
Password Control tab of the Users and Password Control dialog. When Login Type is set 
as Windows Login, administer passwords using Windows User Management. 
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Limiting failed Login attempts using Lockout 

This procedures enables you to lock out a user that persistently fails to log in correctly. 
1.    From the Setup menu, select Administration and then click Setup Users. 

        The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures and 
Password Control dialog (Spectrum FL ES) is displayed. 

2.    Select the Password Control tab. 

3.    Click Account Lockout. 
        The Account Lockout dialog is displayed. 

4.    Enter the Number of failed logins allowed before lockout. 
        For example, if Number of failed logins allowed before lockout is set to 5 (the default value), 

the user is locked out on their fifth failed attempt until an administrator allows them access 
again (Permanent) or for a specified period of time (Duration). 

        The minimum number of failed login attempts before a user is locked out is 1. The 
maximum number of allowed failed login attempts before a user is locked out is 10. 

NOTE: If Number of failed logins allowed before lockout is 1, then the user is locked out 
after their first incorrect login attempt. That is, an incorrect login attempt is not 
allowed; the user must login successfully at their first attempt or be locked out. 

5.    Select the Lockout Duration as Permanent, until administrator unlocks, or Duration 
(minutes). If you select Duration, enter the time (in minutes) for the lockout. 

        Permanent means that the user will be unable to login again until an administrator has 
assigned a new password. Duration is grayed if Permanent is selected. 

        Duration prevents the user being able to login again until the time specified has elapsed. If 
Duration is selected, the default is 60 minutes. The minimum Duration is 1 minute and the 
maximum Duration is 32767 minutes (22.75 days). 

NOTE: Details of failed login attempts are recorded in the Login History. 

Reinstating Locked Out Users 
If Account Lockout is set to Permanent until Administrator unlocks and the user has failed to login 
correctly within the allowed number of attempts, an administrator must assign a new password 
before the user is able to login again. 
If one or more users a has been locked out, when an administrator next logs in a list of Locked Out 
Users is displayed. 

1.    Highlight the name of the user that you wish to reinstate and then click Edit. 

          The Edit User dialog is displayed. 

NOTE: If you click OK (rather than Edit) when the list of Locked Out Users is 
displayed, the list is closed. Any locked out users will remain locked out. The 
list will be re-displayed each time you log in until all locked out users have 
been assigned a new password. 

2.    Enter a new Password and repeat it in the Confirm password field. 
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3.    Click OK. 
        The user is removed from the list of Locked Out Users. 

4.    Click OK to close the Locked Out Users dialog. 
        The previously locked out user will now be able to log in using the new password. 

        You can mandate a password change by selecting User must change password at next login. 

NOTE: In Spectrum FL ES User must change password at next login is mandatory. 

Users locked out for a specified duration can be unlocked by the administrator in the same 
manner. 

W indows Login 
It is possible for users to log in to Spectrum FL using their Windows  User name and Password 
(instead of having a separate Spectrum FL User name and Password). 
It is not possible to have some users that log in using their Windows User Name and Password 
while others use a separate Spectrum login. 

NOTE: Being logged in as a Windows administrator gives full read/write permissions to the 
system. To avoid negating the 21 CFR Part 11 compliance, end users (that is, individuals 
using Spectrum FL ES software and instruments to collect data), should run as Windows 
Users, never as Windows administrators. 

Adding Windows users to the PKIUsers group on a local PC: 

To facilitate the use of Windows User names and Passwords, the PKIUsers group is created on the 
local PC during the installation of Spectrum FL. When Spectrum FL is installed and run on a local 
PC, the Windows administrator should add all the users who will access Spectrum to the PKIUsers 
group. 

NOTE: When Spectrum FL is used across a network, the Windows administrator should create 
a network group on an accessible domain and then add users to that group. 

1.    Install Spectrum FL. 
2.    From the Windows Start menu navigate to Control Panel. 

3.    Select Administrative Tools and then Computer Management. 
          The Computer Management dialog is displayed. 

4.    Select Local Users and Groups. 
5.    Select the Groups folder to see the list of available Groups on the PC, and then double-click 

PKIUsers. 
          The PKIUsers Properties dialog is displayed. The Members list already contains Everyone. 

This group has been created for folder access only, not as a Windows user group as it 
contains no user members. 

6.    To add a user member to the Group, click Add. 
          The Select Users, Computers, or Groups dialog is displayed. 
7.    To select a user from a different location (domain), click Locations and then select the 

required location for the user you wish to add. 
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8.    To add a user to the group, enter the name of the user in the Enter the object name to 
select field and then click Check Names. 

          Clicking Check Names will validate the name on the specified domain. 

NOTE: If you are not logged into this domain already, a login dialog will be displayed. 

9.    Click OK. 
          The Select Users, Computers, or Groups dialog is closed and the user is added as a 

member to the PKIUsers Properties dialog. 
10.  To add more users, repeat steps 6 to 9. 

NOTE: It is possible to add a user more than once if they are on more than one domain as 
each Location together with the User name and Password will be unique. 

All users added to the PKIUsers Group on the local PC, or added to a network users group, will be 
able to log in to Spectrum once a Spectrum administrator has defined the Login Type as Windows 
Login. 

NOTE: Any users added to the PKIUsers Group before logging into Spectrum FL for the first 
time will appear in the Name drop-down list on the Users tab of the Users and 
Passwords Control dialog. If users are added subsequently, click Update users on the 
Users tab to refresh the Name drop-down list. 

Defining the Spectrum FL Login Type as Windows Login 

The Login Type (Windows Login, PerkinElmer Login or No Passwords Login) applies to all users. It 
is not possible to have some users that log in using their Windows Login while others use a 
separate Spectrum login. 

1.    Start Spectrum FL and log in as an administrator. 

2.    From the Setup menu, select Administration and then click Setup Users. 
        The Users and Passwords Control dialog (Spectrum FL) or the Users, Groups, Signatures and 

Password Control dialog (Spectrum FL ES) is displayed. 

3.    Select the Password Control tab. 
4.    From the Login Type drop-down list select Windows Login. 

        All the other information previously displayed on the tab is removed as the password 
controls are now from Windows rather than Spectrum FL. 

        The Load Windows Users dialog is displayed. 
5.    Select the Domain and specify the Group of Windows users that you wish to add to the 

list of Spectrum FL users. 

          The default selection is the PKIUsers group on the local PC. 

6.    Click OK. 
        The Windows users will be loaded and you may be prompted to select a new Spectrum FL 

administrator. 
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NOTE: If users are subsequently added to the PKIUsers group, to add these new Windows 
users to the list of Spectrum FL users a Spectrum FL administrator must click Update 
users on the User tab of the Users and Passwords Control dialog (Spectrum FL) or 
Users, Groups, Signatures and Passwords Control dialog (Spectrum FL ES). 

To assign users Spectrum FL group memberships, see Assigning a User to a Group. 
If a user is not added to at least one group, an error message will be displayed when they try to 
log in informing them that they do not have access to the application. 

Logging in to Spectrum FL using a Windows Login 

If you have been set up to log in to Spectrum FL using your Windows login: 

1.    Start Spectrum FL. 
          (Select Start, PerkinElmer Applications, Fluorescence). 

2.    Enter your Windows User name and Password. 

3.    If the Log on to field is not displayed, click Options. 
4.    Select the required Domain from the Log on to drop-down list. 

          By default, the Domain last logged on to is displayed. 

NOTE: If all users are on the same Domain, there is no need to show the Log on to field as the 
correct Domain will be listed. To avoid confusion, this field can be hidden by clicking 
Options<<. 

Troubleshooting Windows Login 

If you cannot login to Spectrum FL using your Windows Login, check that: 
•       Your Windows administrator has added your name to the PKIUsers Group. 

•       You have been assigned to at least one Group within Spectrum FL. 

•       You have entered the correct User Name and Password, and selected the correct Domain 
option from the Log on to drop-down list. 

•       PE21CFR is running. From the Start menu navigate to Control Panel, and then select 
Administrative Tools. Then select Services. In the Services dialog check that PE21CFR is still 
running. If this has been paused or stopped you will be unable to login to Spectrum. 

Password expiry 

If whilst logging into Spectrum FL you get a message that your password is about to expire, you 
can change your password. This change applies to Windows as well as Spectrum FL. 

Removing a User from the PKIUsers group in Windows: 

1.    From the Windows Start menu navigate to Control Panel. 
2.    Select Administrative Tools and then Computer Management. 

        The Computer Management dialog is displayed. 

3.    Double-click Local Users and Groups. 
4.    Double-click the Groups folder. 

        The list of available Groups on the PC is displayed. 
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5.    Double-click PKIUsers. 

        The PKIUsers Properties dialog is displayed. 
6.    Select the appropriate user and then click Remove. 

        The user is removed from the PKIUsers group. 

Users Audit Trail (ES only) 
Users Audit Trail (Spectrum Enhanced Security Only) 

NOTE: The Users Audit Trail is available in Spectrum ES only. It can be viewed by members of 
the Administrators group only. 

The Users Audit Trail records all changes to security settings in compliance with 21 CFR Part 11. All 
changes to users, groups and password settings are recorded. It also records when the Login 
History or Audit Trail have been exported and cleared. 

1.    Select Users Audit Trail from the Administration sub-menu of the Setup menu. 
        The Login History, Audit Trail and Summary dialog is displayed. 

2.    Select the Audit Trail tab. 
        The Audit Trail is displayed. For each change recorded, the following information is given in 

the Audit Trail:   

–      Function – the item that was changed, for example, Add New User. 
–      Previous Value – the state of the item before it was changed. 

Numbers refer to permissions or instruments; see Summary. 
–      Current Value – the new state. 

Numbers refer to permissions or instruments; see Summary. 

–      Full Name – the full name of the user who made the change. 
–      User Name – the login user name of the user who made the change. 

–      Computer – the name of the computer from which the change was made. 

–      Date Modified – the date and time of the change. 

Printing the Audit Trail 

➤     To print the Audit Trail click Print. 
          All the information currently held in the Audit Trail is printed to the default printer. 

Exporting the Audit Trail 

1.    To export the Audit Trail click Export. 

          A Save As dialog is displayed. 
2.    Select the required destination and enter a filename. 
          The Audit Trail is exported as a *.csv file that can be opened, for example, in Microsoft 

Excel. 
Exporting the Audit Trail does not clear the Audit Trail entries from the dialog. However, you must 
export Audit Trail entries before they can be cleared. 
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Clearing the Audit Trail 

➤     To clear the Audit Trail click Clear Audit. 
          You will be asked to confirm that you want to delete the Audit Trail log. All details are 

removed. 

NOTE: It is only possible to clear Audit Trail entries that have previously been exported. If the 
Audit Trail contains additional entries since it was last exported, only those entries that 
have been exported will be deleted. If none of the entries have been exported, a 
warning message will be displayed when you attempt to clear the Audit Trail. 

Additional Information 

The Users Audit Trail is saved to the Security database, Users.mdb. 

Login History (Spectrum FL Enhanced Security Only) 

NOTE: The Users Audit Trail is available in Spectrum FL ES only. It can be viewed by members 
of the Administrators group only. 

1.    Select Users Audit Trail from the Administration sub-menu of the Setup menu. 
          The Login History, Audit Trail and Summary dialog is displayed. 

2.    Select the Login History tab. 
        The login history is displayed. This details every login attempt, since the history was last 

cleared, by: 
–      Full Name – the full name of the user, or Not Found if the User Name entered did not 

exist. 

–      User Name – the user name entered, whether correct or not. 
–      Computer – the name of the computer 

–      Status – OK indicates that the user logged in with the correct password; Failed 
indicates that a login was attempted with an incorrect password or User Name. 

–      Logged In – date and time. 

–      Logged Out – date and time. 

Printing the Login History 

➤     To print the Login History click Print. 

All the information currently held in the Login History is printed to the default printer. 

Exporting the Login History 

1.    To export the Login History click Export. 

          A Save As dialog is displayed. 
2.    Select the required destination and enter a filename. 

          The Login History is exported as a *.csv file and can be opened, for example, in Microsoft 
Excel. 
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NOTE: Exporting the Login History does not clear the Login History details from the 
dialog. However, you must export Login History entries before they can be 
cleared. See Clearing the Login History. 

Clearing the Login History 

 To clear the Login History, click Clear History. 
        You will be asked to confirm that you want to delete the Login History log. All Login details 

are removed. The first Login details to appear after the Login has been cleared will be the 
date and time that you log out. 

NOTE: It is only possible to clear Login History entries that have previously been 
exported. If the Login History contains additional entries since it was last 
exported, only those entries that have been exported will be deleted. If none of 
the entries have been exported, a warning message will be displayed when you 
attempt to clear the Login History. 

The only limit to the size of the Login History is disk space, but we recommend that you review and 
archive it at regular intervals. 

Summary (Spectrum FL Enhanced Security Only) 

NOTE: The Users Audit Trail is available in Spectrum FL ES only. It can be viewed by members 
of the Administrators group only. 

The document created by this command records a summary of the security status of the 
application. 

1.    Select Setup Users Audit Trail from the Administration sub-menu of the Setup menu. 

          The Login History, Audit Trail and Summary dialog is displayed. 

2.    Select the Summary tab. 
          The Summary records all information about the security settings: 

–      Application – records the application for which this Summary applies. 
–      Password control – records the Login type, Windows group, Maximum password age, 

Minimum password age, Minimum password length, Password uniqueness, Lockout count 
and Lockout duration settings. 

–      Permissions – records the number of permissions, then lists each permission with a 
number that is used to identify the permission on the Users Audit Trail. 

–      Instruments – records the number of instruments attached to the application. Each 
instrument is then listed with a number that is used to identify the instrument on the 
Users Audit Trail. 

–      Users – records the number of users. It then records each User name, Full name, 
Status, Last Login, the Groups the user belongs to, the Permissions of that group and 
the Instruments the user has permission to use. 

–      Groups – records the number of groups. For each Group it records the Group Name, 
the Users in the Group, the Permissions of that group and the Instruments the group has 
permission to use. 
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Printing the Summary 

 To print the Summary click Print. 

     All the information is printed. 

Exporting the Summary 

1.    To export the Summary click Export. 

          A Save As dialog is displayed. 
2.    Select the required destination and enter a filename. 

3.    Select to save the Summary as a *csv or as a *.txt file. 
4.    Click Save. 
          The summary is exported as a *.csv file or *.txt file that can be opened, for example, in 

Microsoft Excel. 

Assigning a New  Group Workspace (Spectrum FL Enhanced 
Security Only) 
A new workspace is created each time a user logs in to Spectrum FL (unless the user previously 
selected to reload their last workspace). By default, the new workspace is based on the software 
default workspace. However, members of the Administrators group in Spectrum FL can assign their 
current workspace as the default for a group. 

Features that can be assigned to a group workspace include: 

•         Custom toolbars, reflecting the tasks frequently performed by a group of users 

•         Instrument Setups 

•         Sample Table Setups 

•         Equations 

•         Software settings, such as Instrument settings. 

No spectra or data will be included in the default workspace. 

Assigning the current workspace to ex isting groups 
Before the workspace can be assigned as the default for a group, a user with the appropriate 
permissions should define the workspace, including toolbar layouts, Instrument Setups, Sample 
Table Setups, and Equations. 

To set the current workspace as the default for a group: 

1.    Log in to Spectrum as an administrator. 
2.    Set up the workspace you want to assign to a group or groups. 

          Refer to Loading a Workspace to load an existing workspace. 
3.    From the Setup menu, select Administration and then Set Group Workspace. 

          The Set Group Default Workspace dialog is displayed. The dialog lists all the groups in 
Spectrum. 

4.    Select the Include check box for the group(s) you want to assign the workspace to. 

5.    Click OK. 
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          The Sign Workspace dialog is displayed. The upper part of the dialog shows the Audit Trail. 
The lower part, if displayed, shows the signatures in the current workspace. To display the 
Signature Details list, ensure that Show signature details is selected. 

6.    To sign the workspace, click Sign. 

          The Sign dialog is displayed. 
7.    Enter your User name and Password. 

8.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Workspace signature point. 

9.    Enter any Comment required. 

10.  Click OK. 
          The current workspace is saved as the new default workspace for the group(s) selected. 

The next time a new workspace is created on login by a member of that group, the new 
default will be used, unless that user is a member of more than one group. It will also be 
used if Restore Default Workspace is selected. 

          If a user is a member of more than one group and one or more of those workspaces is 
modified, then the Choose Group Default Workspace dialog will prompt the user to select 
which group default to use to create a new workspace. This may be displayed when the 
user exits Spectrum and selects Don't load spectra next time, or when the user logs in 
to Spectrum. 

Additional Information 

User-defined objects 

When a new group workspace is loaded, any user-defined objects such as  Equations, Sample 
Table Setups and Instrument Setups are removed and replaced by the objects in the group 
workspace. 

Common (Global) objects 

When a new group workspace is loaded, any objects such as Equations, Sample Table Setups and 
Instrument Setups in the group workspace are loaded. Any objects in the appropriate common 
directory (defined during Spectrum installation) are also loaded. If any objects in the common 
directory have the same file name as an object in the workspace, then they are automatically 
renamed. 
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Instruments 
The Instruments sub menu of the Setup menu enables you to: 

•       Select an instrument from the list of available instruments, or Work Offline. 

•       Auto-Connect to a particular instrument. 

Provided you are logged into Spectrum FL as an administrator, you can also: 

•       Add an instrument to the list of instruments available to Spectrum FL. 

•       Remove an instrument from the list of available instruments. 

Add Instrument 
Use the Add Instrument command to install an instrument and make it available to Spectrum FL. 
You cannot add or remove an instrument unless you are logged into Spectrum FL as an 
administrator. 
To add an instrument: 

1.    Select Instruments from the Setup menu, and then click Add Instrument. 

        The Add Instrument dialog is displayed. 
2.    Insert the Configuration Files CD that was shipped with the instrument.  

3.    Select the Port Number from the drop-down list or click Use Default Port. 
4.    Select the Configuration File by clicking the Select button. 

The Browse For Folder dialog appears. 

5.   Browse to the appropriate disk drive, highlight the configuration file and then click Open. 
  6.  Click OK. 

Remove Instrument 
Use the Remove Instrument command to delete an instrument from the list of instruments 
available to Spectrum FL and to any other applicable PerkinElmer applications installed on this PC. 
You cannot add or remove an instrument unless you are logged into Spectrum FL as an 
administrator. 

1.    Select Instruments from the Setup menu, and then click Remove Instrument. 
        The Remove Instrument dialog is displayed. 

2.    Select the name of the instrument you want to remove from the drop-down list. 

3.    Click OK. 
        A warning page is displayed. An additional warning is displayed if you select the instrument 

that is currently connected. 
4.    If you are certain that you want to delete this instrument from your system, click Remove. 

          The instrument name is deleted from the list of instruments available. 

          OR 
          Click Cancel to exit close the Remove Instrument dialog. 
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Additional Information 
It is not necessary to remove an instrument to select another instrument, or to disconnect the 
current instrument and work offline; use the Select Instrument command. 

Select Instrument 
Use the Select Instrument command to connect to an instrument if you are working offline, to free 
the current instrument and connect to another instrument, or to free the current instrument and 
work offline. 

1.    Select Instruments from the Setup menu, and then click Select Instrument. 
          The Select Instrument dialog is displayed. 
2.    Select the name of the instrument you want to connect to from the drop-down list, and click 

Connect. 
          If the instrument is not available (disconnected, or in use by another user) a warning is 

displayed. 

          OR 

          Click work offline. 

Additional Information 

Always connect to this instrument 

This option enables you to select this instrument connection as your Spectrum FL log in default. 
When selected, the Auto-Connect option in the Setup menu is enabled. 

Managing the List of Available Instruments 

If the instrument you want to connect to is not in the drop-down list of available instruments; see 
Add Instrument. 
If the drop-down list of available instruments contains superfluous instrument connections; see 
Remove Instrument. If you have other PerkinElmer software installed on your PC, remember that 
the instrument connection is removed from your system, not just the Spectrum FL software. 

Auto-Connect 
Use the auto-connect option to connect to a particular instrument automatically during log in, and 
skip the instrument connection dialog. 
There are several ways to enable auto-connection to the instrument that is currently connected: 
 Select the Always connect to this instrument check box in the Instrument Connection 

dialog during log in. 

          This dialog will not be displayed if auto-connect is already enabled. 

          OR 
         Select the Always connect to this instrument check box in the Select Instrument dialog. 

          OR 
        Select the Enable Auto-Connect command from the Instruments sub menu of the Setup 

menu. 
        When enabled, the auto-connect icon to the left of the command is highlighted in orange. 
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Export and Email 

Setup Export and Email 
Use the Setup Export and Setup Email tabs to set up the export of your spectra to a specified 
folder as data files that are accessible to other applications, using the Export command, or to set 
up the server and user information to enable you to send your data by email using the Send To 
Email command. 

1.    Select Export and Email from the Setup menu. 
          OR 

          Select  in the Setup section of the Navigation Pane. 
          The Setup Export and Email tabs are displayed in the Dialog Pane. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 

2.    Select the Setup Export tab, or the Setup Email tab. 

Setup Export 
Use the Export command to save your spectra to a specified folder as data files that are accessible 
to other applications. 

1.    Select Preferences from Options menu in the Navigation Pane. 
        The Export and Email tabs are displayed in the left column. 
2.    Select the Export tab. 

Header Options 
Check the Header options to include spectral header information in the exported file. Then select 
which information to include from General and Custom Fields, Instrument Settings, and 
History Records. This information is the same as that displayed in the four sections of the History 
tab. 

File Options 
File Extension Defines the file extension applied to exported data. The 

options are: CSV, DAT, TXT or XY. 
File Encoding Defines the file encoding used. The options are: Default, 

UTF8 or US ASCII. 
List Separator Defines the list separator used. The options are: Comma 

(“,”), Semi Colon (“;”), Equals (“=”), TAB or SPACE. 
Decimal Separator Defines the decimal separator used for the data. The 

options are: Point (“.”) or Comma (“,”). 

Data Options 
Decimal Places X Defines the number of decimal places for the X axis. The 

options are: As in data set, 1 or 2. 
Decimal Places Y Defines the number of decimal places for the Y axis. The 

options are: As in data set, 1, 2, 3, 4, 5, or 6. 
Sort data decending Check the box to sort the data in descending order (of the 

X axis values). 
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Additional Information 
To export your data using these settings, select Export from the File menu, and choose the 
Custom Defined File format. 

Setup Email 
Use the setup Email tab to set up the email account that will be used in the Send To Email 
command. This must be set up for the Send To Email option to become available. 

1.    Select Preference from Options menu in the Navigation Pane. 
          The Export and Email tabs are displayed in the left column. 
2.    Select the Email tab. 

Server Information 
1.    Enter the Outgoing mail server (SMTP). 

        Type the complete name of the server provided by your internet service provider (ISP) or 
mail administrator. In Microsoft Outlook this is the name of your Microsoft Exchange Server, 
which you can find in your account settings. Often the server name is smtp. followed by 
your domain name, for example, smtp.example.com. If you use a web-based mail 
application, you can usually accesses the server information via the application Help. 

          Simple mail transfer protocol (SMTP) is the standard for sending email messages across 
networks. 

2.    Select Use Default Credentials. 

          OR 
          Select Enable SSL. 
        Choose this option if your mail administrator tells you to use a Secure Sockets Layer (SSL) 

connection. 

3.    Select either HTML Body or Plain Text for the mail output format. 

        If you select HTML Body, the message can contain formatting such as bold text or bullets. 

NOTE: For the email recipient to see these features, the recipients email application 
must support formatted messages. 

          Plain Text does not support text formatting or image display in the message body. 

User Information 
Enter the Email Address you want to use to send emails from. If you selected Enable SSL rather 
the Use Default Credentials in Server Information, you will need to enter the User Name and 
Password that you use currently for that email account and then confirm the password. 

Test Settings 
Click Test Settings to check that your settings have been entered correctly. A message will be 
displayed in the Status bar to indicate that Spectrum is sending a test email, and then whether or 
not the test was successful. If the test is successful you will receive an email with the subject 
Spectrum Software Setup Email - Test Confirmation and the following message: 

This email has been sent to confirm that the Setup Email configuration in Spectrum software 
has been setup correctly. 
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If you selected Enable SSL and your email Server does not support secure settings (SSL) the test 
email will not be sent and a warning message will be displayed. 

Additional Information 
To email your data using these settings, select Send To from the File menu, and then select Email. 

We recommend that you contact your organization's mail administrator if you are unclear about 
which settings to choose. 
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Setup Peak Detection 
Use the Setup Peak Detection tab to edit the criteria used for peak detection and marking using the 
Peak Labels command. 

➤     Select Peak Detection   in the Data Analysis section of the Navigation Pane. 
          The Setup Peak Detection tab is displayed in the Dialog Pane. 

NOTE: To see the tab, you may have to resize the Dialog Pane. 

Algorithm 
By default, the peak positions are found using an Interpolated peak algorithm, which derives 
peak position from maximum intensities. Alternatively, you can select the Center of gravity 
algorithm, as used by NIST, which derives peak position from the shape of the peak. 

Thresholds 
The Thresholds section enables you to choose the thresholds used when detecting peak maxima or 
base points. The threshold used for the Interpolated Peak algorithm is %T (or %R); A (or Log 
1/R); and A.U. (for any other units), depending on the type of spectrum examined. 
The Center of gravity peak height threshold, which is only available when the Center of gravity 
algorithm is selected, enables you to set how much of a peak is used when calculating its center of 
gravity. Where peaks are well defined a value of 0.8 could be appropriate. However, where two 
poorly-defined peaks overlap to produce a shoulder, and the Center of gravity peak height 
threshold is set to include the overlap, the Center of gravity algorithm calculates a peak position 
shifted towards the shoulder unless this value is 0.2 or less. 

Click Reset to return to the default threshold values: 2.00%T; 0.0088 A; 10.00 A.U.; 0.20 Pk Ht. 

Labeling 
The Labeling section enables you to set whether to label All peaks found or only a set number of 
the most intense peaks. 
You can also select to mark the position of the Peak maxima and/or the peak Base points. For 
each position marked you can optionally include a text label with the X Position and/or the Y 
Value. 

Refresh 
Click Refresh to update any peak labels that are currently displayed after modifying any of the 
settings. 
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View  

Setup View  
Use the Setup View tabs to select the default graph appearance properties that will be applied to 
all new graphs and to apply them to existing graphs. 

1.    Select View  from the Options menu in the Navigation Pane. 

          The Setup View tabs are displayed on the left. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 

2.    Select the Setup View Axes tab, the Setup View Appearance tab or the Setup View 
Advanced tab. 

Additional Information 
The Setup View tabs define the graph appearance properties that will be applied to new graphs. To 
apply display options to the currently displayed graph, click Refresh. To apply display options to 
all graphs in the Samples View, click Refresh All. To return the View options to the factory 
default, click Reset. 

NOTE: Reset does not apply the factory default display options to existing graphs. To do this, 
use Refresh and Refresh All. 

The Graph properties dialog enables you to customize the appearance of the graph currently 
displayed; see Formatting a Graph. 

Setup View  Axes 
Use the Setup View tabs to select the graph appearance properties that will be applied to the 
selected graph or all graphs within that section. 

1.    Select View  from the Options menu in the Navigation Pane. 

          The Setup View tabs are displayed in the Dialog Pane. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 

2.    Select the View Axes tab. 

X Axis 
By default, the X axis is autoranged to the largest value and the smallest value in all the curves 
present. This panel allows you to enter a range of your choice. 

Y Ax is 
By default, the Y axis is autoranged to the largest value and the smallest value in all the curves 
present. This panel allows you to enter a range of your choice. If you change the Units (Auto, 
%T or A), make sure that you select appropriate range values. 

Display Mode 
Select whether the graph display mode should Overlay curves (where the curves are displayed on 
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a common set of axes) or Split curves (where the curves are displayed on a common X, but 
separate Y, axes). 

Setup View  Appearance 
Use the Setup View tabs to select the graph appearance properties that will be applied to the 
selected graph or all graphs within that section. 

1.    Select View  from the Options menu in the Navigation Pane. 

          OR 
          Select  in the Setup  section of the Navigation Pane. 

          The Setup View tabs are displayed in the Dialog Pane. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 

2.    Select the Setup View Appearance tab. 

Enable Gridlines 
Select this check box if you want to see gridlines under your curves. The major and minor gridlines 
are elements whose color you can change in the Text and Lines panel. 
The major and minor gridline intervals depend on the major and minor gridline intervals in the 
graph display. 

Text and Lines 
Select the element, such as the Title or Background, of the graph display whose color you want to 
change, and then click Color to open the Color dialog. Select a Basic color, or one of the Custom 
colors you may have defined, and then click OK. 
When you select a text element, the Size selector enables you to select a font size from the drop-
down list. 

Graph Color Palette 
The palette defines the colors available to Spectrum to color curves open in the Samples Views. 
You can change the colors in the color palette; double-click on the color to open the Color dialog. 
Select a Basic color, or one of the Custom colors you may have defined, and then click OK. 

Setup View  Advanced 
Use the View tabs to select the graph appearance properties that will be applied to the selected 
graph or all graphs within that section. 

1.    Select View  from the Options menu in the Navigation Pane. 

          The View tabs are displayed to the left. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 
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2.    Select the View Advanced tab. 

Display Option 
Select one or more of Hide X Axis Units, Hide Y Axis Units, Hide X Axis Numbers, and Hide 
Y Axis Numbers to suppress the labels applied to the X and Y scales. 

Curve Tool Tip Display 
Deselect one or more of these check boxes to suppress elements in the tooltip that appears when 
the mouse pointer is near a curve or data point. 

Data Points 
Select whether to display data points in the curve, and if so, how they should be marked. 

Line 
Select the Interpolation algorithm (Cubic, Linear, or None) applied to the curve joining the 
data points. 
Select a new Size, in pixels, from the drop-down list to amend the curve thickness, perhaps prior 
to copying the graph display to the clipboard or to emphasize a particular curve. 

The Style options enable you to display the curve using a solid, dashed, or dotted line. 
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Setup Equations 
Equations are process commands that perform calculations on one or more spectra, or on the data 
obtained from other processes. 
You setup an equation using Functions and Operators, and can format the results using an If … 
Then … Else construction. 
 Select Equations from the Process menu. 

          OR 

          Select  in the Setup section of the Data Analysis - Navigation Pane. 

          The Setup Equations tab is displayed in the Dialog Pane. 
Each of the equations you set up is appended to the Equations sub-menu in the Process menu, to 
the Equations drop-down list on the Process bar and to the Equations section of the Navigation 
pane. 

NOTE: The equations in the Common Equations Directory will be visible to all users. The 
Common Equations Directory is defined at Spectrum installation. The default is 
C:\pefl_data\equations 
In Spectrum FL ES, Equations in the Common Equations Directory are added to the 
Setup Equations tab each time a new user workspace is created. 

Adding or Modifying an Equation 
1.    If you want set up a new Equation, and create a new row in the list of equations, click Add. 
          OR 

          Select a field in the row describing the equation you want to amend, and then click 
Settings. 

          The Equations section of the Navigation pane opens with the Equation displayed in the 
Dialog pane. 

2.    Set up the Equation as described in Navigation Pane - Equations. 
          The Equations Pane stays open so that you can continue with Result Formatting or select 

another Equation in the Equations pane. If you wish to return to the Setup Equations tab 
click Back. 

          Your Equation is available in the Equations sub-menu in the Process menu. 

Removing Equations 
➤     Select the row containing the Equation that you want to remove, and then click Remove. 
          The Equation is removed from the table, the Equations sub-menu in the Process menu, and 

from the list in the Equations section of the Navigation pane. 
          You can select multiple rows. You will be prompted for confirmation for each Equation 

selected. 

Importing Equations 
To import an Equation: 
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1.    Click Import and then browse to the Equation you want to import. 
2.    Click Open. 
          In Spectrum FL ES, if you attempt to import an unsigned Equation you may be prompted 

for a Signature. 

          The Equation is added to the list of Equations on the Setup Equations tab. 

Exporting Equations 
To export an equation: 

1.    Select the equation in the list that you wish to export and then click Export. 
          In Spectrum FL ES, if you attempt to export an unsigned equation you may be prompted 

for a signature. 

          The Save As dialog is displayed. 
2.    Enter an appropriate filename for the equation. 

3.    If required, browse to the folder you want to save the equation to. 
4.    Click Save. 

          The equation is saved to the chosen location and the Save As dialog closes. 

Running an Equation 
 Display and select the spectrum or spectra that you want to process, select the Equation you 

want to apply and then click Run. 
        The Results Table tab is updated. If the result amends the source spectrum, the processed 

spectrum is displayed in the Viewing Area and added to the Samples View. 

        Processed spectra are not saved to disk automatically. 

Signing, Review ing or Approving an Equation (Spectrum FL ES only) 

NOTE: The Signatures drop-down list is not available if you have loaded a locked workspace. 

To Sign an Equation: 

1.    Select the row containing the Equation you want to sign for and then select Sign from the 
Signatures drop-down list. 

          The Sign Equation dialog is displayed. This contains the Audit Trail entries for that 
Equation, and any signatures added previously. 

2.    To sign the Equation, click Sign. 

          The Sign dialog is displayed. 

3.    Enter your User name and Password. 
4.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if the Administrator has defined Reasons on the Signatures 
tab for the Equation signature point. 

5.    Enter any Comment required. 

6.    Click OK. 
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          The Sign Equation entry is added to the Equation Audit Trail. 
The Equation can now be exported for review or approval by a user with the appropriate 
permissions. 

To Review or Approve an Equation: 
Users with the appropriate permissions can import a signed Equation to review or approve it. The 
options Review and Approve then become available from the Signatures drop-down list. An 
Equation can be signed or reviewed more than once, and by more than one reviewer. An Equation 
can be approved without being reviewed, but once it has been approved it becomes read-only and 
can no longer be reviewed or edited. 

1.    Select the row containing the Equation you want to review or approve, and then select 
Review or Approve from the Signatures drop-down list. 

          The Review Equation or Approve Equation dialog is displayed. This contains the Audit Trail 
entries for that Equation, and any signatures added previously. 

2.    To review or approve the workspace, click Review or Approve. 
          The Review or Approve dialog is displayed. 

3.    Enter your User name and Password. 

4.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Review or Approve signature points. 

5.    Enter any Comment required. 

6.    Click OK. 
          The Review Equation or Approve Equation entry is added to the Equation Audit Trail. 

The Equation can now be exported for review or approval by another user, if it has not been 
approved, or to be added to a group default workspace by an administrator. 
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Global Setting 
There are two settings on the Global Setting screen: 

• Turn on/off warm up waiting time. 

There is 10 min. warm-up waiting time warning for the FL 8500 after connecting 
instrument. If it is unselected, no warm up waiting time warning message pops up. 

 
• Enable auto logout (enter the number of minutes). 

The Enable auto logout option only available for ES version. When you select this 
option, the current user will be logged out automatically when there was no GUI 
interaction in specified period. When a user was auto logged out, the log in dialog will be 
shown in the screen to allow the latest user or administrator login back. 



 

 

Audit Trail (ES only) 
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Audit Trail (Spectrum FL Enhanced Security only) 
All data, settings and actions carried out by a user in Spectrum FL ES are saved to a database, 
grouped into user environments known as workspaces. A workspace is an collection of software 
settings, custom layouts, objects such as equations, and user data. A new workspace, with a 
unique Workspace ID, is created each time a user starts Spectrum FL ES (unless the user selects to 
reload their current workspace next time, when they exit the software). 
A Spectrum FL database has a default maximum size of 5 GB. When it reaches this size, a new 
database is automatically created. Refer to Additional Information below for the default location of 
the database. 

Any activity that affects the way data is collected or stored is recorded in the workspace Audit 
Trail. Entries are written to the Audit Trail at the point where a change that has been made affects 
the recording of data. For example, changes to instrument settings are only applied to the 
instrument when the Scan button is pressed, and so that is when the change is recorded in the 
Audit Trail. This means that any changes made to settings that are subsequently cancelled without 
being used are not recorded. 
Some changes to the Audit Trail may require a "signature" from the user. Details of the signature 
will be added to the Audit Trail. These signature points are predefined and cannot be added to, but 
members of the Administrators group can define which actions will require a signature. Refer to 
Signatures for more information. 
When the Audit Trail dialog is displayed, the Audit Trail of the current workspace is shown by 
default. However, you can use the filters on the Audit Trail dialog to view other workspaces in the 
database(s). Members of the Users group can only view workspaces they have created. However, 
members of the Administrators group can view the Audit Trail for all workspaces. Also, members of 
the groups Reviewers and Approvers can view the Audit Trail of workspaces that have been locked 
by other users for review or approval. 
You can select a saved workspace in the Audit Trail and then load it in Spectrum FL. This means 
that you can continue working on a previously saved workspace. Also, if you have Review or 
Approve permissions you can check work completed by another user. Refer to Reviewing and 
Approving for more information. 
Members of the Administrators group can load any workspace, although the workspace will be 
read-only. 

View ing the Audit Trail 
To view the Audit Trail of a workspace: 
 Select Audit Trail from the Audit Trail menu. 

        The Audit Trail dialog is displayed. The current workspace is displayed by default. 
        If Show details is selected, the lower part of the dialog shows the detailed Audit Trail for 

the selected workspace. 

        To exit the Audit Trail dialog, click Close. 

Selecting the Workspace 
You can use the filtered list of available workspaces to select the one you want to view. The Audit 
Trail for the current workspace is displayed by default. 
Members of the Users group an only view workspaces they have created. Members of the 
Administrators group can view all workspaces. 



Audit Trail (ES only) . 201 

 

 

Members of the Reviewers and Approvers groups can select For Review or For Approval, as 
applicable, to display workspaces that have been locked by their creator, indicating that they are 
ready for review and/or approval. All other user workspaces are hidden. 

To select a workspace: 
1.    From the Database selection drop-down list select the database that contains the 

workspace(s) you would like to view. 
        The drop-down list contains any Spectrum ES databases at the database location. Refer to 

Additional Information below for the default location of the database. 

2.    Select the appropriate filter from the Workspace selection drop-down list. 
        The options are Current Workspace, When created, Last modified, Signed, 

Reviewed, Approved, Returned, For Review, and For Approval. 

          Current Workspace is selected by default. 
3.    Enter or select the start date and time in the From field. 
        Click the drop-down arrow to display a calendar and select the date. Or click in the field and 

use the up and down arrows to increase or decrease a value, respectively, or type a new 
value. 

        This option filters the list of workspaces so that only those with a Time and Date stamp 
including and after the time and date entered will be displayed. For example, if Last 
modified is selected as the Workspace selection, only those workspaces last modified at 
times including and after the From entry will be displayed. 

        If Current Workspace is selected as the Workspace selection, From is not available. 
4.    To display workspaces created by a particular user select the user name from the Creator 

ID drop-down list. 

          OR 
        To display workspaces created by all users in the database select All from the Creator ID 

drop-down list. 
        Creator ID is only available if you have the appropriate permissions, which depend on the 

Workspace selection. Current User is selected by default. 
        Members of the Users group can only view workspaces they have created. Members of the 

Administrators group can view all workspaces. Also, members of the groups Reviewers and 
Approvers (or any other groups with Review or Approve permissions) with For Review or For 
Approval selected as the Workspace selection can display workspaces by other users. Those 
workspaces must have been locked by their creator, indicating that they are ready for 
review and/or approval. 

5.    Select the maximum number of workspaces you want to display. 

        The workspaces with the most recent Time and Date stamps will be displayed. 
        If Current Workspace is selected, Number of workspaces is not available. 

        The list of workspaces is now filtered by your selections. 
6.    Click the left mouse button in the row of the Workspaces table for the workspace you would 

like to view. 

        The Audit Trail displayed is updated the selected workspace. 
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Audit Trail 
The Audit Trail area, in the lower part of the screen, shows a chronological list of activities 
performed within the workspace (with the most recent at the top). You can select which columns 
to display in the table using the column selector in its top left corner. 
The available columns are: 

• Category – provides an overview of the type of action that has been audited. For 
example, Setup or Administration. 

• Subcategory – provides the sub-menu grouping. For example, if the category is Setup, 
an example sub-category is Instrument and Accessory; or, if the category is 
Administration, an example sub-category is Users. 

• Audit – the audit entry indicates what type of setting was changed. For example, for a 
Setup category with a sub-process Instrument and Accessory, the Audit entry would be 
Instrument Settings, if one of the instrument settings was changed. 

• Audited items – provides the detail of which setting was changed. For example, the Scan 
Type. 

• Old Value – the previous value applied to the configuration that was changed. For 
example, the Scan Type was Background. 

• New Value – the value applied when the configuration change was made. For example, 
the Scan Type is Sample. 

• Time and date – the date and time of the change. 

• Workspace ID – the unique ID of the current workspace. 

The following additional columns are relevant for Audited items that required a signature: 

• Sign point – the type of signature point, for example, Sign Workspace. For a list of the 
signature points in Spectrum FL ES, and how to set up signature points, refer to 
Signatures. 

• Signature – the signature of the user (this is the same as the User name). 

• Signature (full name) – the full user name of the user. 

• Reason – the reason given for the signature. The reasons available for a signature point 
are defined by the administrator; refer to Signatures. 

• Comment – any comment by the user added at the signature point. 

• Signature time and date – the time and date of the signature point. 

Loading a Workspace 
You can load an existing workspace and continue work. Only the user who created the workspace, 
or an administrator, can open a workspace. If a workspace has been locked, then users that are 
members of a group with Review and/or Approve permissions can load the workspace to review or 
approve it. 
A locked workspace is read-only. An approved workspace is also read-only. However, login 
information is still recorded in the Audit Trail. 

1.    Select the Workspace ID of the workspace you would like to load and then click Load 
Workspace. 

        The Load workspace dialog is displayed. 

2.    Click OK to confirm. 
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        Any unsaved data in the current workspace will be saved. If a signature is required, the Sign 
workspace dialog will be displayed for you to enter a signature. The workspace closes. 
Spectrum FL then reloads with the selected workspace displayed. 

NOTE: When a workspace is loaded, the Audit Trail displays the details of that workspace only. 
To view the details of other workspaces, you must return to your own workspace. Refer 
to Ex iting the workspace. 

Exiting the workspace 
After completing work on your own workspace: 

1.    Select Exit from the File menu. 

          OR 
          Click Close (X) at the top right of the Spectrum FL window. 

          The Save Options dialog is displayed. 
2.    Select Reload spectra next time. 
        This option saves any unsaved data, and reloads the current spectra, settings and layout 

next time you login to Spectrum FL, which enables you to carry on with your work from 
where you left off when you next login to Spectrum FL at this PC. 

          OR 
          Select Don't load spectra next time. 

          This means a  new workspace loads next time you login to Spectrum FL. 
After completing work on another user's workspace: 

1.    Select Exit from the File menu. 

          OR 
          Click Close (X) at the top right of the Spectrum FL window. 

          The Save Options dialog is displayed. 
2.    Select Return to workspace to reload the previous workspace. 

          OR 
          Select Exit the software. 

          The previous workspace is restored next time you login to Spectrum FL at this PC. 

Saving the Audit Trail 
1.    To save the Audit Trail of the currently displayed Workspace, click Save. 

         A Save As dialog is displayed. 

2.    Select the required destination and then enter a filename. 
        The Audit Trail is exported as a *.csv file that can be opened in a spread-sheeting 

application, for example, Microsoft® Excel™. 

Printing the Audit Trail 
1.    To print the Audit Trail of the currently displayed Workspace, click Print. 
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          The Print Preview dialog is displayed. 
2.    Review the printed output, and then select Print from the File menu. 

Additional Information 
The Spectrum FL ES Audit Trail is saved to the database FLMethodDB.mdf and FLResultDB.mdf. A 
Spectrum database has a default maximum size of 6 GB. When it reaches this size, a new database 
is automatically created. 
The default location of the Spectrum FL ES database(s) is: 

•       Windows 7/8/10 – C:\ProgramData\PerkinElmer\Fluorescence\xxxx.mdf 

You can also configure Spectrum FL ES to access the database over a network. For more 
information, refer to the Spectrum ES Administrator's Guide (part number L1050100) available on 
the manuals CD supplied with your software. 
A new workspace may be based on the system default, or on a group default. Refer to Assigning a 
New Default Workspace for more information. 
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Signing 
The ability to formally sign at signature points is available in Spectrum FL Enhanced Security (ES) 
software only. Only the user that created the workspace, or a member of the Administrators group, 
can sign the workspace. A user’s signature applies to the whole workspace, and covers all currently 
unsigned activities logged for the user in the Spectrum ES Audit Trail. 
You will be prompted to enter an electronic signature when performing an action that requires a 
signature, such as exporting data, or when you exit the software. You can also sign the workspace 
at any time by selecting Sign from the Audit Trail menu. 

Objects such as Equations, Instrument Setups and Sample Table Setups contain their own Audit 
Trail, and are not signed as part of signing the workspace. To sign one of these objects, select 
Sign from the Signatures drop-downs on the Setup Equations, the Sample Table Setups, and 
Instrument Setups dialogs, as applicable. Refer to the on-screen Help accessed from those dialogs 
for more information. 

Signing the Workspace (Audit Trail Menu) 
1.    Select Sign from the Audit Trail menu. 
          The Sign Workspace dialog is displayed. The upper part of the dialog shows the Audit Trail. 

The lower part, if displayed, shows the signatures in the current workspace. To display the 
Signature Details list, ensure that Show signature details is selected. 

2.    To sign the workspace, click Sign. 

          The Sign dialog is displayed. 
3.    Enter your User name and Password. 

4.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Workspace signature point. 

5.    Enter any Comment required. 
6.    Click OK. 

Additional information 
Signature points are predefined and cannot be added to, but members of the Administrators group 
can define which actions will require a signature. If no signature is required, then the software will 
ignore the signature point and you will not be prompted for a signature. However, if any Reasons 
have been set up for the signature point, you will still be prompted to select one. Refer to 
Signatures for more information. 
A signed (and locked) workspace, or a signed object, can be reviewed and approved by users that 
are members of a group with Reviewer or Approve permissions. Refer to Reviewing and Approving 
for more information. 
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Lock/ Unlock Workspace (Spectrum Enhanced Security only) 
When a user has completed work on a workspace, it should be presented for sign-off by users with 
the required authority. The workspace must be locked to indicate that it is ready for review and to 
make it visible in the Audit Trail to users with Review and/or Approve permissions.  
Only the user that created the workspace, or a member of the Administrators group, can lock or 
unlock the workspace. 

Lock Workspace 
The Lock workspace option enables the user to make a workspace available for review and 
approval by users with the appropriate permissions. Lock is not available if the workspace is 
already locked. 
When a workspace is locked it becomes read-only. Users with Review or Approve permissions can 
load the workspace and then review or approve it, but they cannot make changes to content. 

To lock a workspace: 

1.    Display the workspace you want to lock. 
        You can lock the current workspace, or load a previously saved workspace. 

2.    Select Lock from the Audit Trail menu. 
        The Sign Workspace dialog is displayed. The upper part of the dialog shows the Audit Trail. 

The lower part, if displayed, shows the signatures in the current workspace. To display the 
Signature Details list, ensure that Show signature details is selected. 

3.    Click Sign. 

        The Sign dialog is displayed. 
4.    Enter your User name and Password. 

5.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Workspace signature point. 

6.    Enter any Comment required. 
7.    Click OK. 
        The workspace Status is changed to Locked. Users with Review and/or Approve permissions 

can then view the workspace under For Review or For Approval in the Audit Trail dialog. 
Refer to Reviewing and Approving. 

Unlock Workspace 
Unlock is not available if the workspace is not locked. A workspace can be unlocked only by the 
user that locked it or by an Administrator. A workspace cannot be unlocked once it has been 
approved (workspace Status Approved). 
To unlock a workspace: 

1.    Display the workspace you want to unlock. 
2.    Select Unlock from the Audit Trail menu. 

        The workspace Status is changed to Unlocked. The workspace is no longer visible under For 
Review or For Approval in the Audit Trail. 
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Review ing and Approving Workspaces 
Reviewing and approving, or returning, workspaces is a function of Spectrum FL Enhanced Security 
(ES) software only and can be performed only by someone with the appropriate permission(s). It is 
up to the administrator to set the correct privileges to ensure that only the appropriate people can 
"sign-off" data. 
We use the term "Review" to mean that the person has looked at the data and has agreed that it is 
correct. This is along the lines of a peer review and any number of people can review data as 
determined by your internal procedures. 

We use the term "Approve" to mean that a person with the "authority" has signed off the data as 
fit-for-purpose and, again, details of who is allowed to do this should be documented in your 
internal procedures. When a workspace has been approved, it will be read-only. You will be able to 
view the data but no changes can be made. 
When work has been completed on a workspace, the user must lock it to indicate that it is ready 
for review and/or approval. A user with Review or Approve permissions can then load the 
workspace to check the data. The ability to load a workspace created by another user means that a 
reviewer or approver can check the work at any time: the user does not have to be present. If you 
are working over a network, a reviewer or approver can load a workspace created by another user 
while that user is logged in to Spectrum ES at another PC. 
After checking the workspace, reviewers and approvers can add an electronic signature using the 
Return, Review or Approve option from the Audit Trail menu. (The items displayed will depend 
on the permissions of the user.) A workspace can be reviewed multiple times, and by multiple 
users. A workspace can be approved without being reviewed. However, when a workspace has 
been approved it will be read-only and can no longer be reviewed. If a reviewer or approver views 
the data and does not agree that it is correct, then if they have the Return Workspace permission 
they can "Return" the workspace to the user with a description of the problem. 

Some objects such as Equations, Instrument Setups and Sample Table Setups contain their own 
Audit Trail. They are reviewed or approved separately from the workspace using the Review or 
Approve option in the Signatures drop-down on the appropriate dialog. Refer to the on-screen 
Help accessed from those dialogs for more information. 

Review ing or Approving the Workspace (Audit Trail Menu) 
Workspaces that have been locked by a user ready for review are visible in the Audit Trail to users 
with Review or Approve permissions (assigned by default for members of the groups Reviewers 
and Approvers). 

To review or approve a workspace: 

1.    Select Audit Trail from the Audit Trail menu. 
        The Audit Trail dialog is displayed. 

2.    Use the filters to display the workspace that you want to review. 
        Select For Review or For Approval as the Workspace selection. Then select the Creator 

ID of the appropriate user from the drop-down list, or All to see workspaces from all users. 

NOTE: In the list of Workspaces the Login ID of the last user to access the workspace 
will be shown. This may be the creator of the workspace, or a reviewer. 

3.    Select the workspace, and then click Load Workspace. 
4.    Click OK to confirm that you want to load the workspace. 
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        If you have unsigned data in your current workspace, then you are asked to sign the 
workspace. 

        The workspace closes. Spectrum FL will then be reloaded with the selected workspace 
displayed. The loaded workspace is read-only, although login information will be saved to 
the Audit Trail. 

5.    When you have finished checking the workspace, if the contents are correct select Review 
or Approve from the Audit Trail menu. 

        The Review Workspace or Approve Workspace dialog is displayed. The upper part of the 
dialog shows the Audit Trail. The lower part, if displayed, shows the signatures in the 
current workspace. To display the Signature Details list, ensure that Show signature 
details is selected. 

          OR 
          When you have finished checking the data, if the data is not correct, return the workspace 

to the user. 

6.    To review or approve the workspace, click Review or Approve. 
          The Review or Approve dialog is displayed. 

7.    Enter your User name and Password. 

8.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Review or Approve signature points. 

9.    Enter any Comment required. 

10.  Click OK. 
        If the workspace was reviewed it is still visible to users under For Review or For Approval in 

the Audit Trail. A workspace can be reviewed more than once by the same reviewer and by 
several reviewers. The user that created the workspace, and the administrator, can see the 
workspace under Reviewed. 

        If the workspace was approved it is no longer visible to users under For Review or For 
Approval in the Audit Trail. The user that created the workspace, and the administrator, can 
see the workspace under Approved. The workspace is now read-only. 

11.  Exit the workspace. 
        You can review or approve, as applicable, multiple workspaces without exiting Spectrum FL 

software. Refer to Exiting the workspace for more information. 

Returning the Workspace 
If a reviewer or approver identifies a problem with the workspace, and does not want to review or 
approve the workspace until this has been corrected, then they can Return the workspace to the 
user. If enabled for the Return Workspace signature point, they can add a comment describing the 
problem. 
Return is only available from the Audit Trail menu if the reviewer or approver has the Return 
Workspace permission (assigned by default for members of the groups Reviewer and Approver) 
and a locked workspace has been loaded. 

1.    Select Return from the Audit Trail menu. 

        The Return Workspace dialog is displayed. 
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2.    Enter your User name and Password. 

3.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Return Workspace signature point. 

4.    Enter any Comment required. 
5.    Click OK. 
        The workspace is no longer visible to users with Review or Approve permissions (assigned 

by default for members of the groups Reviewers and Approvers) under For Review or For 
Approval in the Audit Trail. The user that created the workspace, and the administrator, can 
see the workspace under Returned. 

Additional information 
Refer to Signatures for more information about the signature points in Spectrum FL. 





 

 

Workspace Reference 
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Workspace Reference 
These reference topics describe the elements of the Spectrum user interface: 

• Viewing Area 

• Data Explorer 

• Navigation Pane 

• Dialog Pane 

• Menus 

• Toolbars 

Additional Information 
• The View menu includes options that enable you to select whether a toolbar is shown  

or hidden. 

• For information about manipulating toolbars and resetting the workspace layout, see 
Showing, Hiding and Moving Toolbars. 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 

• You cannot customize the Status bar. 
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View ing Area 
The Viewing Area contains one or more tabs, depending on the item you have selected in the Data 
Explorer, whether an instrument is connected, and whether or not the instrument is scanning. 
Additional tabs may be displayed showing the results of some processes, such as Peak Table. 

Offline 

Item Selected Tab 
[Samples View name] Graph tab [Samples View name] 
  Results Table tab 
[spectrum name] Graph tab [spectrum name] 
  History tab 

Instrument Connected 

Not Scanning 

Item Selected Tab 
Sample Table Sample Table 

[Samples View name] Graph tab [Samples View name] 

  Results Table tab 
[spectrum name] Graph tab [spectrum name] 
  History tab 

Scanning 

Item Selected Tab Option 
[Samples View name] Live tab Energy 
    Sample 
    Single Beam 
    Interferogram 
    Force Gauge 
  Graph tab [Samples View name]   
  Results Table tab   

Graph Tab 
When you are viewing a single spectrum, the Graph tab displays the curve and a Results pane. 
When you are viewing a Samples View selected using the Data Explorer, the graph tab contains a 
table (or 'spectrum browser') that enables you to select which curves you want to display from that 
Samples View. 
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Additional Information 

Optimizing and Formatting Graphs 

• To learn more about optimizing graphs, and preparing them for publication by formatting 
and adding labels, see Viewing Spectra. 

• The Results pane includes columns for the Name (ID), Description, an icon to indicate 
whether the curve has been saved, and an icon to indicate whether any warnings were 
generated by Quality Checks. 

A column chooser in the top left corner enables you to select which columns are displayed. You can 
also resize any column by dragging it borders, or move a column by dragging its header. 

History Tab 
Use the History tab to view information about the way in which a spectrum was collected and, if 
applicable, was processed. 

When the spectrum is saved, this information is stored in the file header. 
1.    Select the spectrum in the Data Explorer Pane. 

        The spectrum is displayed in the Viewing Area. 
2.    Select the History tab. 

        Information about the spectrum is displayed categorized by Sample, Instrument, History, 
and Quality Checks. 

        The fields displayed depend on your instrument configuration and the amount of processing 
that has been applied to the spectrum. 

Additional Information 
When exporting your data using the Custom Defined Format, include the information displayed 
on the History tab in the header of the exported file using the Header Options on the Setup Export 
tab. 

Amending the Sample History 

The information in the History tab is collected automatically and cannot be edited, or was entered 
in the sample table as the spectrum was collected. 

You can, however, amend the current Sample Description and Comment using the Status dialog: 
1.    Select the Graph tab. 

2.    Place the mouse pointer over the curve, right-click, and then select Status. 
          The Status dialog opens with the Sample tab displayed. 

          The Status dialog includes a useful subset of the History information. 

3.    Edit the Description and Comments fields as required. 
4.    Close the Status dialog. 

5.    To update the History tab, save, close and then reload the spectrum. 

Results Table Tab 
To view a table that summarizes all the spectra in the currently selected Samples View: 

 Select the Results Table tab. 
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The Results Table includes a row for each spectrum in the Samples View, and columns for 
the Name (ID), Description, an icon to indicate whether the curve has been saved. 

If the Results Table becomes overly complex, consider hiding (or resizing) the columns containing 
intermediate results: 

 To select which columns are displayed, use the column chooser in the top left of the table. 
 To resize a column, drag its borders. 

 To move a column, select and drag its header. 
You can delete an Equation result column from the Results Table in Spectrum FL software: 
 To delete an Equation result column, right click the mouse button in the column and then 

select Delete from the shortcut menu. 

Processes and Equation Results 
•       If you apply a process to a spectrum that generates a new spectrum, the new spectrum is 

appended to the Samples View, and a new row is added to the Results Table. 
•       If you apply a process to a spectrum that generates a numeric result, such as an Equation, 

a new column is added to the Results Table, and the result is entered into the corresponding 
cell. 

Sample Table 
Use the Sample Table tab to specify the Sample IDs and Descriptions for a batch of similar 
samples. 
The Sample Table is available whenever an instrument is connected. You cannot build a Sample 
Table when working offline. 

Displaying the Sample Table 
 Select the Sample Table tab from the Method Setup menu. 

          OR 

          Open the Data Explorer pane, and then select Sample Table. 
          The Sample Table is displayed in the Viewing Area. 

Save Location 
This field displays the current default path to saved spectra. 

 To amend this default path, browse to and select your preferred location, and then click OK. 

          The Save Location on the Setup Instrument Data Collection tab is also updated. 

NOTE: In Spectrum FL ES if you do not have the appropriate permission, then you will not be 
able to modify the Save Location. 

Preview  
The Preview option initiates the monitor mode for the sample, which helps you optimize the scan 
conditions before initiating data collection. 

1.    Select the Preview option and then select Run from the Action menu, or click . 
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          When you are happy with your setup, click . 

          The sample is scanned. 

Sample ID and Description 
The Sample ID and Description fields in the Instrument Settings bar correspond to the first 
'unmeasured' row in the Sample Table. 
Any default entries in the Sample ID and Description fields rows depend on the Setup Instrument 
Auto-Name settings. 

 To amend a Sample ID or Description, double-click the field and enter new text. 
        To avoid replacing all the text, click to place your editing cursor within the highlighted text. 

        Right-click to select Copy (CTRL+C) and Paste (CTRL+V) commands. 
        You cannot use a Sample ID more than once. Any duplicate entries are highlighted in pink 

and data collection from this sample will not be executed. 

Sample Rows  
By default, the Sample Table contains a row for each completed measurement, and another row 
for the next measurement. 
To set up a batch of samples, build a table with the appropriate number of 'unmeasured' rows. 

NOTE: Clicking Run at any point runs the next unmeasured row in the Sample Table. You 
cannot highlight a row and run it from the Sample Table. If you want to run a specific 
sample, move the appropriate row to the top of the unmeasured samples in the table 
and click Run. 

Selecting Rows 

 Select, or deselect, a complete row in the Sample Table by clicking the first (leftmost) column 
in the row. The most recently modified row is marked, and any selected rows (or cells) are 
highlighted. 

       To select a block of rows, hold down SHIFT and click the first and the last cells in the block, 
or drag a highlight up or down the table. 

       To select or deselect a row, leaving the others selected, hold down CTRL as you click the 
rows. 

Adding Rows 

To add a number of rows to the bottom of the Sample Table: 
1.    Enter the number of rows to be added. 

2.    Click Add. 
          OR 

          Right-click anywhere within the table and then select Add. 

NOTE: If you have Spectrum FL ES, you will not be able to add rows to the Sample Table if you 
do not have the appropriate permissions. 
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Moving and Inserting Rows 

Move rows to amend the order in which the samples are measured. Insert a row to place a sample 
in a particular position in the batch. 

 Select the unmeasured rows you want to move, and then click Up or Down (or right-click 
and select Up or Down). 

 To insert a new row above the selected row, click Insert (or right-click and select Insert). 

Removing and Clearing Rows 

You may want to clean up the Sample Table so that it only refers to the current batch of samples. 

 Select any rows that are not needed and then click Remove. 
 To remove all the rows for completed measurements, click Clear Measured. 

NOTE: Removing or Clearing rows in the Sample Table does not affect the Samples Views and 
links set up in the Data Explorer. 

Custom Columns 

Selecting Columns 

 Select, or deselect, a complete column in the Sample Table by clicking the column title bar. 
Any selected columns are highlighted. 

        To select a block of columns, hold down SHIFT and click the first and the last column titles 
in the block, or drag a highlight left or right across the table. 

        To select or deselect a column, leaving the others selected, hold down CTRL as you click the 
columns. 

Adding Columns 

NOTE: If you have Spectrum FL ES, you will not be able to add columns to the Sample Table if 
you do not have the appropriate permissions. 

To add a column to the Sample Table: 

1.    Click Add Column. 

          OR 
          Right-click any column title and then select Insert Column. 

          The Add a custom column dialog is displayed. 
2.    Enter a title for the column in the Name field. 
        The column name cannot be blank. An existing column name cannot be used. All-numeric 

column titles are not allowed. 

3.    Select the Type of custom column, and define any settings for that type in the column. 

        The options are Data Entry, File Path, Numeric, List or Image. 
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          File Path custom columns allow the user to select a spectrum from disk that can then be 
used in a processing step, such as Arithmetic. 

        List custom columns allow you to create a list of options for the user. Only items within the 
list can be selected in the Sample Table column. Add new entries to the List using the Add 
button on the Add a custom column dialog. Change the order of the list using the Up and 
Down buttons. To delete an entry from the list, highlight the item and click Remove. 

        Numeric custom columns can be set to display a number of Decimal places or Significant 
figures. Only numeric entries are allowed in the column. 

        Image custom columns contain a browse button that allows you to navigate to an image. 
*.bmp, *.jpg and *.gif files can be opened. 

4.    If you wish to force users to complete a column entry before running a sample, select 
Mandatory. 

5.    Click OK. 
        The Sample Table will be updated to include the column you have added. Any Mandatory 

entries will be highlighted in red until data is entered. If you try to run a sample row 
containing fields highlighted in red, the scan will not be completed and a warning message 
will be displayed. 

Moving and Inserting Columns 

Move columns to amend the order in which the data is displayed. 
 Select the column you want to move, and then click and drag the column. The new location is 

indicated by arrows.  
 To insert a new column to the left of the selected column, right-click and select Insert 

Column. 

Editing custom columns 

1.    Right-click the title of the column you wish to modify and select Edit Column. 
          The Edit custom columns dialog is displayed. 

2.    To rename to column, select Edit Name and edit the Name field. 
3.    To change the Type, select a new option from the drop-down list. 

          If you select a new type, any data you have entered in the column will be lost. 

4.    Click OK. 

Making Custom Columns Read-only 

After you have entered data in a custom column, you can make that data read-only. 
1.    Right-click the title of the column you wish to modify and select Edit Column. 

          The Edit custom columns dialog is displayed. 

2.    Select Read-only. 
3.    Click OK. 

          The entries in the column in the Sample Table now cannot be edited. 



Workspace Reference . 219 

 

 

Setups 
You can save the Sample Table, or load a previously saved Sample Table. To access the Sample 
Table Setups dialog, click Setups. 

The Sample Table Setups dialog contains a list of Sample Table settings that have been saved. To 
save the current Sample Table as a setup, click Save current Sample Table. You can select a 
previously saved Sample Table and make this the current Sample Table using Set as Current. To 
delete a Sample Table setup, click select the appropriate row in the table and then click Delete. 
The Sample Table setups list is specific to the User currently logged in to Spectrum. You can 
Export your Sample Table Setup (as a *.smt file, or secured *.ssmt file) or Import an existing 
file. 

NOTE: The setups in the Common Sample Table Setups Directory will be visible to all users. 
The Common Sample Table Setups Directory is defined at Spectrum installation. The 
default is C:\pefl_data\SampleTableSetups 
In Spectrum FL ES, Sample Table Setups in the Common Sample Table Setups Directory 
are added to the Sample Table Setups dialog each time a new user workspace is 
created. 

Signing, Reviewing or Approving a Sample Table Setup (Spectrum FL ES only) 

To Sign a Sample Table Setup: 
1.    Select the row containing the Sample Table Setup you want to sign for and then select Sign 

from the Signatures drop-down list. 

          The Sign Sample Table Setup dialog is displayed. This contains the Audit Trail entries for 
that Sample Table Setup, and any signatures added previously. 

2.    To sign the Sample Table Setup, click Sign. 

          The Sign dialog is displayed. 
3.    Enter your User name and Password. 
4.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Sample Table Setup signature point. 

5.    Enter any Comment required. 

6.    Click OK. 
          The Sign Sample Table Setup entry is added to the Sample Table Setup Audit Trail. 

The Sample Table Setup can now be exported for review or approval by a user with the 
appropriate permissions. 
To Review or Approve a Sample Table Setup: 
Users with the appropriate permissions can import a signed Sample Table Setup to review or 
approve it. The options Review and Approve then become available from the Signatures drop-
down list. A Sample Table Setup can be signed or reviewed more than once, and by more than one 
reviewer. A Sample Table Setup can be approved without being reviewed, but once it has been 
approved it becomes read-only and can no longer be reviewed or edited. 
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1.    Select the row containing the Sample Table Setup you want to review or approve, and then 
select Review or Approve from the Signatures drop-down list. 

        The Review Sample Table Setup or Approve Sample Table Setup dialog is displayed. This 
contains the Audit Trail entries for that Sample Table Setup, and any signatures added 
previously. 

2.    To review or approve the workspace, click Review or Approve. 
        The Review or Approve dialog is displayed. 

3.    Enter your User name and Password. 
4.    Select the appropriate pre-defined Reason from the drop-down list, if applicable. 

NOTE: A reason will required if an administrator has defined Reasons on the Signatures 
tab for the Review or Approve signature points. 

5.    Enter any Comment required. 

6.    Click OK. 
        The Review Sample Table Setup or Approve Sample Table Setup entry is added to the 

Sample Table Setup Audit. 
The Sample Table Setup can now be exported for review or approval by another user, if it has not 
been approved, or to be added to a group default workspace by an administrator. 

Import CSV 
You can import a CSV file containing sample information into the Sample Table. 

1.    Ensure that the Sample Table setup displayed contains the appropriate columns for the 
samples you wish to add. 

        The CSV file import will enter data into the columns defined on the Sample Table. It will not 
create new columns, or reorder existing columns. 

2.    Create a CSV that contains the data you wish to import into the Sample Table. 
        It is advisable to produce a test CSV file to check that the columns are set up correctly, 

before importing a lot of sample data. 
        The CSV file should contain entries that correspond to the columns in the Sample Table 

setup, in the correct order. You will need to include empty columns as a placeholders for 
any Image custom columns. Any data entered in this column will not be imported into the 
Image column. 

        You should not include placeholders for the leftmost column that indicates whether a 
measurement has been completed, the column that indicates whether the curve has been 
saved or the column that indicates whether any warnings were generated by Quality 
Checks. 

        If you include any text that will be entered into a List custom column but that does not 
match one of the predefined entries, the field will be left blank when the CSV file is 
imported. If you include any text that will be entered into a Numeric custom column, the 
field will be left blank. Only numeric entries can be imported into a Numeric custom column. 

        If you want to include entries in your CSV file that contain a comma, you can put the entry 
in quotation marks. For example, "2,00","1,00". 

        Any blank rows in the CSV file will be ignored when the file is imported. 

3.    Click Import CSV. 



Workspace Reference . 221 

 

 

        The Import CSV dialog is displayed. 

4.    Browse to and select the *.CSV file you wish to import and then click Open. 
5.    Click Yes. to overwrite the existing samples in the Table with those in the *.CSV file. 

          OR 

          Click No to cancel the import. 

Additional Information 
• By default, the Sample Table includes columns to indicate that a measurement has been 

completed, Sample (ID), Description, an icon to indicate whether the curve has been 
saved, and an icon to indicate whether any warnings were generated by Quality Checks. 
A field chooser in the top left corner enables you to select which columns are displayed in 
the table. You can also resize any column by dragging its borders, or move a column by 
dragging its header. 

• Custom column entries are available as Variables on the Equations tab. 

• Data entered for samples that have not been scanned, including custom column entries, 
will only be retained upon exiting and reopening the software if you select Save for 
reload next time on the Save Options dialog before closing the software. 

Peak Table Tab 
When you run a Peak Table or Peak Area/Height process, the results are displayed on the Peak 
Table tab. 

• The upper left quadrant of the Peak Table tab lists each spectrum. 
You can select which columns to display in the table using the column selector in its top 
left corner. 

To view this table in detail, it may be helpful to drag the borders between the quadrants. 

• The List of Peaks for each spectrum is tabulated in the upper right quadrant of the Peak 
Table tab. 
You can select which columns to display in the table using the column selector in its top 
left corner. 
To view this table in detail, it may be helpful to drag the borders between the quadrants. 

• Your source spectrum or spectra are displayed in a graph below the results tables with the 
peak X and Y positions labeled.  
The peak areas will be shaded and the height will be marked on the peaks if a Peak 
Area/Height process was run. 

• Use the shortcut menu to Copy the Peak Table to the clipboard, or use the Send To 
command to copy the contents of the Viewing Area into a Word or WordPad document. 
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Navigation Pane 
Use the Navigation Pane together with the Dialog Pane to, for example, set up your instrument. 

• The Navigation Pane is on the right of the Spectrum FL workspace. 

The Options section includes shortcuts to key items. 
The Equations section in Data Analysis includes shortcuts to the Equations currently listed 
on the Setup Equations tab. Selecting an Equation in the pane displays the settings of that 
equation, which can be edited. 

• The Dialog Pane is at the bottom of the Spectrum FL workspace. 

The contents of the Dialog Pane, arranged on one or more tabs, reflect the shortcut 
selected in the Navigation Pane. 

Additional Information 
Opening and Closing Panes 
 To open or close the Dialog Pane, click the button at the center of the top edge of the 

Viewing Area. 

          OR 

          Select Dialog Pane from the View menu. 
 To open or close the Navigation pane, click the button at the center of the left edge of the 

Viewing Area. 
          OR 

          Select Navigation Pane from the View menu. 
 To open or close the Data Explorer, Navigation and Task Dialog panes simultaneously, hold 

down the SHIFT key and click the button that opens or closes any of these panes. 

Resizing Panes  
 Open the pane, and then drag the edge of the pane containing the button (not the button 

itself) to the width or height required. 

Equations 
Data Analysis - Navigation Pane - Equations 
The Equations in the Data Analysis section of the Navigation pane displays shortcuts to the 
Equations listed in the Setup Equations tab. New Equations are added using the Setup Equations 
tab. 
 Click Data Analysis in the Navigation pane then click Equations to display shortcuts to the 

Equations currently listed on the Setup Equations tab. 

You setup an equation using Functions and Operators, and can format the results using an If … 
Then … Else construction. 

Setting up an Equation 

1. Click   in the Equations section of the Navigation pane to access a user-defined 
equation.  
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The Dialog Pane at the bottom of the Spectrum workspace, is opened (or updated) to 
display the settings of that equation. 

2. Select the Equation tab. 

3. Amend the Equation name and Equation description as required.  
The Equation name will be used in the Equations sub-menu in the Process menu. 

4. Enter the Equation, either by typing directly or by clicking on items in the Operators, 
Functions and Variables lists.  
Every function has a number of required or optional arguments, as shown in the syntax 
popup displayed when the function is selected. 
Often, the first argument is <spectrum>, set to All by default, which means that the 
function is applied to all selected spectra. If you want the equation to address a particular 
type of sample select another of the Variables or, to address a specific spectrum, click 
Browse and then select the spectrum required. All numeric entries in the Results Table 
are available in the Variables List, including numeric values from Custom columns set up in 
the Sample Table. If Enable Pathlength is selected on the Setup Pathlength tab, the global 
pathlength defined there will be available as a Variable (Setup_Pathlength). 

5. Click Check to make sure that the syntax used in the equation is correct. 
The Equation list on the Setup Equations tab is updated, but the dialog pane stays open so that 
you can continue with Result Formatting. If you wish to return to the Setup Equations tab click 
Back. 

Your equation is available in the Equations sub-menu in the Process menu. 

Formatting Equation Results 

You can highlight the numeric result delivered by your equation in a different font or color, 
depending on its value. Essentially, you apply an If … Then … Else … condition. 

1. Click   in the Equations section of the Navigation pane to access a user-defined 
equation.  
The Dialog Pane at the bottom of the Spectrum workspace, is opened (or updated) to 
display the settings of that equation. 

2. Select the Results Formatting tab. 
3. Set up the 'If' condition by entering a constant or selecting a result (usually you select the 

result of the equation you are working on), followed by an Operator (such as 'greater 
than'), and then a Criterion (such as a constant or the result from another equation).  
The criteria available are <>, <=, >=, <, >, =, Not Between, and Between. The Not 
Between and Between operators require two criteria, so you must complete the 
Criterion and the Criterion 2 fields. 

4. Setup the 'Then' conditional formatting, which specifies what happens when the 'If' section 
is true. Select whether to do nothing, or to label and/or highlight the result.  
To do nothing, select No formatting. 
To label your result, select Replace result with text or Add text to result, which 
opens a text field for you to enter your label. If no label is required, select Only change 
font. 
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To highlight your result, you can amend its font attributes and/or the color of the cell or 
row in which it is displayed. Click Change Font to amend attributes such as Font, Font 
styles (italic, bold) and Size, and to apply Effects such as Color, Strikeout and Underline. 
Use the Fill color drop-down selector to choose a background color, and select the Apply 
to row check box if you want this color to apply to the table row containing your result. 

5. Setup the 'Else' conditional formatting, which specifies what happens when the 'If' 
condition is false.  
Select whether to do nothing, or to label and/or highlight the result, as before. 

6. If you wish to return to the Setup Equations tab click Back. 

Function Reference 

The Area function 

Use the Area function to calculate the area under a curve between two set points. The syntax of 
the function is "Area[<spectrum variable>, Left Limit, Right Limit, Left Base 
Point(optional), Right Base Point(optional)]" 

 
The area reported is between the Left Limit and Right Limit, either relative to a zero baseline or 
relative to a linear baseline intersecting the spectrum at the specified baseline points. If no 
baseline points are specified, the area reported is that above zero. If only one baseline point is 
specified, a horizontal baseline is constructed from that point. 
The Yval function 

Use the Yval function to obtain the ordinate value at a specified abscissa position. 
The syntax of the function is "Yval[<spectrum variable>, Abscissa position]". 
The Yval function is useful for calculating net absorbance from the difference in absorbance at two 
positions. The Yval function also enables you to determine the amplitude of a band on a varying 
sloping background. 
The PeakX function 

Use the PeakX function to find the position of a peak or valley within a specified range. 
The syntax of the function is "PeakX[<spectrum variable>, Start Range, End Range, Peak 
Threshold, 1=Peak/-1=Base, 1=Interpolated(default)/0=sampled position 
(optional)]". 
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A peak is identified by a valley that exceeds the selected threshold on either side. PeakX gives the 
abscissa position of a peak or valley over the specified range. If there is more than one peak that 
exceeds the threshold the routine returns the value of the first peak or valley it finds. 

 The Ymax function 
Use the Ymax function to find the maximum ordinate value within a specified range, instead of 
measuring the height at a fixed position. When processing many spectra, the Ymax function 
enables you to address any shifts in the location of the maximum.  
The syntax of the function is "Ymax[<spectrum variable>, Start Range, End Range]". 
For example: Ymax[All, 3150, 3000] returns the maximum ordinate value between 3150 cm-1 
and 3000 cm-1. 

The Ymin function 
Use the Ymin function to find the minimum ordinate value within a specified range. When 
processing many spectra, the Ymin function enables you to address any shifts in the location of the 
minimum. 
The syntax of the function is "Ymin[<spectrum variable>, Start Range, End Range]". 

The XYmax function 
Use the XYmax function to return the abscissa position of the maximum ordinate value found by 
interpolation over a specified range. 

The syntax of the function is "XYmax[<spectrum variable>, Start Range, End Range]". 
The XYmin function 
Use the XYmin function to return the abscissa position of the minimum ordinate value found by 
interpolation over the specified range. 

The syntax of the function is "XYmin[<spectrum variable>, Start Range, End Range]". 
The Height function 

Use the Height function to calculate the ordinate value at a specified abscissa position relative to 
an optional baseline. 
The syntax of the function is "Height[<spectrum variable>, Abscissa position, Left Base 
Point(optional), Right Base Point(optional)]". 
If you specify one base point, a horizontal baseline is calculated from that point.  If you specify no 
base points then the height is not corrected for a baseline. 
The Interval function 

Use the Interval function to calculate the data interval of the spectrum. 

The syntax of the function is "Interval[<spectrum variable>]". 

For example: Interval[All] return the data interval of each spectrum. 
The Npts function 

Use the Npts function to calculate the number of data points in the spectrum.   
The syntax of the function is "Npts[<spectrum variable>]". 

For example: Npts[All] returns the number of data points in each spectrum. 
The End function 

Use the End function to find the last abscissa point in the spectrum. 
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The syntax of the function is "End[<spectrum variable>]". 
For example: End[All] returns the last abscissa point in each spectrum. 

You can also nest the End command within a command in place of its end value. 
For example: XYmax[All, Start[All], End [All]] returns the abscissa value for the maximum 
ordinate anywhere in each spectrum without having to set start and end limits. 
If you use the End command with Wavelength Programmed data the last wavelength in the list is 
returned. 
For example: Height[All, End[All]] returns the height at the last wavelength in the list without 
pre-setting that value. 
The Start function 

Use the Start function to find the first abscissa point in the spectrum.  

The syntax of the function is "Start[<spectrum variable>]". 

For example: Start[All] returns the first abscissa point in each spectrum. 
You can also nest the Start command within a command in place of its start value. 
For example: XYmax[All, Start[All], End [All]] returns the abscissa value for the maximum 
ordinate anywhere in each spectrum without having to set start and end limits. 

If you use the End command with Wavelength Programmed data the last wavelength in the list is 
returned. 
For example: Height[All, Start[All]] returns the height at the first wavelength in the list without 
pre-setting that value. 
The MaxHt command 
Use the MaxHt function to determine the height of the tallest peak in a range, relative to a 
baseline if required. The MaxHt function is useful for obtaining absorbance values for quantitative 
applications. 
The syntax of the function is "MaxHt[<spectrum variable>, Start Range, End Range, Left 
Base Point, Right Base Point]". 
When the Left Base Point and Right Base Point are given the same value, a horizontal baseline 
is used, as shown below. 
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The Mean, SD, and RMS functions 

The Mean , SD (Standard deviation) and RMS (Root mean square deviation) functions are 
standard statistical functions. When you apply them to spectral data they return the average, 
standard deviation or RMS deviation ordinate value over all wavelengths.   
You can use the Mean and SD functions to evaluate the results from repeated measurements to 
estimate their precision and uncertainty. Use the RMS function in a similar manner to determine 
variability, for example as a measure of the noise in a region of a spectrum. 
The syntax of these commands is "[<spectrum variable> or <number variable>]". 

You can apply the Mean, SD and RMS functions to spectra or to a numeric result from another 
equation. 
For instance, if you replicated your experiments and had an equation to find the area of a peak in 
each, you could calculate the Mean of the peak areas. 
The Trend function 

Use the Trend function to measure a slow variation, that is a variation described as drift rather 
than as noise. 
The Trend function calculates the slope of a linear fit to the spectrum. You can apply the function 
to the complete spectrum or to a region within it, defined by Start Range and End Range. 
The syntax of the function is "Trend[<spectrum variable>, Start Range (optional), End 
Range (optional)]". 
The Exp, Log, Sqr, Sqrt and Ln functions 

Use the Exp (Exponent), Log (Logarithm), Sqr (Square), Sqrt (Square Root), and Ln (Logarithm 
base e, or natural logarithm) as standard mathematical tools that you can apply to spectra or to 
the numeric results from another equation. 

NOTE: If you try to take the log, natural log (Ln), or square root (Sqrt) of a negative number a 
value of zero is returned. 
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The Log function returns the base <n> logarithm of a number or a spectrum. The syntax of the 
Log function is "Log[<spectrum variable> or number, base]". 

For example, Log[All, 10] would return the logarithm (base 10) of all your spectra. 
The XVal function 

Use the XVal function to determine the abscissa value at a specified Y value. The function uses 
interpolation by default, which returns the actual abscissa value at the specified Y value. 
If when setting up the function, you enter 0 instead of interpolation in the syntax statement, the 
function returns the abscissa value of the nearest data point. 
The XVal function returns the first abscissa value at the specified Y value. If the spectrum has 
more than one abscissa value at the specified Y value (such as when there is more than one peak 
in the spectrum), the Search from Start / End options in the syntax statement are useful. Select 
whichever end of the spectrum ensures that the required value is returned. 
The syntax of the function is "XVal[<spectrum variable>, Ordinate value, Start Range, End 
Range, 1=Search from Start(default)/-1=Search from End(optional), 
1=Interpolated(default)/0=sample position (optional)]" 
  
Width at half height 

You can use the XVal function to calculate the width of a peak at half its height: 

 
  
The YShift function 

Use the YShift function to find the ordinate value difference at the selected position between two 
linear best fit lines fitted to the data points either side of a specified x position over a fixed width. 
The syntax of the function is "YShift[<spectrum>, x position at which to calculate shift, x 
width from position for Linear Fit]". 
The RCoeff function 

Use the RCoeff function to calculate the correlation coefficient. 
The syntax of the function is "RCoeff[<spectrum variable>,Start Range(optional), End 
Range(optional)]" 

If you do not specify Start Range and End Range values, the complete spectrum is used. 
The Ri function 

Use the Ri function to calculate the refractive index of your sample. 
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The syntax of the function is "Ri[<spectrum variable>, Start Range, End Range, Thickness, 
Num Fringes (-1=Auto), Angle of Incidence, Thickness Units: 1=Å/2= µ m, Peak 
Threshold(optional)]" 
The Tcalc function 

Use the Tcalc function to calculate the thickness of your sample. 
The syntax of the function is "Tcalc[<spectrum variable>, Start Range, End Range, 
Refractive Index, Num Fringes(-1=Auto), Angle of Incidence, Result Units: 1=Å/2= µ 
m, Peak Threshold(optional)]" 

Additional Information 

If you want the spectrum generated by an Equation to be used as the input spectrum for the next 
step, you should enable the option Use for next step.   
If Use for next step is selected, you can also select to Overwrite input spectra. The Equation 
will generate a new spectrum and overwrite the input spectrum. The new spectrum generated will 
then be used by the next step. Any numerical results calculated for the input spectrum will be 
retained. 
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The Dialog Pane 
Use the Dialog Pane together with the Navigation Pane to, for example, set up your instrument.  

•       The Dialog Pane is at the bottom of the Spectrum FL workspace. 

          The contents of the Dialog Pane, arranged on one or more tabs, reflect the shortcut 
selected in the Navigation Pane. 

•       The Navigation Pane is on the right of the Spectrum FL workspace. 

          The Navigation Pane contains a Setup area, which includes shortcuts to key items from the 
Setup menu. 

NOTE: To see a dialog, you may have to resize the Dialog Pane. 

Additional Information 
Opening and Closing Panes 
 To open or close the Dialog Pane, click the button at the center of the bottom edge of the 

Viewing Area. 

          OR 
          Select Dialog Pane from the View menu. 

 To open or close the Navigation pane, click the button at the center of the right edge of the 
Viewing Area. 

          OR 

          Select Navigation Pane from the View menu. 
 To open or close the Data Explorer, Navigation and Task Dialog panes simultaneously, hold 

down the SHIFT key and click the button that opens or closes any of these panes. 

Resizing Panes 
 Open the pane, and then drag the edge of the pane containing the button (not the button 

itself) to the width or height required. 
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Menus 

The Data Analysis Menu Bar 
These reference topics describe the menus available in the Data Analysis Menu Bar: 

• File 
• View 
• Process 
• Setup 
• Audit Trail (ES) 
• Navigation 
• Help 

Additional Information 
The Menu Bar cannot be turned off, floated or customized. It is placed at the top of the Spectrum 
FL workspace. 

NOTE: If you have Spectrum FL ES, and you do not have permission to perform any of the 
functions on the menu, the menu will not be displayed. If you have permissions for 
some, but not all, of the functions, the menu will be displayed showing only those items 
for which you have permission. 

Navigation Menu 
These are the commands available on the Navigation menu. 

 

Additional Information 
The number of folder items available mirrors the number of Samples Views displayed in the Data 
Explorer pane. Use the Folder items to select the current Samples View. 

Method Setup Method Menu 
These are the commands available in the Method Setup Method menu. To learn more about a 
command, click on its name. 
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New Ctrl+N 

 

Save Ctrl+S 

 

Delete 

Ctrl+D 

 Transform Ctrl+T 

Additional information 
For more information about opening and saving files, see Finding and Saving. 
For more information about printing your results, see Publishing Results. 

Send to Word, Send to WordPad and Send to Excel will only be available if you have the relevant 
software installed on your computer. 

NOTE: If you have Spectrum FL ES, some items on this menu may not be available if you do 
not have the appropriate permissions. 

  

Method Setup File Menu 
These are the commands available in the Method Setup File menu. These items are also on the 
Method Setup File Bar.  To learn more about a command, click on its name. 

 

Export CTRL+E 

 

Import CTRL-I 

 

Report CTRL+R 

 Exit   

Additional information 
For more information about opening and saving files, see Finding and Saving. 

For more information about printing your results, see Publishing Results. 
Send to Word, Send to WordPad and Send to Excel will only be available if you have the relevant 
software installed on your computer. 

NOTE: If you have Spectrum FL ES, some items on this menu may not be available if you do 
not have the appropriate permissions. 
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Setup Menu 
These are the commands available in the Setup menu. To learn more about a command, click on 
its name. 

  Administration (Administrators only) >   Setup Users 

        Users Audit Trail (ES only) 
        Set Group Workspace (ES only) 
  Instruments > 

 

Add Instrument 

      
 

Remove Instrument 

      
 

Select Instrument 

      
 

Enable Auto-Connect 

  Restore Default Workspace       

Additional Information  
To access the Add Instrument and Remove Instrument options on the Instruments sub-menu, you 
must have administrator rights. 

Data Analysis File Menu 
These are the commands available in the Data Analysis File menu. To learn more about a 
command, click on its name. 

 

New CTRL+N         

 

Open CTRL+O         

 

Open 3D Data... CTRL+W         
  Send To > Word > 

 

New Word Document 
      WordPad > 

 

New WordPad Document 
      Excel > 

 

New Excel Workbook 

 

Export CTRL+E         

 

Report CTRL+R         

 

Save CTRL+S         

 

Save As           
  Save All           

 

Print Preview           

 

Print CTRL+P         

 

Exit           

Additional information 
For more information about opening and saving files, see Finding and Saving. 
For more information about printing your results, see Publishing Results. 
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Send to Word, Send to WordPad and Send to Excel will only be available if you have the relevant 
software installed on your computer. 

NOTE: If you have Spectrum FL ES, some items on this menu may not be available if you do 
not have the appropriate permissions. 

View  Menu 
These are the commands available in the Data Analysis View menu.  

 

Full Range       

 

Autorange X       

 

Autorange Y       

 

Previous Range       

 

Cancel Offset                        

 

Format Graph       

 

Add Text       

 

Vertical Cursor       

 

Horizontal Cursor       

 

Label Peaks       

 

Autoscale Y       

 

Optimize       

  Graph Toolbars > 
 

Graph 

      
 

Process 

        Customize 

 

Data Explorer       

 

Navigation Pane       

 

Dialog Pane       

Additional Information 
To view the Instrument Settings or Action toolbars, you must be connected to an instrument. 

Viewing Graphs 
The menu items referring to how curves are displayed can also be available on the Graph Toolbar. 
A selection of the commands are also made available in vertical toolbars displayed by the spectra 
when some processes are run. 

For more information about viewing graphs, see Optimizing Graphs. 
Showing or Hiding Interface Elements 

The menu items referring to toolbars and panes enable you to quickly show or hide parts of the 
Spectrum interface. For a toolbar,  indicates that the toolbar is visible. For the Data Explorer, 
Navigation and Dialog Panes,  indicates that the pane is open. 

The toolbars displayed by default will depend on the options you selected at installation. 
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You can organize your workspace by hiding a toolbar, or by showing a toolbar that had been 
hidden. 

 Click the  icon to the left of the name of the toolbar that you want to hide 

          OR 

          Click the shaded area to the left of the name of the toolbar that you want to show. 

Process Menu 
These are the commands available in the Process menu. 

 

Absorbance     

 

% Transmittance     

 

Data Tune-up     

 

Baseline Correction     

 

Interactive Baseline Correction     

 

Difference     

 

Normalization     

 

Interpolation     

 

ConvertX     

 

Smooth     

 

Derivative     

 

Arithmetic     

 

Deconvolution     

 

Polarization     

 

Anisotropy     

 

Peak Table     

 

Peak Area / Height     

Additional Information 
These commands are also available from a shortcut menu in the Viewing Area, and may be 
included in the Process Bar. 

NOTE: If you have Spectrum FL ES, some items on this menu may not be available if you do 
not have the appropriate permissions. If you do not have permission to access any of 
the items on the menu, the menu will not be displayed. 
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Results Menu 
Use the actions in the Results menu to search, reprocess, or remove Previous Results displayed in 
the table. 

  
Search Ctrl-Q 

 

Reprocess Ctrl-R 

 

Remove Ctrl-D 

Audit Trail Menu (Spectrum FL Enhanced Security Only) 
The Audit Trail menu is only available in Spectrum FL ES. The commands available will depend on 
your permissions and the current status (for example, Locked or Unlocked) of the workspace. 
To learn more about a command, click on its name. 

 

Audit Trail 

 

Sign 

 

Review 

 

Approve 

/
 

Lock / Unlock 

 

Return 

Help Menu 
These are the commands available on the Help menu. To learn more about a command, click on its 
name. 

Contents 

Index 

Search 

Disclaimer 

About 
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Toolbars 
The Spectrum FL workspace can include a number of global toolbars: 

• The Scan toolbars, namely the Instrument Settings bar, the Action bar, the File bar and the 
Accessory bar. By default, these toolbars are located at the top of the workspace, under 
the Menu bar. 

• The Status bar, located at the bottom of the workspace. 

The Viewing Area pane can include one or more local Graph toolbars: 
• The Graph bar. By default, this toolbar is located at the top of the Viewing Area. 

• The Process bar. By default, this toolbar is located at the top of the Viewing Area. 

Additional Information 

• The View menu includes options that enable you to select whether a toolbar is shown  
or hidden. 

• For information about manipulating toolbars and resetting the workspace layout, see 
Showing, Hiding and Moving Toolbars. 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 

• You cannot customize the Status bar. 

The Method Setup File Bar 
Use the Method Setup File bar to create new sample views, open methods in the software, to save 
methods and publish data to other formats and applications. 

  

Additional Information 
The commands displayed by default on the toolbar will depend on the option you selected at 
installation. You may decide to include other view commands that you use frequently. See 
Personalizing Toolbars. 

The Action Bar 
Use the buttons in the Action bar, or from the Action menu, together with the messages given in 
the Prompts Display, to control your instrument. 

Action Bar Action Menu 

    

 

Run/Resume Ctrl-R 

 

Pause Ctrl-P 

 

Stop Ctrl-H 
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Additional Information 
The commands displayed by default on the toolbar will depend on the option you selected at 
installation. You may decide to include other view commands that you use frequently. See 
Personalizing Toolbars. 

The Accessory Bar 
The Accessory Bar contains controls appropriate to the accessory currently installed in the 
instrument. The toolbar includes an icon that identifies the accessory installed. If you change the 
sampling accessory, the Accessory bar will automatically be updated with the new accessory 
controls. 

 
The following Accessories are available. 

• Single Cell Holder 
• Water Jacketed Single Cell Holder 
• Water Jacketed Single Cell Holder w/ Stirrer 
• Solid Sample holder 
• Variable Angle Solid Sample Holder 
• Micro Cell Holder  
• Water Jacketed Micro Cell Holder w/ Stirrer 
• Integrating Sphere 
• Absorbance Module 
• UV/Vis Automated Polarizer 
• Rapid Mixing Accessory 
• Fiber Optic Probe 
• Vis Automated Polarizer 
• Manual Polarizer Holder  
• Microplate reader 
• 4-Position Multi-Cell Holder 
• Water Jacketed 4-Position Multi-Cell Holder 
• Water Jacketed 4-Position Multi-Cell Holder w/ Stirrer 
• Fast Filter 
• Single Cell  Peltier Holder 
• 4-Position Multi-Cell Peltier Holder 
• Auto Sipper 
• S10 Autosampler 
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The Graph Bar 
Use the Graph bar to optimize how your spectra are displayed, particularly prior to printing, or 
cutting and pasting into another application. 

  
 

Open 

 

 

Auto XY 

  
 

Auto X 

 

 

Auto Y 

  
 

Prev 

  
 

Cancel Offset 

  
 

Format 

  
 

Text 

 

 

Vertical Cursor 

  
 

Horizontal Cursor 

 

 

Labels 

  
 

Autoscale Y 

  
 

Optimize 

  
 

Split 

    Reset Toolbar 

Additional Information 
The commands displayed by default on the toolbar will depend on the option you selected at 
installation. You may decide to include other view commands that you use frequently. See 
Personalizing Toolbars. 
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The Process Bar 
Use the Process bar to select a process to apply to your selected spectrum. 

 

 

Absorbance 

 

 

%Transmittance 

  
 

Data Tune-up 

  
 

Baseline 

 

 

i-Interactive Baseline Correction 

 

 

Difference 

  
 

Normalization 

  
 

Interpolate 

  
 

ConvertX 

  
 

Smooth 

  
 

Derivative 

  
 

Arithmetic 

  
 

Deconvolution 

  
 

Polarization 

 

 

Anisotropy 

  
 

Peak Table 

 

 

Peak Area / Height 

 

 

Equations 

Additional Information 

The  icon above indicates that the command is included in the factory default Process bar. 
You may decide to include other process commands that you use frequently. See Personalizing 
Toolbars. 
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These commands are also available from a shortcut menu in the Viewing Area, and from the 
Process Menu. 

The Previous Results File Bar 
Use the Previous Results File bar to search for results, reprocess, display, and report previous 
results in the software. 

  

Additional Information 
The commands displayed by default on the toolbar will depend on the option you selected at 
installation. You may decide to include other view commands that you use frequently. See 
Personalizing Toolbars. 

The Status Bar 
The Status bar is a global toolbar that is displayed at the bottom of the Spectrum FL workspace. 
The Status bar reports the name of the user who is currently logged in, and whether Spectrum FL 
is working Offline or is connected to an instrument. 

When Spectrum FL is connected to an instrument, the Status bar reports whether: 

•       The connection to a networked instrument is healthy. 

•       The instrument is Idle or Scanning. 

•       The instrument requires servicing, or its desiccant requires changing. 
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Show ing, Hiding and Moving Toolbars 
You can organize your workspace by hiding a toolbar, or by showing a toolbar that had been 
hidden. 

 In the View menu, click the  icon to the left of the name of the toolbar that you want to 
hide 

          OR 
          Click the shaded area to the left of the name of the toolbar that you want to show. 

NOTE: The Menu and Status bars cannot be hidden. 

Moving, or Floating, a Toolbar 
When a toolbar is unlocked, a dotted drag handle is displayed, usually on its left edge. This handle 
enables you to change the position of a toolbar, or to float it in a separate window. 
 Place your mouse pointer over the drag handle on the toolbar you want to move and drag it 

to its new position. 

Locking Toolbars 
Locking a toolbar protects it from some inadvertent changes. A locked toolbar can be hidden, and 
its buttons re-arranged or reset, but it cannot be customized or dragged to a new location. 

 Right-click the  button to the right of the toolbar and then click Lock The Toolbars. 

    The toolbars are locked when  is displayed to the left of this command. 

NOTE: The toolbars are grouped so that, for example, locking one of the Scan toolbars locks 
the Instrument Settings and Action toolbars, or locking one of the Graph toolbars locks 
the Graph and Process toolbars. 

Restoring the Workspace 
Spectrum FL Standard 
Restore Default Workspace will return your workspace, including instrument settings and other 
default parameters, toolbar buttons and the layout, to the system default. No equations, 
instrument setups or sample table setups will be removed. 
To restore the workspace to the system default: 

1.    Select Restore Default Workspace from the Setup menu. 

        The Reset Layout dialog is displayed. 
2.    Click OK to restore. 

        Spectrum FL closes briefly, and then opens with the system default layout. 
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Spectrum FL ES 
Restore Default Workspace will return your workspace, including instrument settings and other 
default parameters, toolbar buttons and the layout, to the group or system default. Any user 
equations, instrument setups or sample table setups will be removed. 

To restore the workspace to the group or system default: 
1.    Select Restore Default Workspace from the Setup menu. 

        The Restore Default Workspace dialog is displayed. 
2.    Click OK to confirm the reset. 

        If you are a member of a group with a group default workspace, then the group workspace 
will be loaded. If not the system default will be loaded. 

        If you are a member of more than one group, the Set Group Workspace dialog is displayed. 

3.    Select which group workspace you want to load. 
        Members of the Administrators group can select the system default. 

4.    Click OK. 
        Any unsaved data in the current workspace will be saved. If a signature is required, the Sign 

workspace dialog will be displayed for you to enter a signature. The workspace closes. 
Spectrum then reloads with the selected workspace displayed. 

Additional Information 
•       For information about manipulating toolbar buttons, see Personalizing Toolbars. 

•       For information about adding or removing toolbar buttons or menu items, see 
Customizing Toolbars and Menus. 

•       You cannot personalize or customize the Status bar. 
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Personalizing Toolbars 
You can personalize toolbars by adjusting their appearance and by showing, hiding and re-
arranging buttons. 

NOTE: The toolbars are grouped so that, for example, changing the appearance of the Graph 
toolbars changes the appearance of both the Graph Toolbar and the Process Toolbar. 

Displaying and Positioning Text 
By default, toolbars are displayed with command names placed under below the command icon. 

1.    In the View menu, select Graph Toolbars and then select Customize. 

          OR 

          Right-click the  button to the right of a toolbar and then click Customize. 

          OR 

          Right-click in an area next to the toolbar and then click Customize. 
          The Customize dialog is displayed. 

2.    Select the Toolbars Text tab. 
        By default, the Show both text and images in toolbars option is enabled (checked) and the 

Text below image option is selected. 
3.    If you want to display the toolbar buttons without text, deselect (uncheck) the Show both 

text and images in toolbars option. 

          OR 
          Select one of the text display options. 

4.    Click Close. 

Changing the Icon Size 
1.    In the View menu, select Graph Toolbars or Scan Toolbars, and then select Customize. 

          OR 

          Right-click the  button to the right of a toolbar and then click Customize. 

          The Customize dialog is displayed. 

2.    Select the Options tab. 

        By default, the Large Icons in Toolbars option is enabled (checked). 
3.    If you want to display the toolbar buttons with smaller icons, as used in the menus, disable 

(uncheck) the Large Icons in Toolbars option. 
4.    Click Close. 

Show ing and Hiding Buttons  
The toolbars are, by default, populated by standard sets of buttons (that is, icons or text entry 
fields), which depend on the Installation Type selected when Spectrum was installed. You can 
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organize your workspace by hiding any buttons that you do not use very often, or by showing a 
button that had been hidden. 

 Click the  button to the right of the toolbar you want to modify, select Add or Remove 
Buttons, the name of the toolbar, and then click the   icon to the left of the name of the 
button that you want to hide, 

          OR 

          Click the shaded area to the left of the name of the button that you want to show. 

Re-arranging Buttons on a Toolbar 
You can arrange the buttons in the toolbars to suit your preferred method of working. 

1.    Hold down the ALT key and select the edge of the button you want to move. 

        The button is surrounded by a black box. 
2.    Drag the button to its new position on the toolbar. 

        The button is placed at the position of the cursor. 

Resetting a Toolbar 

 Click the  button to the right of the toolbar you want to reset, select Add or Remove 
buttons, the name of the toolbar, and then click Reset Toolbar. 

    The toolbar is reset to include all the icons available for that toolbar. 

Additional Information 
• For information about manipulating toolbars and resetting the workspace layout, see 

Showing, Hiding and Moving Toolbars. 
• For information about adding or removing toolbar buttons or menu items, see 

Customizing Toolbars. 

• You cannot customize the Status bar. 
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Customizing Toolbars and Menus 

Adding Buttons to a Toolbar 
You can customize a toolbar by adding buttons that are not simply hidden in the current setup. For 
example, you can add a button that is usually displayed in another toolbar. 

1.    In the View menu, select Graph Toolbars (if you want to customize the Graph toolbar or 
Process toolbar) or Scan Toolbars (if you want to customize the File toolbar, Instrument 
Settings toolbar or Action toolbar), and then select Customize. 

          OR 

        Right-click the  button to the right of the toolbar, click Add or Remove Buttons and 
then click Customize. 

        The Customize dialog is displayed. 

2.    Select the Commands tab, and then click Rearrange Commands. 
        The Rearrange Commands dialog is displayed. 

3.    Select the Toolbar option, select the toolbar you want to customize, and then click Add. 
        The Add Command dialog is displayed. 

4.    Select from the Categories of command available, and then select the Command you 
want to add. 

        You can select any available command from the All Commands category. 

5.    Click OK. 
        The command is added to the list of commands that you can rearrange. 

6.    Position the command in the toolbar by clicking Move Up and Move Down. 
7.    If you want to insert a separator 'below' a button (as listed in the dialog, usually to the right 

of the button when the toolbar is displayed), click Modify Selection and select the Begin 
a Group option. 

8.    Click Close. 

9.    Click Close to shut the Customize dialog. 

NOTE: Although you can use the Rearrange Commands dialog to delete a command from a 
toolbar, you may prefer to simply hide it. 

Creating a New  Toolbar 
You can create a new toolbar containing any of the available commands, such as those needed for 
a particular task. You could hide the toolbar when it is not needed. 
You associate a new toolbar with either the Graph toolbars (that is, the Graph toolbar and the 
Process toolbar) or with the Scan toolbars (that is, the Accessory toolbar, File toolbar, Instrument 
Settings toolbar and the Action toolbar). 

1.    In the View menu, select Graph Toolbars or Scan Toolbars, and then select Customize. 

          OR 

          Right-click the  button to the right of a toolbar and then click Customize. 
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        The Customize dialog is displayed. 

2.    Select the Toolbars tab, and then click New. 
        The New Toolbar dialog is displayed. 

3.    Enter a Toolbar name and its default Location, and then click OK. 

        The New Toolbar dialog closes, and an empty toolbar is added to Spectrum. 
        The toolbar name will be added to the appropriate sub-menu in the View menu, which 

enables you to show or hide it. 
4.    If you want the toolbar to be hidden by default, deselect the checkmark to the left of its 

name in the Toolbars pane. 
5.    To populate your toolbar, continue from Step 2 in Adding Buttons to a Toolbar. 

          OR 

          Click Close. 

Customizing the Menu Bar 

NOTE: The menu system is very flexible, but there are some restrictions. For example, some 
sub-menus are treated separately and not every command is available. 

You cannot add a new menu to the Menu bar, or add a command that does not exist. However, 
you can simplify a menu by not displaying a command that you never you use, display a command 
in another menu, or rearrange a menu to make a useful command more prominent. 

1.    In the View menu, select Scan Toolbars, and then select Customize. 

          OR 
          Right-click in the Menu bar and then click Customize. 

          The Customize dialog is displayed. 
2.    Select the Commands tab, and then click Rearrange Commands. 

        The Rearrange Commands dialog is displayed. 
3.    Select the Menu Bar option, and then select the menu or sub-menu that you want to 

customize. 
        If any of the existing commands in the menu can be modified, they are listed in the 

Commands pane. 
4.    If you want to add a command to the menu, click Add, select the command from the Add 

Command dialog, and then click OK. 

        The command is added to the list of commands that you can rearrange. 
5.    Position a selected command in the menu by clicking Move Up and Move Down, or 

remove it by clicking Delete. 
6.    If you want to insert a separator below a command, click Modify Selection and select the 

Begin a Group option. 

7.    Click Close. 
8.    Click Close to shut the Customize dialog. 
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Additional Information 
• For information about manipulating toolbars and resetting the workspace layout, see 

Showing, Hiding and Moving Toolbars. 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 

• You cannot customize the Status bar. 
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